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1. General System Introduction

Airelectronics has developed a complete solution for both rotary and fixed wing UAVs. The
system is composed of:
•

U-Pilot

•

U-Ground

•

U-See

U-Pilot takes care of the vehicle from Take-off to Landing. It is completely adaptable to any
aircraft including fixed wing, multi-copters, helicopters and captive rotary wing.
U-Pilot is completely capable of following a flight plan with up to 200 points (real time
editable). Once the flight plan is loaded on the U-Pilot it is independent of operator
instructions. In case of a failure in the communications, U-Pilot can perform a completely
configurable behavior, for example follow a specific BackTrack route and start a Landing
maneuver which would safely land the UAV on the Runway Point.
Thanks to its versatility U-Pilot can control any device on board the UAV such as cameras,
parachutes and others. These devices can be real time controlled by a Computer Operator
or by U-Pilot automatically.
U-Pilot has, working in parallel:
•

Up to 31 PWM (Pulse-Width Modulation) outputs or even more if necessary,

•

3 ADC inputs (Analogical Digital Converter) to monitor the voltages of three
batteries on the UAV

•

4 serial ports RS232 to communicate with payloads, external magnetometers, etc.

•

A radio with up to 100 km1

•

GPS, dynamic and static pressure sensors, a magnetometer, gyroscopes and
accelerometers.

U-Pilot is built using a two parallel microprocessor approach:
•

One processor takes care of the state estimator and controls the UAV using
hardware acceleration to calculate high speed algorithms.

•

Another processor takes care of the mission at high level and the communications
with the U-Ground and Payloads management.

•

The processors do not waste any time doing low level tasks.

Due to the fact that those two processors are working in parallel and there is dedicated
electronics taking care of all the serial ports, sensors, inputs and outputs, the system is
capable of recalculating its position, orientation and closing control loops at 1000 Hz. This
high speed gives the UAV huge navigation accuracy and control.
On the ground segment, we have both U-Ground and U-See.
U-Ground is a control station with the other end of the radio link communicating the U-Pilot
with the U-See software.
U-See software is a user-friendly program that runs in any personal computer running
Windows or Linux2.
1 Range may vary with the frequency band used. Default is 900 MHz but legal limitations in
some countries may change this.
2 MAC OS X can be available upon request, but it is considered a second-tier platform and
some features may be unavailable.
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Through U-See, the UAV operator can inspect the current state of the mission and
command it in real-time.
All the U-Pilot configuration is done by Airelectronics staff so the End User does not have to
waste any time setting the internal parameters of the system.

1.1 Concept of system operation
The system is made up of an U-Pilot installed in an aircraft connected to the U-Ground
through a radio link. (See Figure 1: System concept below)
The U-Ground has its own radio link to communicate with the U-Pilot. It also has an RS-232
output to relay the data to a PC running U-See to allow control from the End User.
A Futaba Joystick allows manual override and control.

Figure 1: System concept

The mission team usually is formed by two people:
•

The External Pilot who will have the Futaba Joystick on its hands, in case a manual
control of the UAV is desired (specially during the development and adjustment
phase).

•

The U-See operator that will command the mission using the PC.
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2. U-See
2.1 Introduction
U-See is the software the operator will use to monitor and command the mission. All the
information displayed by U-See comes from U-Pilot. This way the operator can be sure that
the info displayed on the map is the actual information being used on-board for navigation
and control.
The map engine connects to the Internet, fetches Geo-referenced maps, displays them.
The End User is not required to manually load maps and worry about their alignment.
However, it is possible to load such external maps through MapManager application that is
distributed alongside U-See, and choosing map theme display is available in the settings
dialog.
For operational deployments without Internet connectivity, U-See keeps a local cache of
already displayed locations.

2.2 Recommended Hardware
U-See runs on a standard PC.
The recommended hardware specification is:
•

Intel Core i5 5th generation (or later) processor.

•

4 GiB RAM (8 GiB to enable video recording).

•

4 GiB free hard drive.

•

OpenGL capable graphics Video Card.

•

15-inches (720p or greater) screen.

•

1 RS-232 port or an available USB port with a serial USB to RS-232 converter.

•

1 Extra free USB port for license dongle.

All complex computer graphics drawn in U-See use OpenGL, the computer's video card is
computing all the information. As a result, the processor load is lower and it is free to
compute the mission information.

2.3 Software compatibility
U-See supports the main Operating Systems (Windows, Linux and MacOS X). However,
MacOS X is considered a second-tier platform and some functionality may not be available.
Contact Airelectronics and we will provide you with the software that better fits your
requirements.

2.3.1 Windows Installation
To install U-See on Windows follow the steps:
–

Execute Setup-U-See-VERSION.exe (If asked about administrator permissions should
be given, say yes). Then, select desired options.
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Figure 2: Installation process, step 1

–

Click Next > button.

Figure 3: Installation process, step 2

–

Choose the destination folder and click Install.
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Figure 4: Installation process, step 3

–

Wait until the end of the process and the click Close.

2.3.2 Linux Installation
The recommended platform for deployment is Debian GNU/Linux release Buster. Packages
repositories are available to make installing U-See under Linux trivially easy. Contact
Airelectronics for details.

2.4 License Dongle
U-See uses a USB dongle to authenticate
the license and it’s necessary to have it
inserted in the computer while U-See is
running. When the USB dongle is not
found, U-See will warn the user and will
close automatically in 45 seconds. A
countdown together with a red warning
will appear in the lower right corner of the
main window. When the license is found,
the countdown will stop and the license
warning will turn green.

Figure 5: USB License warning

Figure 6: USB License status

2.5 Units and locale
Unit system used for data display is fully configurable through the U-See settings window
(see section 2.15.14 U-See settings)
Available Units are:
•

Distance:
•

kilometers

•

Nautical miles (1 nmi = 1852 m)
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•
•

•

•

•

Statute mile (1 mi = 1609.344 m)

Altitude
•

meters

•

Feet (1 foot = 0.3048 m)

Speed
•

kilometers per hour

•

meters per second

•

knots (1 knot = 1 nmi per hour)

•

miles per hour (statute mile)

Vertical speed indication
•

meter per second

•

feet per minute

Temperatures
•

Celsius (°C)

•

Fahrenheit (°F)

Coordinates and angles are always shown using sexagesimal degrees. However
coordinates presentation format can be changed between decimal coordinates format
(e.g. 41.880263,-7.3828424) and degree, minute and second coordinates format
(41°52'48.9468”N 7°22'58.23264W). When using the decimal coordinate system positive
latitudes are North of equator and positive longitudes are East of the equator. When the
degree,minutes and seconds system is in use coordiantes will be always positive but will
have a letter indicating North(N) or South (S) for latitude and East(E) and West(W) for
longitude
When necessary to input a decimal quantity, the decimal separator used is “.” (the dot)
and also in this document decimal quantities are presented in this way.

2.6 Important considerations before connecting U-Pilot
Every few months newer versions of U-Pilot and U-See are released with new features and
improvements. In spite of our efforts to maintain backwards compatibility, sometimes it is
just impossible. This is why each U-See release has its compatibility assured with only
some versions of U-Pilot. Please, before operating an aircraft with a new U-Pilot or U-See
version, check if they are compatible, otherwise unexpected performance or even an
aircraft crash may occur.
If U-See software detects an incompatible version of U-Pilot connected a warning message
box will show up indicating the current U-Pilot version.
In spite of being strongly discouraged, the warning can be dismissed and the software can
still be used with the connected autopilot by checking the “I understand and accept the
risk” box and then click Accept. Please, really reflect on the fact that an aircraft loss due to
incompatibility is a real (although improbable) possibility before blindly dismiss the
warning.
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Figure 7: Incompatible version detected

2.7 Keyboard Shortcuts
There are specific keyboard shortcuts in order to facilitate the user experience with the
software during the mission. A list of these shortcuts and their function can be found
below:
•

F2: ‘Engine Data’ dialog

•

F3: ‘Sensors Summary’ dialog

•

F4: ‘Electric’ dialog, in Subsystems.

•

F5: ‘Actuators’ dialog, in Subsystems.

•

F6: ‘Hydraulics’ dialog, in Subsystems.

•

Ctrl+S: ‘State’ dialog.

•

Ctrl+Space: ‘Command’ dialog.

•

Ctrl+K: ‘Communications’ dialog.

•

Ctrl+P: ‘Antenna Pointing Assistance’ dialog.

•

Ctrl+L: ‘Multi link Statistics’ dialog.

•

Ctrl+V: ‘Video capture’ dialog.

•

Ctrl+F: ‘Flight Plan’ dialog.

•

Ctrl+Shift+Space: ‘Camera’ dialog.

•

Ctrl+J: ‘Joystick’ dialog.

•

Ctrl+R: ‘Record data’ dialog.

•

Ctrl+G: ‘On-Ground detector’ dialog.

•

Ctrl++: Zoom in on map.

•

Ctrl+-: Zoom out on map.

2.8 Map View
On start-up, the 0°,0° position is displayed with a drop-down menu bar and a toolbar.
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Once the serial port is opened (See 2.9.1 Communications) and data starts arriving to USee, the proper aircraft position will be displayed through an icon and the map will
recenter.
Linked to the aircraft position icon, there is a small overlay summarizing UAV mode, speed
and altitude status. However the display of this overlay is optional and it is controlled
through the U-See Ground Settings dialog (see section 2.15.14 U-See settings)
To move the map click and drag on the screen using the left mouse button.
Zooming can be performed either by use of the mouse wheel, the keyboard shortcut
“Ctrl+ -” and “Ctrl + +” or the “Zoom In” and “Zoom Out” actions in the tool-bar present
in the main window.
Over-imposed on the map, the user will see a set of lines and points that describe the
active and future operations of the UAV. The active task is always drawn in green, while all
the symbology relating non-active features is drawn in blue (e.g. Figure 8, a flight plan is
drawn in green while the landing approach is blue, i.e., the flight plan is active while the
landing approach is on stand-by).
Information relating ground clearance is also optionally displayed on the map. This
information is displayed using a key of three colors: Red, Yellow and Green.
•

Red indicates a problem with ground clearance, such as the ground is above the
projected flight plan or predicted position of the aircraft.

•

Yellow indicates a warning condition: The ground is probably not a problem, but
man-made elements such as antennas, buildings, etc. may pose a threat.

•

Green indicates a level that should be ok, but if the conditions continue to
deteriorate may pose a warning in the future.

These clearance warnings will be shown in the Ground Proximity Warning System display
and over-imposed in the flight plan projected path when a conflict occurs. More details on
these warnings are detailed in section 2.8.3, GPWS Information display
The UAV icon will leave behind a trail of color points. This color will reflect the climb speed.
Red for positive climb rate and blue for negative climb rate.3
The operator can add additional windows on the drop-down menu as described on
2.11 View Menu: Real time information windows.
If the ground system has not received a packet from the connected U-Pilot in the last 5
seconds a red cross will appear over the map display. This is a visual indication of the
failure in the communications link, but the buttons within the window are still clickable.

3 The presence of this trail is controlled by the maps settings in the U-See Settings dialog.
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Figure 8: Example screenshot of U-See. Note different colors for active and standby elements,
trail with climb information and the small overlay

2.8.1 On Map icons
Home Position: This icon will be placed at U-Ground GPS position, provided
U-Ground GPS antenna has sky visibility.
Aircraft Position: Depending the type of aircraft, one of
these two icons will be placed on map at the reported UPilot position.

Landing Site Location: Reported Landing Site
Location, proper orientation will be displayed on
map.
Camera Target: Calculated center of camera pointing coordinates. It is only
shown when the option “Show camera on map” option is checked in Settings→
Ground Settings.
Commanded Camera Target: This blue circle will be painted on the position the
autopilot is trying to aim the camera, when in a Geo-referenced camera-mode,
the previous icon should be firmly inside this one.
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Flight-plan point: The number in the interior is the flight-plan
sequence number. When the autopilot is in flight-plan mode,
outer circle is colored in green, if not, blue is used instead.
If the point is the current flight-plan destination, a yellow circle
will enclose the icon.
Destination Point: This point is used to direct the aircraft when not in
flight-plan, take-off or landing modes. In fixed wing aircrafts, active state
will also include a representation of the orbit radio the aircraft will fly
once the DP is reached. In rotary wing aircrafts, this orbit will be hidden in case it is set to
0.
Landing Hold center: Only displayed with fixed wing aircrafts, this icon marks
the center of the hold pattern for landing (See Section 2.13.1.4.5 Landing
mode)
Carrot Point: Only visible when operating a rotary wing aircraft. It will
report the instantaneous theoretical position the UAV should be at to
comply with planned trajectory, e.g. when going from current position to
new destination point, this point will move smoothly from current position to DP and the
aircraft should remain very close to this point.
Rally Point: (Optional) This point is the designated waiting point to be
used in communications failure if the comm failure sequence is adjusted
to do so.
Other Aircrafts: (Optional) A new icon representing the 2D position of a
detected aircraft is drawn on the map, if ‘Enable Current Trafic Info’ is
activated in Settings→ Ground Settings. Please notice that the icon is not
necessarily representative of the type of traffic

2.8.1.1 Optionally available icons
Hereafter are listed those icons that only are displayed on some specific versions of the
Software when some optional feature is enabled. They are listed here for the sake of
completeness. These may not apply to your software version.
Base location: When operating in moving base mode using a relative
GPS, the base location and heading is displayed with this icon

2.8.2 On Map Information Overlay
Linked to the aircraft position icon a small overlay will present basic status information:
1. Mode indication: The list of mode
abbreviation is found in Table 2: Fixed Wing
Modes Key, Table 3: Rotary Wing Modes Key
and Table 4: Captive Rotary Wing Modes Key
2. HDG: True Heading4
3. IAS: Indicated Air Speed in the configured
system unit.
Figure 9: Basic Information Overlay

4. ALT: Altitude in the configured U-See altitude
unit
5. GS: Ground Speed in the configured system

unit.
4 Measured from geographic north in the 0-360° range.
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6. AGL: Altitude above ground level in the configured altitude unit. See note
AGL information is calculated using a Digital Elevation Model (DEM for
short) incorporated into U-See.
Default DEM used in U-See has global coverage but, in exchange, its
accuracy at some points may be lacking. Errors as high as 150 m. can
exist.
Because of this, it is advised to take AGL values with a pinch of salt, and
only for broad informational purposes. Never fully trust these values for in-flight
planning. A Safe terrain clearance should be kept at all times.
This warning still applies if high detail DEM is loaded instead of U-See default: DEMs
usually do NOT include obstacles (as buildings and antennas) and terrain may have
changed since the DEM preparation date because of human development.

2.8.2.1 Optionally available map overlays
When operating in moving base mode and the feature is enabled, next to the base position
an overlay with information about course and speed of the moving base will be displayed.
This information is only available in some U-See versions and this section may not apply

to your version

2.8.3 GPWS Information display

Figure 10: GPWS information display in action
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GPWS is the acronym for Ground Proximity Warning System. When active (See 2.15.14.3
Maps & DEM configuration5) a circular gridded sector covering the aircraft’s surrounding
8 km will be displayed.
Aircraft is located at its center. Innermost sector is a 300 m. circle which state is the worst
of the surrounding adjacent grid elements.
At every corner of each grid element ground clearance is checked. Ground clearance is
computed as current aircraft altitude minus the digital elevation model predicted terrain
elevation at the element coordinates. The lowest ground clearance is checked against the
configured GPWS warning levels (See 2.15.14.1 Alarms & Warnings):
•

Ground clearance is negative of lower than the configured critical warning level.
Grid element will be red colored. This means that the terrain at that location is
higher than current aircraft altitude, and a fly-to to this location without increase of
altitude will surely cause a loss of the aircraft because of controlled flight into the
terrain.

•

Ground Clearance is between the critical and warning level. Grid element will be
yellow colored. This means that while theoretically the ground should be lower that
current altitude, antennas, man-made obstacles, digital elevation model errors,
trees and other inaccuracies still pose a danger for the aircraft. A fly-to to these
coordinates may cause problems for the aircraft.

•

If Ground clearance is between warning and low altitude level, the grid element will
be painted in green. This shows that while there should be not problem at that
altitude, terrain is near to be a problem.

•

If ground clearance is above the low altitude level, the grid element will not be
painted to avoid map clutter.

Besides the gridded circular sector, the flight plan projected path will also be checked
against the terrain elevation according to current active digital elevation model, if the
clearance of a section of the projected flight plan path is below the configured clearance,
the offending segment will be painted with a thick path of the corresponding color to
highlight the potentially unsafe operation.
This check is executed in a background loop in the ground software and there may be
slight delays between the change of a flight plan point and the updated of the clearance
statistics.

Whenever using a Digital Elevation Model it is important to remember that
these are models, and models sometimes contain errors or inaccuracies.
GPWS overlay is provided for additional situational awareness but is not
substitute for proper flight planning.

2.8.4 Interacting with the Map View

5 DEM is an acronym for Digital Elevation Model
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Map interaction using the mouse has substantially changed starting at
version 1.720
If you have used previous versions of U-See in the past, review this section
carefully.
In case you are using an older version of U-See, contact Airelectronics for
obtaining previous revisions of this document.
Map view is the main way of interacting with UAV navigation control. At all times, the map
can be interacted with the left and right button of the mouse.
Right mouse button click opens a context menu, dragging the mouse with the left button
pressed moves the map and simple left click is reserved for interactions that change
navigation properties in the autopilot.

2.8.4.1 Right Button Menu
A right button click will bring up a menu containing the following entries:
•

Coordinates of the clicked position: longitude and latitude are displayed. Clicking on
this option copy the coordinates to the clipboard.

•

UTM coordinates of the clicked position: If the option “Show UTM coordinates in
map contextual menu” is checked in Settings → U-See Settings, this menu entry is
shown. Clicking on this option allows to copy the displayed position in the clipboard.

•

Elevation of the clicked point: Elevation of terrain is displayed 6

•

'Point Camera Here' action: This will command the camera to point here when in
Geo-referenced modes. This entry won't be shown if the “Show camera on map”
option is unchecked in Settings → U-See Settings.

•

Distance From/To: Action to enable on map measuring.

•

Points of Interest: see section 2.10.3 Points of Interest

If the right click is done on a Point of Interest or a Camera Point, the menu will have the
same entries, but “Points of Interest” entry will be substituted by the following:
•

Set as destination point/landing site: The destination point or landing site will be set
in the coordinates of the Point of Interest or Camera Point that was clicked.

•

Remove POI/Camera Point: The point of interest or camera point will be removed.

•

Measuring on the map

At any given time, measurements can be made on the map. This is accomplished by:
•

Right clicking on the first measurement point and selecting “ Distance From” from
the context menu

•

Right clicking on the second measurement point and selecting “ Distance To” from
the context menu.

•

Distance between the two points will be presented in the left bottom corner of the
map display, right above the scale display.

6 For proper description of vertical datum, please, contact Airelectronics.
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2.8.4.2 Left click interaction
Generally, left button click sends through the radio up-link an order for the autopilot to
change the position of the “Destination Point”. Trough this action, the intention to change
the navigation target (while in the proper modes) is transmitted to the autopilot.
If autopilot has accepted this command the Destination Point should immediately move
right to the clicked position on the map.
It may happen, due to ambient noise and byte losing in the radio-link while operating at
long distance, that the destination point is not updated: shall this occur, just repeat the left
click action.
Exceptions to the “Left button click set destination point” rule exist:
•

When editing a flight plan point (See Section 2.12.3 Flight-Plan) the left button click
rules are a bit different:
◦ Every flight-plan button has an “edit” mode in which the left click on the map
picks coordinates for this point. While in this mode, the cursor will be
transformed in a cross-hair and a tool-tip will be shown reading “Left Button
Picks ID Point N”
◦ When adding a new point to the flight-plan, left click will select the clicked
coordinates as point coordinates. This change in behavior will be indicated by a
cross-hair cursor and a tool-tip moving with the cursor that reads “Left Button
click appends ID Point X. Altitude will default to maintain minimum flight-plan
clearance”

•

Whenever the “Pattern Generation” tool window is opened left click on map will add
a point to the terrain outline (See Section 2.12.7 Pattern Generator)

Flight-plan points position can be edited by dragging them with left mouse button to the
desired new position. The point being dragged and its correspondent lines from the
previous and the next point will appear in gray color. Once the left button is released, a
drop-down menu appears with the options:
1. Set Waypoint with current altitude: this option places the Flight-plan point in the
selected place with the same altitude AMSL that it had before.
2. Set Waypoint with new altitude: this option triggers a new window where the new
desired altitude can be chosen. In systems with multi-reference altitude, the user
can switch between tabs with AMSL (Above Mean Sea Level), AGL (Above Ground
Level) and ALS (Above Landing Site). The color of the altitude spinbox changes
depending on the GPWS Levels.
3. Cancel: exits the edition mode.
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Figure 11: Example of Flight-plan point while dragging

If the point is set in a dangerous position a warning message appears to confirm if the
point is being set.
The same operation can be performed on BackTrack waypoints.
Complete Flight-plan can be moved at a time dragging one of its legs with left mouse
button. The movement is limited to one kilometer from the initial dragging point. While it is
being dragged, the provisional Flight-plan is drawn in gray color. After the left button is
released, a drop-down menu appears with the following options:
1. Set Flight Plan with current points altitude: this option moves the Flight-plan points
to the desired position maintaining their previous altitudes in meters above mean
sea level.
2. Set Flight Plan with altitude increment: this option opens a new dialog with a spin
box where the user can set an altitude increment that will be applied to each point
in the Flight-plan.
3. Cancel: exits the edition mode.
If the Flight-plan is set in a dangerous position a warning message appears to confirm each
conflicting point being set.

2.8.5 Fly/Exclusion Zones and Points of Interest
Fly Zones and Exclusion Zones can be set as seen in section 2.15.15 Fly/No-Fly Zones
Management. In the map, these zones can be edited the same way as the flight plans.
User can move a zone vertex by clicking and dragging it. If the user clicks and drags a
zone line, the whole zone is moved.
If the plane leaves a Fly Zone or enters an Exclusion Zone, an alarm is triggered in the
Alarms section of the State window.

Document Version 1.54

19

U-See User Manual - Map View
Points of Interest can be added to the map as seen in section 2.10.3 Points of Interest.
These points can also be set by right-clicking on an empty zone of the map and then
moving to the “Points of Interest” sub-menu. The position of a Point of Interest can be
edited by clicking and dragging it on the map.

2.8.6 Other on Map Information
2.8.6.1 Camera pointing area
If the option “Show camera pointing area on map” is checked in Settings→ Ground
Settings, and if the camera is not pointing beyond horizontal line, a blue area in the map
will be shown wrapping the terrain that is being pointed by the camera in real time.

Figure 12: Example of camera sight being shown on the terrain

2.8.6.2 Camera tilt and pan widget
If the option “Show camera pan and tilt on map” is checked in Settings→ Ground Settings,
a camera tilt and pan widget will be shown in right bottom corner of the map, indicating
the reported tilt and pan of the camera.

Figure 13: Camera tilt and pan widget
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2.8.7 Traffic State information
If the option “Enable Current Traffic Info” is checked in Settings→ Ground Settings → Maps
& DEM, map shows information related to the reported air traffic: position, velocity,
heading, etc. This information is obtained from public web servers, and there are some
options to be selected in order to show the information. Options related to this feature are
detailed in section 2.15.14.6 Traffic Information.
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2.9 File Menu
Under this menu are grouped all operations relating input and output of telemetry data.

2.9.1 Communications
The communications dialog controls the source of telemetry data presented all through the
program. It is divided among communications with the primary UAV and communications
with other systems, be it other ground stations or secondary telemetry from other UAVs.

2.9.1.1 Comms with UAV

Figure 14: Comms with UAV dialog

At current version, primary telemetry data has three possible sources:
1. RS232 Telemetry data as supplied by U-Ground.
2. A previous flight recording file.
3. TCP/IP Telemetry received from another computer acting as a relay.
Only one source of primary telemetry can be active at a time, and only when connected
through RS232 to the paired U-Ground unit commands can be uploaded to the autopilot on
the aircraft, i.e. TCP/IP clients cannot command the UAV in the standard version.
To access the Communication Window click on the
File → Communications.
2.9.1.1.1

icon menu on the toolbar or go to

RS232 Telemetry (Serial Port section)

This is the main source of telemetry: A U-Ground unit connected to the computer through a
RS232 link. Telemetry will be decoded from the stream and presented all through the
program as soon as it is received.

Document Version 1.54

22

U-See User Manual - File Menu
Only while connected through the RS-232 serial port to U-Ground Software U-See will be
able to upload commands to the UAV autopilot.
To start operation, select the proper port from the drop-down list and click on ' Open'. Upon
successful port opening, the dialog will disable the ' Open' button and enable the Close
button. Besides this, the rest of the dialog will be disabled and the main window will show
a bar displaying current communications health.
Software will remember the last port used in previous sessions.

Figure 15: Communications quality display in main window

Only a source of telemetry at a time is possible, so, if RS-232 operation is desired and the
Open button is disabled, click on Stop button in the Replay Flight File section or the
Disconnect button in the Network section
2.9.1.1.2

Replaying a flight file

It is possible to replay an old recorded flight. To do so, click Select File and choose the file
to replay in the dialog that will open.
Once opened it is possible to pause, accelerate and decelerate with the corresponding
buttons, or select a specific time of the flight using the slider bar. The approximated replay
rate is shown between the accelerate and decelerate buttons.
Once the file has been opened (press play button) it will be scanned to search for the
embedded time marks as reported by the (then) connected autopilot. The displayed time
codes are uptime as reported by the autopilot, so it is possible to have repeated times if in
the same file different autopilots or successive start-ups are captured in the file. Very old
files will contain no time mark and so no time marks will be shown in the slider, however,
the software will continue to allow movement through the file as usual.
While dragging the slider, a box with the reported uptime appears, at slider release the
replay will continue from the selected position. If more precision is needed, the user can
zoom in in the slider by using the mouse wheel if available or clicking the
button in the
dialog. When zoomed, only a small portion of the file is shown, so beneath the position
slider a small blue bar will appear that shows the current slider zoomed coverage
compared with total file size. The blue arrows appearing in the left and right sides of the
slider bar can be clicked and used to move the current section of file shown.

Figure 16: Replay Flight File section

While the replay is ongoing the rest of the dialog will be disabled. To finish reproducing an
archive click the stop button and the dialog will be enabled again.
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Only a source of telemetry at a time is possible, so, if replaying a previous flight is desired
and the Select File button is disabled, click on Close button in the Serial Port section or the
Disconnect button in the Network section
2.9.1.1.3

Network client

U-See can decode telemetry received through a TCP/IP connection and relayed by another
computer connected through RS-232 to U-Ground. Only the U-See instance connected
physically to the serial port of the U-Ground receiving hardware will have the capability to
emit a command to the UAV7.
To operate in this manner, write the hostname (or IP) and port the server is and click on
Connect. Upon successful, connection, the rest of the dialog will be disabled, the Connect
button will be grayed out and the Disconnect button will be enabled.
Hostname resolution is supported, as
well as IPv4 and IPv6 IPs.
Only a source of telemetry at a time
is possible, so, if networking client
operation is desired and the Connect
button is disabled, click on Close
button in the Serial Port section or
the Stop button in the Replay Flight
File section.
U-See can still operate as a server of
data while in network client mode.
This allows daisy chaining several
copies of U-See, although this is not
recommended.

2.9.1.2 Comms with other systems

Figure 17: Comms with other systems

This section of the dialog is used to
re-transmit the received data to third
systems, even allowing a translation
of
protocol
to
allow
intercommunication with different
manufacturer's system.

The data can be retransmitted through another serial port or
by a TCP/IP Network.
2.9.1.2.1

Serial port for export

Telemetry data can be re-exported using a serial-port. Port
Speed, data width, stop bit number and parity are
configurable.
Said data exported is formatted according to the selected
data protocol.
Current standard protocols for serial export are:
•

NMEA 0183: Due to limitations in the NMEA protocol,
only the current position and altitude is exported with
NMEA protocol.
Figure 18: Packet filter selector
dialog for serial connection

7 Modified versions that allow remote controlling are available on request.
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Allow commands from this serial port connection: when active, the selected commands

received from this serial port are transmitted to the UAV. The user can select to allow
different preconfigured presets. In default U-See versions, only these presets are available.
To add more presets, please, contact Airelectronics for a custom version.

Warning regarding Allow Commands
When using this setting is important than only one client has the camera
joystick opened at the same time, or the UAV will receive contradictory
camera movement commands.

2.9.1.2.2

Networks → server of data.

No matter what is the actual source of the data, U-See can retransmit said data to other
computers using a TCP/IP connection.
To enable this behavior, select the desired port to listen on 8 and check the Act as a server
of data checkbox. To disable, un-check the option.
Up to 8 clients may connect to a data server, although this number can be increased by
using daisy chaining.
Protocol of the exported data can be selected through the available menu. Current
protocols available through network are:
•

Airelectronics' telemetry data: To expose the data to another U-See instance.

•

NMEA 0183 position data: Due to limitations in the NMEA protocol, only the current
position and altitude is exported with NMEA protocol.

Allow Client Commands: when active, the connected network clients are allowed to transmit

commands to the UAV. The user can select to allow different preconfigured presets. it is
possible to choose different filters for different clients. When a client is connected, the
default filter is applied, and then the client is identified by its IP and it is possible to select
specific filters for this client. In default U-See versions, only these presets are available. To
add more presets, please, contact Airelectronics for a custom version.

Figure 19: Packet filter selector dialog for network

8 Elevated privileges may be necessary for ports under 1024
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Warning regarding Allow Client Commands
When using this setting is important than only one client has the camera
joystick opened at the same time, or the UAV will receive contradictory
camera movement commands.

2.9.1.2.3

Extra export protocols

Your U-See version may have extra available export protocols. Please check specific
documentation for those options.
Extra protocols can be developed upon request. Please, contact Airelectronics for details.

2.9.2 Record Data
To access to the record window click
File → record data.

on the icon menu on the tool-bar, or go to

To record the data from the flight click on Select File and choose a file or create a new one
by writing a new name.
Once a filename is selected, click on start button to start recording the flight and stop to
finish recording. The recorded flights can be replayed afterward by loading the generated
file in the Communications dialog (See Section 2.9.1.1.2 Replaying a flight file).
An alarm, displayed in state window, is linked to the file writer status (See 2.11.9.1Alarms
section). When recording to a file, REC alarm is green and red when the file writer is not
active.

Figure 20: Record dialog window
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2.10 Map Menu
The map behavior is controlled through this menu.
First two entries in the menu are the usual zoom in and zoom
out commands.
Below, a Clear Map Trace entry is shown: This will clear the
trailing points the map drew to represent past climb rate. By
activating this entry, previous points will be forgotten and a
new trail will begin to show.
Figure 21: Map Menu

The Download Map Region entry will open a dialog to download
regions of the map in order to use the software offline. (See
details in Section 2.10.1 Downloading map regions).

The Document Loader entry opens a new dialog that manages kml files that store
information about zones and points of interest (POIs). More details of this dialog can be
found in section 2.10.2 Document Loader.
These zones and POIs are defined using the Fly/No-Fly Zones Management tool (see
section 2.15.15 Fly/No-Fly Zones Management) and the Points of Interest tool (see section
2.10.3 Points of Interest).
The Points of Interest entry opens a new dialog that manages all the points of interest
placed on the map. More details of this dialog can be found in section 2.10.3 Points of
Interest.
Last section of the menu is a map mode selector:
•

In Map Free you are free to move the map view and inspect whatever you wish.

•

In Plane On Screen the map will re-center on the transmitted position if the actual
position of the aircraft is not in the map view.

•

In Plane On Center the aircraft will remain at all times at the center of the map
view. This option may be heavy in CPU load and battery drain.

2.10.1 Downloading map regions
This dialog allows the user to download certain
regions of the map that should be cached in hard
drive to be able to navigate through them when no
internet connection is available.
To select the regions, the user can navigate through
the map to the region of interest or specify the
coordinates in the spin boxes. The user must also
specify a range of zoom levels that must be available
in that region. Two thumbnails representing the
corresponding top and bottom zoom levels are shown.
Note that if the user navigates through the map
without checking the “Specify region” option, the
selected region will be lost, as well as the zoom level,
that automatically changes with the actual view
zoom.
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When the region of interest is selected, the user can preview how many tiles are inside
that region as well as how many tiles are already downloaded in the hard drive, giving an
approximate download size that may vary depending on the region.
For most standard flights, 18 as the bottom is a very reasonable zoom level. Selecting a
zoom level deeper than 18 will end up in a huge number of tiles that will probably not be
necessary. Also, take into account that there are some regions of some satellite maps,
mainly oceans, desserts and other inhabited areas, where not all zoom levels are available.
In that case, the download will timeout and will not be completed.
It is not possible to download a region which has a size bigger than the map persistent
cache size established in settings (Details in Section 2.15.14.3.1 Map Cache
configurations ).
Please note that this kind of maps are segmented in a very high number of
pieces. While not intuitive, downloading a high number of small files can
be much more taxing for a computer that a single big file.
Because of this it is recommended to use this tool while the aircraft is not
on flight and previous to operations.
A hard limit of 10 000 tiles is imposed on the tool.

2.10.2 Document Loader
Kml files are used in order to store information related to the user-defined fly and no-fly
zones or points of interest. This tool manages the current files used by the U-See
software.

Figure 23: Document Loader dialog

In this dialog, new kml file are created to store new information about POIs and zones, or
an existing file can be loaded with previous data. Multiple files can be created or loaded,
and the dialog informs about the number of loaded files.
All the loaded files can be selected and the dialog shows information about the number
of POIs or zones included on the file, the file path, etc.
In addition, there are some options to set for each selected file.
•

Read-only option: protect the selected file from modifications, i.e., the stored
information is used exclusively in order to show the POIs and the zones on the map.
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•

Default option: assign the current file as the default one for modifications, i.e., new
zones and POIs are stored in this file unless another one is selected.

•

Reload button: update the information of the selected file.

2.10.3 Points of Interest
This tool is used in order to manage loaded and created points of interest.

Figure 24: Points of Interest dialog

Points of Interest are grouped by the following types:
•

Camera points ( )

•

Favourite points ( )

•

Target points (

•

Vehicle points ( )

•

Custom points (up to five types of points defined by the user). For each created
point, the dialog shows point’s coordinates, name, style or type, creation date and
document in which it’s stored.

)

A point can be selected by type and name. Buttons placed on this dialog are:
•

Create button: create a new point. By default, the point is located on the center of

the map’s coordinates and it’s stored in the default kml file.
•

Edit button: Edit parameters of the selected point.

•

Center button: Move the map view in order to place the current point to the center

of the screen.
•

Remove button: Erase the current point from the associated kml file.

The point name of each style are numbered in increasing order, from the last available
point. The name can be edited from this menu clicking in ‘Edit’ button. The date and time
is captured from the UAV GPS in case available, otherwise from the computer date time.
The user can add up to five custom points types. A specific name and icon can be
introduced for each custom type using the ‘Add/delete Custom POIs types’ menu.

Document Version 1.54

29

U-See User Manual - Map Menu

Figure 25: Add/delete Custom POIs types menu

Once the icon and the name are introduced, the ‘validate’ button should be clicked. Each
created custom type can be deleted using the ‘trash’ button. Custom icons must be 32x32
size as maximum pixels.

2.10.3.1 Camera Points
It is possible to set Camera Points by clicking in any point of the video shown in the Video
Capture dialog (Section 2.11.6.1), allowing the user to mark a point of the image in the
map. A point is created only if the camera is pointing to the terrain, thus the point is
actually on some position in the map. It is also possible to add a point from the map
contextual menu.
Finally, UTM coordinates are specially relevant for camera points: to show this data in map
contextual menu, the user can check the option “Show UTM coordinates in map contextual
menu” in Settings → U-See Settings.

2.11 View Menu: Real time information windows
The U-See software have a set of windows that will report information to the user in
real-time, allowing to control the current state of the UAV. These windows are shown
independently to support multi-display environments more comfortably.

2.11.1 Live Graphs
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Figure 26: Live Graph: IAS vs Commanded IAS

This window represents live information of different values of the system. The base time
can be accelerated or decelerated using the spin box (higher values are fastest, 0 means
real time and negative values slow down the base time). The dialog also allows to freeze
the graph. If mouse tracking is enabled, a box appears next to the mouse cursor
representing the value under the cursor in the given units.
Available graphs are:
•

Pitch: represents the commanded pitch and the current system pitch in degrees.

•

Roll: represents the commanded roll and the current system roll in degrees.

•

Yaw: represents the commanded yaw and the current system yaw in degrees.

•

IAS: shows the current Indicated Air Speed (IAS) and the commanded IAS. The unit
is consistent with the speed units chosen in the U-See Settings dialog.

•

Altitude: shows the current UAV altitude and the commanded one. The unit is
consistent with the altitude units chosen in the U-See Settings dialog.

•

Ground Speed v IAS: shows the UAV Indicated Air Speed (IAS) and the UAV Ground
Speed. If the system has external dynamic pressure sensors installed, the curves for
the main pitot and the external ones are reported. The colors used in this graph are
consistent with the colors used in the pitot calibration in (2.15.10) Air Data System
Settings dialog.

2.11.2 Software Version
This window will show information about current connected autopilot software version and
its serial number.
The Flight and Mission software version will be displayed and it should match in both CPUs.
Serial number of the connected autopilot is also displayed.
This information can be used to check against Airelectronics' supplied software
compatibility list and to establish manufacturing date and features available on your
autopilots.
This information will be asked on initial contact with Airelectronics' support.
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2.11.3 Sensors Summary
In sensors summary window it's possible to see the real time data received by U-See
concerning the on-board sensors. This window is divided in ten panels:

Figure 27: Sensor summary window display. Barometric Correction, GPS state, GPS Channels Signal

•

Euler Angles and Vertical Speed: Representing the attitude of the vehicle and the
vertical speed.

•

Internal temperatures: Measurement from the internal temperature sensor/sensors
in the autopilot. Triple sensor version will have three temperatures, while single
sensor version will show only one.

•

Barometric Correction: As an option, autopilot and ground control station exchange
information to establish high precision barometric altimetry. This dialog allows
monitoring of barometric correction status.
This barometric correction section displays the current barometric correction applied
to on-board pressure sensor since last reference setting (See Section 2.15.10 Air
Data System Settings), current ground sensed altimeter value in meters and a
correction status description.
Possible status are:

•

OK: Ground Sensor is working well and a valid reference was established so
correction is being correctly applied.
•

BADSENS: Ground Sensor is failing for some reason and thus, high precision
differential altimetry is not available. Should you find this condition, try
power-cycling the U-Ground Hardware. If this condition persist, please,
contact Airelectronics for support.
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•

•

NOREF: No valid reference could be established. High precision differential altimetry
is disabled.
•

NOCONFIG: Differential altimetry was not activated or is not supported by
current autopilot and ground station pair.

•

EXCESS: Excessive correction detected. If variation since reference was
established surpass a threshold, correction is discarded as invalid. This may
be indicative of ground sensor failure. Please, contact Airelectronics for
support in this case.

•

NOTSET: Barometric altimetry has never been crossed against GPS
measurement in the current autopilot uptime. This is a typical situation
encountered when the system has been powered-on recently and has never
had a valid GPS fix. This implies that current static pressure indication may
be off by several dozen of meters until an altimeter 'set' command is
performed. For this, go to Settings → Air Data system and press the 'Sync GPS
& Altimeter' button. Valid GPS fix is necessary for this to work and the
autopilot will perform automatically a set command when it has GPS fix
calculated with at least 6 satellites.

•

FILT: The Ground Control station indication of pressure have changed too fast
in a very short time and the autopilot is introducing this correction in a
filtered way to avoid sudden changes of altitude. This situation can occur
when recovering contact with an UAV after a long period of communications
blackout. Special attention is required in case this occurs.

Position: Shows data used as valid GPS navigational fix aboard the UAV. In UAVs
with more than one source of GPS, a button will appear here with the text “Show
Multi-GPS”. This button opens a new dialog that shows the current status of each
available GPS on-board.

Figure 28: Multi GPS window

•

State: shows quality information regarding the fix:
◦ Mode shows what kind of solution the GPS is offering. Possible modes are: 2D,
3D, DGPS and 'No Fix'.
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◦ Satellites show the number of satellites used to produce current navigation fix 9.
◦ Diff Age: Shows how old is the data used for Differential correction
•

U-Ground Position: GPS solution for the position of the Ground Control Station.

•

Dilution: How precise is the position obtained by GPS.

•

GPS UTC Time: shows reported GPS Coordinated Universal Time.

•

Pitot Indicator: shows the speed measured by the dynamic sensor/sensors. In
systems with external dynamic pressure sensors installed, the system will report 3
channels. Otherwise only main dynamic pressure sensor is reported.

•

GPS Channel Info: you will have access to the signal status of the tracking channels
the GPS modules has. Informing you of which satellite the autopilot is tracking to
compute its GPS position and what signal level is receiving from every satellite.
The chart shows the identification of the Space Vehicle being tracked (SV ID). Those
SV identified with numbers above 120 correspond to SBAS 10 systems such as WAAS
or EGNOS.
The chart displays also the signal level. Acceptable signal levels would be over 30
dbHz.

•

IMU Sensors: this section reports the values of x, y and z axes of IMU's gyroscopes
and accelerometers. In U-Pilots with triple sensor section “Source Of Measure”
appears. This additional section shows the sensors being used to calculate the
value for triple sensor. Green means all sensors are being used. When the label is in
orange, the sources used are reported.

2.11.4 Relative GPS Status (Optional)
This window will be only displayed on moving base operations enabled versions of U-See.

So this section may not apply to your U-See version

Figure 29: Relative GPS typical appearance

This window shows information about the current status of the Relative GPS solution. It will
show the baseline distance and the azimuth and elevation of the baseline. Said azimuth
and elevation is measured from geographic north and oriented in the Base-Rover direction.

9 Do not mistake this number with the number of visible satellites over the horizon.
10 Satellite Based Augmentation Systems
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Below this, there is indication about the quality of the solution by mean of indication of
sigma(σ) value. This value shows the threshold in which a 60% of the measurements given
by the system will be inside that threshold. Fully operational system should give sigmas in
the range of the thousandth of degree.
MasterPOS shows the current GPS solution for the moving base position.
Status shows the kind of solution that is being computed and Operative shoes with a true
or false indication if the system is usable for landing operation in a moving base.
Possible status for the solution are:
•

None: System could not establish relative positioning.

•

PSRDIFF: Solution comes from a differential correction of pseudo-ranges. Relative
positioning obtained using this method is considered not valid for accuracy landings
on moving bases, but could work for stationary approaches.

•

L1_FLOAT: Floating L1 ambiguity solution. Typical sigma of this mode will be around
1°.

•

L1_INT: Integer L1 ambiguity solution. Typical sigma of this mode is around 0.1°

•

NARROW_INTEGER: Carrier phase wave-number is calculated using the maximum
information possible. This is the desired state of functioning and typical sigma can
be as low as 0.001°

Notice possible state are ordered from less to more accurate.

2.11.5 Antenna Pointing Assistant
This dialog supplies manual antenna
tracking information. Relative position of
the UAV is displayed by a two-pane
display, one for horizontal relative
position and another for vertical.
The
pointing
is
calculated
using
geographical bearings and the unit used
is sexagesimal degree.
On each half of the display precise
azimuth and elevation can be read from
the bottom right corner.
The pointing can be calculated from the
landing site or from the position given by
U-Ground GPS Fix. This can be selected
Figure 30: Antenna Pointing Assistant window as
through the drop-down menu at the
displayed in software
bottom of the window. When “Auto” is
selected, the pointing will be calculated from the U-Ground GPS Fix if it is available, and
from the landing site if it is not. This change will occur automatically.

2.11.5.1 U-Antenna Tracker specific options (optional)
When U-Antenna Tracker11 is connected, the additional options will show up and the
window is divided into 2 parts: the two-pane display on top side, and an area of
configuration buttons at the bottom. UAV Horizontal relative position is displayed on the
left side of the two-pane display, while the vertical relative position is displayed on the
right side. Both represented by a black needle.
11 To obtain more information about this product, refer to User Manual or contact Airelectronics.
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Additionally, more needles are shown on the horizontal plane in order to show U-Antenna
Tracker telemetry data. As it's the case of commanded position in yellow, current pointing
position in blue, and the U-Antenna Tracker orientation in gray. Every position is azimuth
referenced, which value will be displayed at the bottom of this compass.
UAV current elevation will be displayed on the right side. U-Antenna Tracker doesn’t
support tilt movement at the moment.
The rotator spin can be controlled either in auto or manual mode. At the bottom there are
2 group boxes identifying the current working mode (auto or manual), at the left side, and
its parameters at the right side.
2.11.5.1.1

Auto Mode

U-Antenna Tracker starts in auto mode and waits for a commanded angle to start running.
Auto mode works according to a location given by the GPS allocated on the U-Pilot board,
which transmits the UAV position to the U-Ground through the radio link. Based on this
provided data and its own GPS signal, U-Ground performs some calculations to allocate the
UAV relative position and then, commands the U-Antenna Tracker by a permanent
provision of azimuth-referenced angles.
The user will be able to set an offset value in order to match the desired direction to track
the UAV current position, if necessary. It's the only value the user will be able to modify in
this working mode, done by clicking either the "Left" or "Right" button, which will apply a
constant negative (left) or positive (right) offset every time the user clicks them. Offset
value can be reset to 0 by clicking "Reset"
button.
2.11.5.1.2

Manual Mode

Clicking the "Manual" button triggers the
change to manual mode. Manual mode
commands the current angle, causing the
rotator to stop. In addition, the window
will get modified and the new working
mode parameters will show up.
Commanded command in manual mode
can be changed either by typing angles
on the text line or by clicking on the angle
directly on the compass at the top side.
2.11.5.1.3

Dead Zone

The rotator doesn’t support continuous
rotation, but it can rotate more than 360º
(480º). The zone where there rotator is
outside the first 360º is called dead zone.
Figure 31: Antenna Pointing Assistant window with
Based on its orientation, a gray pie will be
U-Antenna Tracker special features
displayed in order to reference it. In this example, the rotator is not able to spin beyond 225 or +225 degrees from its orientation.
If the rotator reaches its dead zone (always represented on the compass by a gray pie)
while tracking the UAV, it will trigger a turnaround in order to track the UAV back. Given
the current rotor speed rate, this would cause communications losses for several seconds
until the tracker is tracking the UAV back.
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2.11.5.1.4

Orientation

In order to avoid mentioned in the previous section, U-Antenna Tracker can be oriented
towards any of these four compass points: North, East, South or West. The zero reference
angle of the tracker needs to be oriented towards that bearing. Orientation can be
changed anytime during U-See execution, no matter the current working mode at that very
moment, but we strongly recommend to modify this parameter prior to start flying.

2.11.6 Video Capture (Optional)

Figure 32: Video capture dialog with advanced options deployed

This is an optional feature and may not apply to your U-See version
U-See optionally supports opening video devices to show video as acquired by the UAV.
Video devices are listed by name in the upper drop-down list. The device list can be
updated using the “refresh”( ) button. Through open and close button besides the device
lists, the video devices are opened or closed. If your version of U-See is capable of
receiving a digital video stream over the network, the options “H264 TS”, “H264 RTP” and
“JPEG RTP” will appear. Details about this feature are explained in section 2.11.6.2 Video
Over Network (Optional).
Video Capture Device: Although U-See may be able to read video from
several capture devices, it is encouraged to use the device provided by
Airelectronics in order to prevent compatibility issues.
You can select different resolutions before opening the video, and the video will be scaled
to fit this resolution. If the detected resolution of the original incoming video doesn’t have
the same aspect ratio as the selected resolution, black borders will be created. If the
desired resolution of the video is not listed, it is possible to select a custom resolution by
selecting the last option of the list (Custom) and typing the desired resolution in the dialog
that pops up.
Video Overlay shows in the center at the top of the frame the calculated camera course.
On the top right corner the current camera mode is reported. Under the camera mode
report, an indicator shows the current camera bearing. A bar in the right side of the frame
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shows the current zoom commanded. In the left of the window there is a bar showing the
reported tilt of the camera. The left bottom corner contains a box with title “POINTING”
showing the calculated positions, altitude and distance of the center of the image. If the
distance to the target is being calculated (not actually measured by the camera) the
distance will have the word CALC appended after the measurement unit. Note that a laserequipped camera is needed for this distance to be actually measured.
On the left upper corner, “CAM” box reports the active camera. If no active camera is
reported, this box is automatically hidden and disabled.
The bar in the bottom center displays reported pan of the camera. At the right bottom,
with the title “UAV” there is a box reporting current Ground Speed (GS) of the aircraft and
current Line of Sight (LOS), the distance between the aircraft and the landing site.
Furthermore, it is possible to show a unified tilt and pan indicator in the left bottom corner.
If this indicator is enabled, the individual pan and tilt indicators are disabled, and vice
versa.
Note that not all cameras have feedback angles or zoom. Feedback angles will be reported
if available. In case there is no report of angles, commanded angles will be displayed (in
case of servo controlled cameras). If the camera connected is Open Loop there is no report
and no command, in this case camera course, pan, tilt and pointing options are disabled
and hidden.
All these elements in the Overlay can be hidden by clicking the related check-box in the
“Adv. Options” menu. “Overlay Color” button shows a dialog where the Overlay color can
be selected.
Video recording is also available through the buttons at the bottom of the dialog. Once the
device is opened, to start recording, select your preferred video codec and clic button
“Start” ( ). To stop the recording press the button “Stop” ( ). Available video codecs are:
•

h264: record h264-compressed video to an .avi container.

•

VP8: record VP8-compressed video to an .avi container.

•

Theora: record Thera-compressed video to an .avi container.

•

XRAW: record raw frames to an .avi container.

Keep in mind that XRAW recording consumes a fair amount of hard drive space, and h264
recording consumes a fair amount of CPU time. Please, have into account the capabilities
of the computer you are using while recording and flying an aircraft.
It is also possible to capture individual frames as picture using the third button in the
bottom row “Capture” ( ).
The file names and paths of the video and picture files created is adjustable from the
section “Recording” in Settings→ U-See Settings (see Section 2.15.14.4.2 Multimedia
Record).
Note for Windows Users it is recommended to save the video into your
user folder. If the user tries to save the video to a folder with no write
permissions (i.e. C:, C:/Program Files/) may create a virtual C: drive in
$USER/AppData/Local/VirtualStore/, being the videos saved in that folder.
If this is the case, the video will appear in the VirtualStore folder instead of the original
location when trying to open with a different program.
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By clicking the button “Adv. Options”, it is possible to adjust different visualization settings.
In the first tab, Brightness, Contrast and Saturation and mirroring options are exposed.
Brightness, Contrast and Saturation can be modified at any time, but mirroring can be
changed only when not recording.
In the second tab, it is possible to enable/disable different video overlay elements.
The third tab will be enabled when a video tracking device is present and absolute tracking
is used. It allows the user to override the video resolution detected by the video player to
perform the video tracking. This is only necessary when the video is resized during the
transmission or reception.

2.11.6.1 Clickable action on video playback
When video is being streamed in the video capture window, it is possible to perform a
number of actions using the mouse on the video. Take into account that video margins are
ignored in case that different aspect ratio is selected rather than the original aspect ratio
of the video received:
•

Performing a click on the video selects a tracking point in that video coordinate in
case the camera supports object tracking.

•

Right clicking anywhere on the video deselects last tracking point.

•

Performing a click while holding control key on the keyboard selects a camera point
that is displayed on the map. More information about camera points in section
2.10.3.1Camera Points .

2.11.6.2 Video Over Network (Optional)
If your U-See version is ready to receive video over network, some extra video sources
“H264 TS”, “H264 RTP” and “JPEG RTP” will appear in the drop-down device list.
When selecting and opening one of these, U-See expects to receive an stream over UDP
with the following requirements:
•

“Network H264 TS”: H264-MPEGTS in port 15004.

•

“Network H264 RTP”: H264-RTP in port 15004.

•

“Network JPEG RTP”: JPEG-RTP in port 41251.

The UDP socket is not bound to a specific IP address of the system. In order to receive the
video stream, the IP configuration of the computer running U-See needs to be set correctly
to match the subnet and network mask of the video transmitting equipment. Configuring
the OS network stack (Windows, OS X, Linux) is beyond the scope of this document.
Please, consult your video transmitter manual regarding TCP/IP network necessary settings
to receive the video and your OS manual to learn how to setup the network stack.

2.11.6.3 Video Source Toggles (Optional)
If the payload equipped has several cameras available (normally Daylight or Thermal),
they may be selected through an option that appears in the upper left corner of this dialog
(apart from being available in the Camera command dialog).

2.11.6.4 Video Processor options (Optional)
Some video processor options will appear in this dialog, in a row between the video and
the recording options, whenever a video processor is present (be it independent or
equipped with the gimbal). To see a complete list of options see Section 2.13.9 Video
processor (optional).
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2.11.6.4.1

Epsilon 140Z

Figure 33: Video processor options that appear in the video capture dialog for Epsilon 140Z

2.11.6.4.2

ASIO 155

Figure 34: Video processor options that appear in the video capture dialog for ASIO 155

2.11.6.4.3

Sightline

Figure 35: Video processor options that appear in the video capture dialog for Sightline

2.11.6.4.4

Other

Other video processors might be supported upon request to Airelectronics.

2.11.6.5 Video broadcast
It is possible to broadcast the video on this dialog by
clicking on the “Broadcast” button located on the top.
This will open a window with several options:
•

Host: The destiny IP of the video.

•

Port: The port to use to broadcast the video.

•

Bitrate: The quality of the video in kbps.

•

Enable: Whether to enable video broadcast or not.

2.11.7 Multi Link Statistics (Optional)

Figure 36: Video broadcast target
dialog

This is an optional feature and may not apply to your U-See version
Contains information of the status of the Radio Link(s). The section Multi Link information
shows the Comms quality percentage. On the left side, the circled numbers show which
link is active (green) and which is waiting (gray).
The
communication
is
bidirectional and asymmetrical,
so downlink is used to name the
link from the aircraft to the
ground and uplink from the
ground
to
the
air.
Also,
depending on the software
version, it may be possible to
establish a third non-radio link.
Figure 37: Multi Link Statistics dialog example.
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On the right side, section uplink shows the
number of packets received in the air. Note
that if downlink is in malfunction state, this
statistic will not be reported.

2.11.7.1 Radio Link Statistics
The section Radio Link Statistics displays the
power of the signal, the noise received and
the margin between both. To display this
section, click on the arrow or the text of the
section. The data in the left side is relative
to the primary link while the right side
shows the data of the secondary one. The
graphs report this information in real time.
The user can zoom in and out the graphs
and drag the Y axis position. The movement
and zoom between both graphs is
synchronized.
Radio buttons below the graphs allow to
switch between showing both signal and
noise or the margin between the two values.

Figure 38: Radio Link Statistics graphs example.

This statistics won’t be available for a third non-radio link.

2.11.7.2 Crypto Specific Information (optional)
When encrypted communications are enabled, new functionality is unlocked and additional
information is supplied. Also, a third link appears. This optional link is though to be used as
a SATCOM connection.
One box is displayed for each link and
direction of the link. (Link 2 uplink
direction is not displayed given that
usually only one radio link is boarded on
the aircraft). In each box, the following
stats are displayed:
•

Decoded: packets that were
decoded successfully, and thus,
were received
correctly,
per
second.

•

Accepted: packets that were
decoded
but
also
accepted
because they arrived earlier to
that link, per second.

•

Delay: this delay is calculated in
reference to the first primary link
and is given in number of packets,
so negative delay means that
packets arrive earlier to this link
with respect to the first one and
viceversa.

Figure 39: Cripto Specific Statistics example.
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The “calculate delay in ms” option makes that the quantity displayed in delay is not
measured in packets but in milliseconds. The calculation is based on the total number of
packets decoded per second.
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2.11.8 Synthetic View / Artificial Horizon
Go to View → Synthetic View to open the real time synthetic 3D vision.
The 3D view represents the aircraft surroundings with data provided by the Digital
Elevation Model and the landing point location.
Additionally to the 3D environment information, the Synthetic View provides a lot of useful
real time information through a HUD, such as speed, altitude, course or variometer.
Terrain elevation is generated using a Digital Elevation Model (DEM for
short) incorporated into U-See.
Default DEM used in U-See has global coverage but, in exchange, its
accuracy at some points may be lacking. Errors as high as 150 m. can
exist.

'PSEUDO-VISUAL'

FLIGHT

USING

THIS

VIEW

IS

STRICTLY

FORBIDDEN. Its accuracy is not enough to keep the plane from running into ground. This

view is supplied only as a way of improving situational awareness of the operator. Not
as a tool to pilot the plane.
This warning still applies if high detail DEM is loaded instead of U-See default: DEMs
usually do NOT include obstacles (as buildings and antennas) and terrain may have
changed since the DEM preparation date by human development.
The HUD also represents the autopilot commanded values in yellow color and the
commanded attitude in purple like a flight director. The variometer on the right side
represents the instant variometer measure with a filled triangle and the filtered value with
an empty one.
On the bottom of the display information about unit being used to present the data is
given.

Figure 40: Synthetic 3D View

Figure 41: 2D Artificial Horizon

Information about the visualization mode and flight mode is represented on the top left
corner and the distance to the landing is placed on the right.
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The 3D visualization can be deactivated in order to use a standard Artificial Horizon just
unchecking 3D View on the top of the window. Flight director can be also enabled/disabled
by using the “Flight Director” checkbox.

2.11.9 State
To access to the State window click
go to View → State.

on the toolbar or

The State window is divided in three sections, alarms,
surfaces information and subsystems indicators. The alarms
section occupies the upper section, the surfaces information is
at the middle region and subsystems indicators at the bottom.
If the ground system has not received a packet from the
connected U-Pilot in the last 5 seconds a red cross will appear
occupying this whole window. This is a visual indication of the
failure in the communications link, but the buttons within the
window are still clickable.

2.11.9.1 Alarms section
On the alarms section is possible to see if all systems are
working properly. To start a flight is necessary that all alarms
are set in green. Notice that the magnetometer alarm (MAG)
does not appear when using a fixed wing vehicle, and the
dynamic pressure alarm (QD) does not appear when using a
rotary wing vehicle.
A system operating properly will be reported by a green
background. Any system in critical abnormal condition will be
drawn with a red background. Systems that are operational
but with some problem or limitation are presented with an
orange background. Those system currently not being
checked are displayed with a gray background.
When right-clicking on the MODE alarm a context menu is
shown. In this context menu the user can command different
Flight Modes. These Flight Modes vary depending if the aircraft type is fixed wing, rotary
wing or captive rotary wing.
Figure 42: State window

Also, when right-clicking on the CAM alarm, another
context menu is shown. In this case, the user can
command different Camera Modes. These Camera Modes
vary depending on the type of camera that is connected.
Please note that the voltages alarms may be bounded by
limits defined in U-See instead of the autopilot itself (See
2.15.14 U-See settings).
Table 1: Alarm descriptions
meaning of the alarms.
Alarm

GPS

Green

Valid
navigation
obtained from GPS

hereafter

describes

the

Orange

fix Not possible
alarm

Figure 43: Alarms section of the
State Window
Red

in
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Alarm

Green

Orange

Red

GYRO

Gyro is working properly

ACC

Accelerometer is working This state indicates that A failure in the Accelerometer
properly
measurements
from sensor has made the attitude
Accelerometer sensors estimation unreliable.
are inconsistent and the
sensor suite is operating
in a degraded mode

JOY

Connected Joystick
receiving data.

PS

Correct
values

QD

Correct dynamic pressure Not possible
values (Not used in rotary alarm
wing vehicles)

for

this Static pressure measure failed or
out of range (Not used on rotary
wing vehicles)

MAG

Receiving magnetometer Not possible
signal (Not used on fixed alarm
wing vehicles)

for

this Not
logical
magnetometer
values or out of range (Not used
on fixed wing vehicles)

COMMS

Communications level is Communications level is Communications level is below
above 60%
below 60% but above 40%
40%

Internal
battery 1

ADC1 voltage value within Not possible
configured limits
alarm

for

this ADC1 voltage value
configured limits.

out

of

Internal
battery 2

ADC2 voltage value within Not possible
configured limits
alarm

for

this ADC2 voltage value
configured limits.

out

of

Internal
battery 3

ADC3 voltage value within Not possible
configured limits
alarm

for

this ADC3 voltage value
configured limits.

out

of

Internal
battery 4

ADC4 voltage value within Not possible
configured limits
alarm

for

this ADC4 voltage value
configured limits.

out

of

TEMP

Autopilot temperature is Autopilot is between Autopilot temperature is below
between 0°C and 70°C
-10°C
and
0°C
or -10°C or above 80°C
between 70°C and 80°C

TERRAIN12

According to current DEM
and current UAV 3D
velocity, the next 20
seconds do not present
risk of entering proximity
of the ground

static

This state indicates that A failure in the Gyro sensor has
measurements
from made the attitude estimation
Gyro
sensors
are unreliable.
inconsistent
and
the
sensor suite is operating
in a degraded mode

and Not possible
alarm

for

this Joystick not found; or an
incremental joystick is plugged
when the option is not checked
or viceversa

pressure Barometric altimetry has Static pressure measure failed or
some problem which out of range
reduces its accuracy.
Check section 2.11.3
Sensors Summary for
detailed information

According
to
current
DEM and current UAV 3D
velocity, the UAV will, at
some
point
in
the
following 20 seconds, be
in moderate proximity
with the terrain.

According to current DEM and
current UAV 3D velocity, the UAV
will, in the following 20 seconds,
be in close proximity with the
terrain.

12 To define how close is too close, altitude warning levels can be configured through
Settings → U-See Settings. Check section 2.15.14 U-See settings
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Alarm

Green

Orange

specified Not possible
alarm

Red

DIST

UAV is within
distances limits

ENG

Engine is operating within The
Engine
is
limits
operational but some
operation parameter is
in degraded mode.
Check
engine
data
window under view →
engine data for further
info

ARL
(Auto
Return
Limits)
(Note
that
Bingo
time
and COMMs
have
their
own
alarm
and it is not
included
in
this one.)

Some limit for auto-return Not possible
in mission supervisor was alarm
surpassed and a return
home is recommended. 14

for

this Never in the uptime of the autopilot
an
auto-return
home
request has been issued by
mission-supervisor limits.

Bingo time
(2.12.5 Bing
o Time)

Remaining
displayed

time Not possible
alarm

for

this Bingo time exceed “BINGO” is
displayed

Camera
Not possible for this alarm Not possible
Mode.
Text
alarm
will
display
current
mode.

for

this Not possible for this alarm

REC

Recording data

Not possible
alarm

for

this Not recording data

Mode15

Flight mode selected

Reduced control mode Autopilot mode active has very
active.
limited or none control ability
and could cause a crash if
unattended (e.g. Manual mode)

FLY ZONE16

The plane is flying over a The plane is over an The UAV is over an Exclusion
Fly Zone, or over an undefined zone if there Zone,
undefined zone if there are Fly Zones set.
are only Exclusion Zones
defined.

Bingo

for

this UAV is farther than configured
distance limit
Engine is not operational or
some fault is being reported that
severely
compromises
the
continuity of flight.
Also red when, in electric
vehicle,
battery
level
falls
beyond configured limit.13
Check engine data window
under view → engine data for
further info

Table 1: Alarm descriptions

13 Check section 2.15.14 U-See settings for details on how to set battery limit for alarm.
14 This feature may be not present in your version of U-See.
15 Check Table 3: Rotary Wing Modes Key and Table 2: Fixed Wing Modes Key for the meaning
of mode key displayed as text in this alarm
16 If there are no Fly or Exclusion Zones the alarm is not shown. Check section 2.15.14 U-See
settings for further details on how to set zones.
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Fixed wing modes
Reported mode
in alarms

Meaning

MANUAL

Manual mode

FLYTO

Fly to mode

ROULETTE

Roulette mode

RETURN

Landing mode: Returning towards the landing field

HOLD

Landing: Hold a circular pattern to adjust UAV altitude to a
proper value for final

FINAL

Landing: Executing Final approach

FLARE

Landing: executing landing flare to touch ground

SERVOS

Servo adjustment mode

LOOPS

Internal Loops mode

ORBITING

Orbit mode, the UAV will describe circles around a set point

FPLAN

Flight plan. UAV will follow flight plan point by point

TAKE-OFF

Take off: UAV is executing a take-off maneuver

CATARM

Catapult launch is armed. Autopilot is waiting to detect
movement to go into full Take-Off mode

ABORT

Autopilot is executing a pre-programmed abort manouver.

S-FLYTO
ORBIT

/

S-

Equivalent to FLYTO and ORBITING but with moving base
support. These modes will maintain relative geometry to the
moving base

RET_NET

Landing Mode: Returning for a net Landing with a moving base

HOLD_NET

Landing Mode: Hold pattern for net approach with a moving
base

FIN_NET

Landing Mode: On final approach for net landing with a moving
base

L-TAKEOFF

Auto-Learn TakeOff: For hand launched aircrafts

SAFE-RET

Come Above mode: In this mode the UAV will navigate to the
vertical of the landing site and start an orbiting upon arrival

CAM_GUIDED

Camera Guided mode: Navigation is slave to the camera
pointed coordinates: UAV will navigate to reach the camera
pointed camera and keep the target on camera.

Backtrack mode for landing site. FLYTO and ORBIT subpart of
BACK_FLYTO_L the mode will identify whether the aircraft is flying between
BACK_ORBIT_L points of the bactrack (FLYTO) or adapting altitude before
progressing for next backtrack point (ORBIT)
Backtrack mode for Rally point. FLYTO and ORBIT subpart of
BACK_FLYTO_R the mode will identify whether the aircraft is flying between
BACK_ORBIT_R points of the bactrack (FLYTO) or adapting altitude before
progressing for next backtrack point (ORBIT)
RALLY_ORBIT

Orbiting around Rally point
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Fixed wing modes
Reported mode
in alarms

Meaning

TAXI

On-Ground Taxi.

TAXI_BRAKE

On-Ground communications failure mode for taxi (Idle engine
and brake in a straight line)
Table 2: Fixed Wing Modes Key

Modes with yellow background are aircraft-specific modes and may be unavailable for your
U-See version.
Rotary Wing modes
Reported mode in alarms

Meaning

MANUAL

Manual mode

NAV

UAV will navigate to a set point and
keep a hovering flight over this point
at the commanded altitude when
arrived.

FPLAN

Flight plan mode.

TAKE-OFF

Take off Mode.

LANDING

Landing Maneuver.

SERVOS

The system is in servo adjustment
mode.

ELOOPS

Internal Loops.

CAM_GUIDED

Camera Guided mode: Navigation is
slave
to
the
camera
pointed
coordinates: UAV will navigate to
reach the camera pointed camera and
keep the target on camera.

SPOOL-UP

When incremental throttle is used,
this mode increases the engine
rotation up to a stable point prior to
take-off.

WARMING-UP

This mode must be commanded in
the ground as a secure mode when
the aircraft is equipped with an
internal combustion engine that might
generate vibrations and that takes
some time to warm up to the working
temperature.

GROUND-STBY

This mode must be commanded in
the ground as a secure mode with
incremental throttle, disables throttle
command and gyro stabilization.
Table 3: Rotary Wing Modes Key
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Captive Rotary Wing modes
Reported mode in alarms

Meaning

CAPT_MAN

Manual mode

CAPT_HOLD_POS

UAV will navigate to the destination
point and keep a hovering flight over
this point at the commanded altitude.

CAPT_TAKE_OFF

Take off Mode

CAPT_LAND

Landing Maneuver on progress

CAPT_LAND_FINAL

Final phase of landing maneuver

SERVOS

The system is in servo adjustment
mode

CAPT_INT_LOOPS

Internal Loops

SPOOL-UP

When incremental throttle is used,
this mode increases the engine
rotation up to a stable point prior to
take-off.

GROUND-STBY

This mode must be commanded in the
ground as a secure mode with
incremental throttle, disables throttle
command and gyro stabilization.
Table 4: Captive Rotary Wing Modes Key

NOTE: Servo adjustment mode and internal loops are not flight modes, and they should
never be commanded during an actual flight.
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Camera mode

Meaning

FORW

Forward looking: Camera will look
straight ahead of UAV

MANUAL

Camera will point whatever value
the user has selected

STABILISED

Camera will compensate for attitude
variations of the camera.

RATES

Available only for self-stabilized
payloads,
it
will
delegate
stabilization
to
the
payload.
Autopilot
will
only
suggest
movement through an angle rate
command

GEO

Camera will compensate attitude
changes AND Position changes,
looking to a fixed point on ground

NEUTRAL

Camera actuators are positioned in
neutral state

LATERAL

Special Lateral Mode

CAMGID

Camera Guided: Equivalent to GEO
but the navigation of the UAV is
slave to the pointed coordinates.
Table 5: Camera Modes Available

2.11.9.2 Surfaces section
On the surfaces section there is information about the
position and command of the UAV.
On the right side the current altitude is displayed into
the white square and the commanded altitude is
represented by a yellow line. In case the commanded
altitude is out of the range displayed at that moment,
a yellow arrow appears on the commanded altitude
direction.

Figure 44: Surfaces section of state
window

Commanded altitude can be changed directly from this
window by clicking on the altitude display box. The
display will switch to an editable field with two buttons
beneath it. The green tick will execute the command
altitude set and the red tick (or the keyboard 'Esc') will
cancel the command. Please note that the 'Intro' key in
the keyboard won't set the command. The unit used as
input will be the current input selected for display. (An
example of the interface is depicted in Figure 45).

Terrain level according to current loaded DEM is
represented by a solid brown background, and colored segments on the left side of the
altitude scale represent current selected DEM warning levels. Also, a pointing arrow will
show the predicted altitude in the next seconds, acting as a pseudo-variometer.
In the center of the surfaces section the heading is shown with the word HDG and the
current heading of the aircraft.
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When supported (optional feature of the autopilot), a sliding triangle will show on the left
margin indicating altitude the aircraft should be at to comply with the current vertical
performance limit (See 2.13.1.3 Vertical Performance
limits)
On the left side of the section, the current speed is
displayed into the white box in the same way as the
altitude, and the commanded speed is represented by a
yellow line. If the autopilot version reports the speed
limits, two red bars will be displayed at the left of the
speed bar showing where the limits are placed.
As in the case of the altitude, when the user clicks on
the speed white box a spinbox appears. In this spinbox a
new speed can be selected and commanded by clicking
on the right tick button.
On top of both columns an indication showing current
display unit is present.
In a rotary wing UAV the commanded speed controls the
speed used to transition between commanded points. If
it is already over the designated point and the orbit
radius is set at 0, it will start a hover, thus its speed will
be 0, regardless of the commanded speed, as there is
no need to execute a transition.

Figure 45: Example of speed being
edited in state window

On the center of the section there are two screens displaying rear and lateral view of the
plane with real time information about its attitude. On the upper screen (rear view) the roll
position of plane is displayed, and the
commanded roll is represented by a yellow line.
On the same screen the commanded surfaces are
represented in yellow. On top of this screen there
is a representation of the turn coordination (ball
display).
When active, in the black segment between both
views a reminder of current vertical performance
limit will be displayed at the right margin.
In fixed wing, if the speed control is adjusted for
Economic flight (See 2.13.1.2 Normal and ECO
flight laws), the word “ECO” will be displayed next
to the speed rectangle.
In rotary wing, if manual heading is set, the string
“H:MAN”
will
be
displayed
instead
(see
2.13.1.6 Manual and auto heading). In captive
rotary wing, the string “H:AUTO” will be displayed
in case automatic heading is set (see
2.13.1.11 Heading modes).
Figure 46: Full symbology display. Note that
this is an artificially generated image. Some
indications are mutually exclusive and won't
be displayed at the same time (e.g. yellow
triangles in speed and altitude display
columns)

On the lower screen (lateral view) the pitch
position of plane is displayed, and the
commanded pitch is represented by a yellow line.
On the same screen the commanded surfaces are
represented in yellow and the throttle is
represented as a yellow bar.
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Bellow the throttle bar, a triangle will be displayed. This triangle shows current throttle
stick position in the manual pilot joystick. At the right of the bar, commanded throttle
percentage is shown. If two engines are present in the aircraft, each engine percentage
will be represented at each side of the throttle bars.
Whenever the engine is disabled, a red cross will be displayed over the throttle command.
In the lower left corner ground Speed is given in the current speed unit and in the lower
right corner Above Ground Level (AGL) is given in the current altitude unit. Because AGL
can be calculated using several sources, a letter is drawn above the AGL indicator,
informing about the current source taken for the system in order to calculate a valid AGL
measure. These letters are not exclusive between them, because the system could use
more than one source. Each letter and its meaning are:
•

D → AGL is taken from the selected DEM. This source is the only one exclusive
respect to the other ones.

•

L → AGL is taken from an available laser altimeter.

•

S → AGL is taken from an available sonar altimeter.

•

R → AGL is taken from an available radar altimeter.

AGL indicator value changes depending on the effective source. However, this change
only affects to the lower right corner indicator, i.e., it doesn’t affect to the value
shown in the altitude vertical bar if AGL value is being represented there, and it doesn’t
affect to the terrain level drawn inside the vertical bar. In these cases, the source is
always the DEM.
In case the UAV has a retractable landing gear the situation of the same will be reported in
both views. While deploying, schematic representation starts drawing depending on the
completion. When it is fully deployed a complete landing gear with wheels is drawn in the
views.

2.11.9.3 Alternate Surfaces section
Through Settings →U-See Settings a different data
presentation option can be selected. The choice will
we remembered between application sessions.

Unless the user has previous experience with
artificial horizon flight indicators we don't
recommend its usage.
In the alternate representation, the main display is an
artificial horizon (See figure 47) with a display of
surface deflection immediately below.
In the top of the artificial horizon, the aircraft heading
is shown.
On the right of the artificial horizon the altitude is
displayed exactly in a box and with a sliding band
below. Commanded altitude is represented through a
horizontal yellow line. A pointing arrow will show the
predicted altitude in the next seconds, acting as a
pseudo-variometer.
Figure 47: Alternate data presentation

Terrain level according to current loaded DEM is
represented by solid brown background, and colored
segments on the right side of the altitude scale represent current selected DEM warning
levels.
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On the left of the artificial horizon the speed is displayed in a box with a sliding band
below. Commanded speed is displayed through a yellow horizontal line. If the autopilot
version reports the speed limits, two red bars will be displayed at the right of the speed
bar showing where the limits are placed.
On top of both sliding columns an indication of current display unit is shown.
On the artificial horizon there is a display of wing bars and a crosshair to allow precise
indication of pitch. A green flight director displays current autopilot command.
Below the artificial horizon, a rear view of the vehicle is shown, displaying surfaces
deflection and current engine command represented by a yellow bar that increases from
left to right. A red cross will be drawn on top of the throttle bar in case the engine is
disabled. It indicates the autopilot is actively disabling the throttle command (where
available; cutting engine injection). It does not indicate an engine failure or abnormality
(That is shown through the ENG alarm in the alarms panel when supported).
Below the throttle bar, a triangle will show current joystick throttle stick position and at the
right of the bar commanded throttle percentage is shown. If two engine are present in the
aircraft, each engines percentage will be represented at each sides of the throttle bars.
In the lower left corner ground Speed is given in the current display unit for speed and in
the lower right corner Above Ground Level (AGL) is given in the current altitude unit. The
AGL source is shown with a letter above the value, as has been described in the subsection
2.11.9.2 above.
Current vertical performance limit is shown if active and available (Optional autopilot
feature) below the altitude scale.
In fixed wing, whenever Economic Flight mode is active, the word “ECO” will be shown
below the speed scale, in rotary wing, if manual heading is set, the string “H:MAN” will be
displayed instead and in captive rotary wing, the string “H:AUTO” will be displayed in case
automatic heading is set.
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Figure 48: Alternate presentation: Full
symbology. Note that this is an artificially
generated image. Some indications are
mutually exclusive and won't be displayed at
the same time (e.g. yellow triangles in speed
and altitude display columns)

If UAV has a retractable landing gear its status will be shown in the rear view by a
schematic draw of the same.

2.11.9.4 Subsystem Indicators section
This section show the status of the subsystems present on the UAV, not available
subsystems will automatically hide when connecting the U-Pilot.
Besides their reporting function, these items can
act as command buttons. Buttons showing a
pointer icon when mouse is over,
, are
clickable. Clicking on this kind of control will
switch between the two possible states.

Figure 49: Subsystem Indicators. Note that
some of these may not appear in your view.

Buttons presenting a mouse context menu icon
while hovering ( ) do not have functionality
associated with left click, but a context menu is
shown when right clicking, presenting possible
actions.

These buttons can have a progress indicator (like in airbrakes, flaps and wheel brakes)
where the percentage of the deployment or application of the subsystem is reported. In
addition, percentage is reported numerically near the text indicating the subsystem. The
rest of the buttons only report if the system is on or off (lights and landing gear) by means
of the bar below. Buttons also report when a subsystem can be overriden by user and if it
is in manual or automatic mode.
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In some systems like some retractable gimbal models feedback of its status is provided. In
this case two lights on the right side of the indicator will appear. For gimbal retractable
system red light means that system confirmed it was deployed, green light means system
reported it was fully retracted. If none of the lights is shown, the system might be in an
intermediate mode.

2.11.9.5 Warning about AGL indication
Even if an AGL measurement is available via a sensor (radar altimeter,
laser-altimeter, etc)
AGL information can be calculated using the
selected Digital Elevation Model (DEM for short).
Default DEM used in U-See has global coverage but, in exchange, its
accuracy at some points may be lacking. Errors as high as 150 m. can
exist.
Because of this, we advise to take AGL values with a pinch of salt, and only for broad
informational purposes. Never fully trust this values for in-flight planning. A Safe terrain
clearance should be kept at all times.
This warning still applies if high detail DEM is loaded instead of U-See default: DEMs
usually do NOT include obstacles (as buildings and antennas) and terrain may have
changed since the DEM preparation date because of human development.

2.11.10 Joystick
To access to the Joystick window go to View → JoyStick.
This window provides real time information about the Joystick position in graphical form.
The purpose of this screen is to verify the correct behavior of the Joystick. Check that the
movement on the screen is the same than the real movement of the sticks on the Futaba
Joystick. In case it is not, change the Futaba settings.

Figure 50: Joystick information window

The left half represents throttle in the vertical axis and rudder input in the horizontal axis.
If an incremental joystick is used, the throttle indicator should be in the middle of the axis
when the joystick is not being acted and the word “Throttle” is replaced for “Inc. Throttle”.
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The right half represents elevator input in the vertical axis and aileron input in the
horizontal axis. Additionally, a detailed scale is shown for each axis to help with the trim of
the Joystick.
Below the Joysticks information, there are three widgets reporting the position of the two
switches and the roulette. The bar on the left represents the position of the Aux1 switch.
On the right side, the bar represents the Aux3 switch. Between these two bars, a circular
dial shows the position of the roulette, whose values can vary from -100 to 100.

This axis assignment Is independent of mode (Mode /Mode II) configuration for the
actual joystick.

2.11.11 Subsystems
Under this View → Subsystems menu there are several dialogs showing information about
aircraft subsystems. Depending on your aircraft’s settings, different subsystems will be
showing. Documentation for every subsystem may be managed separately from this
document for each specific project. Should you require this information, please contact
Airelectronics.

2.11.11.1 Engine Data
Accessed through View → Subsystems → Engine Data. This tool is only available for
electric vehicles and monitored engines (ECU controlled engines). The appearance will
change depending on the type of engine management installed on the aircraft.
2.11.11.1.1 Electric engine Data

Figure 51: Engine data window

This menu is divided in two sections:
The Engine data displays, in real-time, the Throttle commanded to the engine, the main
battery voltage, the amperage consumed by the system and the wattage.
As different autopilots have different main battery channel assignments, a drop-down
select box is provided to select the proper main battery channel. This selector affects only
the wattage calculation and the graphical plotter of wattage against IAS.
A real-time plot of the IAS (Indicated Air Speed) of the plane vs the Wattage of the engine
can be shown with the Graphs button on this section. The IAS is shown on the horizontal
axis with unit indication in the right bottom corner while the instantaneous power is shown
on the vertical axis in Watts.
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Figure 52:Example of IAS vs Wattage plot

The Battery data section shows data about the battery capacity status: the information
shown corresponds to the mAh left on the battery, and the percentage of battery left. For
that it is necessary to set the maximum battery Amperage on the Max [mAh] box, before
the mission starts. With this data is possible to know the amount of consumed battery with
an error lower than 3%.
Besides capacity left, there is also a time left estimation. This time estimation is computed
using the displayed estimate consumption. The time shown is the estimate to reach 15%
of battery capacity left.
Old versions of autopilot may not have a time estimation available as they don't transmit
all the necessary information for this estimation.
The reset button present in this dialog resets the consumption counter held on-board the
autopilot.
Note: Notice that the maximum capacity must be set in mAh.
Note: This option is only available for the U-Pilot with an ammeter mounted on the battery
cables. For further information check the 3.2 Monitoring engine data section on the U-Pilot
manual.
2.11.11.1.2 Moscat ME03 electronic injection controlled engine

Whenever the system detects a Moscat ME03 ECU connected and sending data, the
engine data window will switch automatically to this display (See Figure 53: Moscat ME03
Engine control display). Only when connected to this kind of ECU U-See will show this
window.
On the left half of the window the following information is available.
•

Engine RPM as measured by the two hall effect sensors: both sensors should read
very similar RPMs. Also, commanded RPMs by the autopilot are represented with a
yellow triangle.

•

Cylinder head temperature: temperature as measured by the thermocouple
installed at the cylinder head. While in flight both indications should be very similar.
On-Ground functioning may exhibit slight differences. Fuel injection status:
•

Current measured fuel pressure

•

Current approximated engine throttle value
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•

Total accumulated consumption in kg.17
•
•

Instantaneous fuel consumption in
kg/h

Manifold
pressure
measurement.

and

temperature

RPMs, Temperature and fuel pressure have
warning and critical values (Yellow and Red arcs,
see Figure 53: Moscat ME03 Engine control
display). Whenever one of this parameters enter
this range, the general ENG alarm is triggered in
the alarms panel (See Section 2.11.9.1, Alarms
section), as well any other alarm in the dialog will
be triggered if there is a failure, until the user
clicks on them or clicks on “Acknowledge all
alarms” button. It is possible to disable this, as
stated in Section 2.15.14.1 Alarms & Warnings.
The limits are:
•
Figure 53: Moscat ME03 Engine control
display

•

•

RPM:
•

Critical: RPM < 1500 or RPM > 6500

•

Warning: RPM < 1900 rpm or RPM >
6000

Temperature:
•

Critical: Temperature > 200°C

•

Warning: Temperature < 70°C or Temperature > 180°C

Fuel Pressure
•

Nominal value is 2.5 bar

•

Critical: Fuel pressure <1.5 bar or Fuel Pressure > 3.5 bar

•

Warning: Fuel pressure < 2.0 bar or Fuel Pressure > 3.0 bar

On the right half of the window, by order, following information is found:
•

Engine Status. Possible status are:
•

STOPPED: engine is not working. The word STOPPED will be red colored and
this state is linked to a critical alarm in the ENG alarm in the alarms panel.

•

CRANKING: engine is being externally turned. Word will be black-colored and
this state is linked to warning state of the ENG alarm in the alarms panel.

•

WARMING-UP: engine has been recently started and it is running an
automatic warm-up cycle. During this time, the autopilot does not have
control over engine RPM and the engine is not ready for flight. This mode will
end as soon the mean of both engine temperature indication reaches 80 °C.
When in this state, the word WARMING-UP will be colored in orange and this
state is linked to a warning state of the ENG alarm in the alarms panel.

17 Current version does not support pounds for fuel indication.
Document Version 1.54

58

U-See User Manual - View Menu: Real time information windows
•

RUNNING: engine is running by its own means and the autopilot has control
over it. In this state, the word RUNNING will be green colored and, if no other
problem is found in the engine operating parameters, this is linked to a
normal state of the ENG alarm in the alarms panel.

•

ECU working condition information: temperature and main voltage value.

•

Control information: values the control is trying to maintain. These values and the
measured values should agree.

•

Alarms: this sub-panel holds the alarms information regarding engine subsystems.
Any abnormal condition will be signaled by showing the word FAIL colored in red and
it will trigger a critical alarm state of the alarm ENG in the alarms panel.

2.11.11.1.3 Moscat eFI electronic injection controlled engine

Whenever the system detects a Moscat eFI ECU connected and sending data, the engine
data window will switch automatically to this display (See Figure 54: Moscat eFI Engine
control display). Only when connected to this kind of ECU U-See will show this window.
On the left half of the window the following information is available.

Figure 54: Moscat eFI Engine control
display

•

•

Engine RPM as measured by the two hall
effect sensors: both sensors should read
very similar RPMs. Also, commanded RPMs
by the autopilot are represented with a
yellow triangle.

•

Cylinder head temperature: temperature as
measured by the thermocouple installed at
the cylinder head. While in flight both
indications should be very similar. OnGround functioning may exhibit slight
differences.

•

Exhaust gas temperature: temperature as
measured by the thermocouple installed at
the gas exhaust.

•

Fuel injection status:
•

Current measured fuel pressure

•

Current approximated engine throttle
value

•

Total accumulated consumption in
kg.18

•

Instantaneous fuel consumption in kg/h.

•

Fuel pump speed in RPM.

Manifold pressure, temperature measurement and ambient pressure.

RPMs, Temperatures and fuel pressure have warning and critical values (Yellow and Red
arcs, see Figure 54: Moscat eFI Engine control display). Whenever one of this parameters
enter this range, the general ENG alarm is triggered in the alarms panel (See Section
2.11.9.1, Alarms section), as well any other alarm in the dialog will be triggered if there is
a failure, until the user clicks on them or clicks on “Acknowledge all alarms” button. It is
possible to disable this, as stated in Section 2.15.14.1 Alarms & Warnings.
18 Current version does not support pounds for fuel indication.
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The limits are:
•

•

•

•

RPM:
•

Critical: RPM < 1500 or RPM > 6500

•

Warning: RPM < 1750 rpm or RPM > 6280

Cylinder Head Temperature:
•

Critical: Temperature > 200°C

•

Warning: Temperature < 70°C or Temperature > 180°C

Exhaust Gas Temperature:
•

Critical: Temperature > 650°C

•

Warning: Temperature > 600°C

Fuel Pressure
•

Nominal value is 2.5 bar

•

Critical: Fuel pressure <1.5 bar or Fuel Pressure > 3.5 bar

•

Warning: Fuel pressure < 2.0 bar or Fuel Pressure > 3.0 bar

On the right half of the window, by order, following information is found:
•

Engine Status. Possible status are:
•

STOPPED: engine is not working. The word STOPPED will be red colored and
this state is linked to a critical alarm in the ENG alarm in the alarms panel.

•

CRANKING: engine is being externally turned. Word will be black-colored and
this state is linked to warning state of the ENG alarm in the alarms panel.

•

WARMING-UP: engine has been recently started and it is running an
automatic warm-up cycle. During this time, the autopilot does not have
control over engine RPM and the engine is not ready for flight. This mode will
end as soon the mean of both engine temperature indication reaches 80 °C.
When in this state, the word WARMING-UP will be colored in orange and this
state is linked to a warning state of the ENG alarm in the alarms panel.

•

RUNNING: engine is running by its own means and the autopilot has control
over it. In this state, the word RUNNING will be green colored and, if no other
problem is found in the engine operating parameters, this is linked to a
normal state of the ENG alarm in the alarms panel.

•

ECU working condition information: temperature and main voltage value.

•

Control information: values the control is trying to maintain. These values and the
measured values should agree.

•

Alarms: this sub-panel holds the alarms information regarding engine subsystems.
Any abnormal condition will be signaled by showing the word FAIL colored in red and
it will trigger a critical alarm state of the alarm ENG in the alarms panel.

2.11.11.1.4 RDAC XF engine monitor module

Whenever the system detects a RDAC XF module connected and sending data, the engine
data window will switch automatically to this display (See Figure 55: RDAC XF engine
monitor module display). In this window, you can see the following information:
•

RPM: Engine RPMs.

•

Temperatures: Cylinder Head and Oil Temperatures.
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•

Pressures: Fuel and oil pressures.

Whenever one of this parameters enter this range, the general ENG alarm is triggered in
the alarms panel (See Section 2.11.9.1, Alarms section), as well any other alarm in the
dialog will be triggered if there is a failure, until the user clicks on them or clicks on
“Acknowledge all alarms” button. It is possible to disable this, as stated in Section
2.15.14.1 Alarms & Warnings.
The limits are:
•

•

•

Figure 55: RDAC XF
engine monitor module
display

•

•

RPM:
•

Critical: RPM < 1200 or RPM > 5800

•

Warning: RPM < 1400 rpm or RPM > 5500

CHT:
•

Critical: Temperature < 50°C or Temperature > 130°C

•

Warning: Temperature < 75°C or Temperature >
120°C

Oil Temperature:
•

Critical: Temperature < 45°C or Temperature > 130°C

•

Warning: Temperature < 50°C or Temperature >
110°C

Fuel Pressure
•

Critical: Fuel pressure < 0.15 bar or Fuel Pressure >
0.30 bar

Oil Pressure
•

Critical: Oil pressure < 0.8 bar or Oil Pressure > 7 bar

•

Warning: Oil pressure > 5 bar
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2.11.11.1.5 AMT electronic control unit

If you have an AMT ECU connected, this display will show up. Additional options are
displayed in Engine management window (see Section 2.13.6.1 AMT electronic control
unit.)
In each column, different sensors are displayed for each engine.
There are some labels indicating the state of the engine as well. In
case some label represents a dangerous value, it will be displayed
in red and start to blink, until the user clicks on them or clicks on
“Acknowledge all alarms” button. It is possible to disable this, as
stated in Section 2.15.14.1 Alarms & Warnings.
The following information is available for each engine:
•

Engine RPM.

•

Exhaust gas temperature: temperature as measured in the
exit of exhaust gas.

•

Throttle percentage commanded to each engine.

•

Pump voltage.

2.11.11.1.6 Other engine subsystem dialogs

There are other engine subsystem dialogs that cannot be covered in
this general accessible manual. They are treated in additional
project-specific documentation.

2.11.11.2 On Ground Detector (optional)

Figure 56: AMT ECU
specific display

The On Ground Detector is a subsystem that detects whether the
aircraft is flying or on the ground. For aircrafts with this option
enabled, the window shows the on ground detector status. This
status is a decision the autopilot is taking based in a variety of
sources. There three possible states for this window:

• Flying: U-Pilot has strong reasons based on at least one
source to believe that the aircraft is flying.
•

Suspicious flying: There are some indicators that say the aircraft may be in the
ground, but the information is not so clear. In this state, depending on the
configuration, the aircraft will take the decision to turn to On Ground or not.

•

On Ground: The next state to Suspicious Flying, if U-Pilot is in Suspicious Flying for
a certain amount of time, it will be sure that it’s on the ground and will make the
relevant decisions. When the aircraft is in Flare mode, this state will trigger a
change to Braking on Runway and thus the aircraft will brake. This is only possible if
U-Pilot has the relevant configuration.

Also, there are multiple sources of detection:
•

Manual: When any of the modes are forced manually through this dialog or through
the state window subsystem.

•

WoW: The decision is taken based exclusively in the information of the weight on
wheels sensor.

•

Laser: The decision is based exclusively in the information of a sonar or laser
altimeter sensor.

•

Multiple: When two or more sources are used, all of them will be listed joined by
“+”.
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There are different buttons in this window as well:
•

Set auto mode: allows the U-Pilot to take the decision itself.

•

Force Flying/In Ground: Force those states independently from the sensor
readings.

Figure 57: Example of On Ground Detector dialog

•

Force disabled mode: U-Pilot will not change its behavior based on this state,
independently from its configuration.Weight on Wheels (optional)

This is one possible source of decision of On Ground Detector. Weight on Wheels dialog
shows this sensors’ readings. There are up to 3 sensors, one corresponding to each wheel
of the aircraft. Depending on the aircraft, the arrangement will be different.
When at least one of the sensors reaches the limit for a certain amount of time, the sensor
will consider its detecting ground.

Figure 58: Example of Weight on Wheels dialog

2.11.11.3 Laser Altimeter (optional)
This subsystem is another possible source of
altimeter dialog will show the measurement
external sensor. This dialog shows both the
measurement is represented in brown color in
from the aircraft to the ground.

decision of On Ground Detector. The laser
of a laser/sonar altimeter installed as an
raw and the filtered reading. The filtered
a vertical bar, which simulates the distance
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The band marked in yellow is the altitude threshold together
with a margin. Inside the altitude threshold band, the sensor will
be considered to detected the aircraft on ground. If the value is
above the altitude threshold band values, the sensor considers
that the aircraft is flying. Finally, if the value below the altitude
threshold, the measurement is considered invalid and the sensor
is marked malfunctioning (this is useful when, for example, the
altimeter has a cover which hasn’t been removed).

2.11.11.4 Safe-T status (optional)
This option appears when a captive rotary wing vehicle is
Figure 59: Example of
detected. It allows to monitor an Elistair’s Safe-T tethering
Laser Altimeter dialog
station via UDP connection. To do this, it is necessary to
configure some Safe-T network parameters in the dialog
configuration tab. When the UDP port and host IP has been configured, clicking apply
trigger the software to start sending query packets to the tether station and receive the
feedback.
Then, the status tab should reflect the current device state, reporting the current power
draw, the cable chord length, the internal temperature and the cable output speed.
Additionally, the uptime is shown in the data tab.

Figure 60: Sample Safe-T Figure 61: Safe-T status
configuration

Figure 62: Safe-T status

For Windows Users only
The users will have to configure the firewall to accept inbound packets
from this UDP port, otherwise the firewall will block these packets and no
feedback will be available.

Document Version 1.54

64

U-See User Manual - View Menu: Real time information windows

2.11.12 Vibration frequency Graphs
Accessed through View → Vibration Frequency Graphs, this unique functionality allows
you to examine the vibration spectra of your vehicle in real time. With this tool you can
clearly see the source of vibration in your system and check if the system vibration is
nominal, or, on the other hand, there is a new source of vibration indicative of a failure.

Figure 63: Vibration frequency Graphs window

In this window you
can see the current
state of the three
axis
vibration
pattern, with a bar
that
scans
the
different
frequencies.
On
the right hand of
every
axis
you
have options to
alter the vertical
scale (x2, x1, x1/2,
x1/4) that will alter
the height of a
given
vibration
amplitude.

Also, there is a
checkbox titled “LPF”19: with it checked you will see the mean of various samples and
unchecked will give the immediate result.

2.11.13 Time log

Figure 64: Time log dialog

This window shows current uptime as registered
by the autopilot. This is the time that has passed
since the power-on of the autopilot. This time is
always positive and it is monotonically
increasing. This time counter only resets at
autopilot power-on, so it is an appropriate way
to detect power supply problems should they
arise.

Take-Off time shows how much time has passed
since the last U-See detected automatic take-off phase.
This means that this time won't be accurate if:
•

The flight is started in manual or semi-manual modes.

•

The take-off occurred while the current U-See instance was not running.

•

Control handover has occurred and a different UAV is being monitored.

19 LPF stands for Low Pass Filter
Document Version 1.54

65

U-See User Manual - Pre-Flight Menu

2.12 Pre-Flight Menu
The tools on Pre-Flight drop down menu have to be used before the flight starts, with the
UAV on the Runway, with communication with the U-Ground and with GPS signal.
Safety Warning
It is very recommended to set the manual mode and keep the throttle on
the joystick to minimum while adjusting the pre-flight parameters to
minimize injury risk to people around the UAV in case the operator makes
a mistake.
It is also very recommendable to keep engines or motors turned off until the UAV is
ready for flight.

2.12.1 Checklist
The checklist tool allows the user to run a
series of pre-flight checks in order to
prevent errors during operation. The
checklist widget is able to keep in memory
up to 5 pre-designed checklists. The
checklists are defined in text files and can
be provided by Airelectronics or custommade by the client.
When adding a checklist, the software will
ask the user for the location of the checklist
file and will notify if there are any problems
with the file.

Figure 65: Checklist main window

The checklist files must have the following

structure.
First Line: checklist Title
Second Line: creation date (DD/MM/YYYY)
Third Line: author (e.g. Airelectronics)
Fourth Line: BEGIN (checklist start mark)
Next Lines: checklist points, one point per line
Last Line: END (checklist end mark)
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Material Skywalker
04/12/2013
Airelectronics
BEGIN
Point 1 to check
Point 2 to check
…
Point N to check
END
Text 1: Example checklist file

If the checklist shall contain non-ASCII characters ( é,ü,æ,ß, chinese, cyrillic,
etc.) the file must be encoded using UTF-8.

When a checklist is successfully loaded, it will appear in the checklist window with the run
button enabled. Clicking this button will start the checklist process asking the user if that is
the correct checklist to run.
During each check of the checklist, the software will block the “Next” button for a few
seconds, preventing the user from skipping points.

Figure 67: Checklist completion

Figure 66: Checklist question

When the checklist is completed, a green tick will appear with a completion message and a
finish button to end the checklist process.

2.12.2 Runway
To open the Flight Plan window go to Pre-Flight → Runway.
This dialog operates in two modes. Display mode and Editing mode. While in display mode,
the dialog will only display the current stored and reported autopilot values. No interaction
is possible except for clicking the “Enter edit mode” button.
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While in edit mode, it is possible to hand edit the
landing site coordinates, set the landing site to the
current aircraft position and it is also possible to select
a landing site coordinates by map interaction.
When clicking in “Pick from Map” all dialogs will hide
leaving only map view and a left click on the map will
select those coordinates as landing site. Upon click on
the map, the landing site icon should be displayed on
the clicked position to confirm selection. If not, a click
on set will resend the selected coordinates to the
autopilot.

Figure 68: Runway dialog in edit mode

It is important to understand that buttons “Current
coord.” and “Pick from Map” only affects landing site
coordinates, this is, landing site altitude won't be
changed by these buttons and the user must set both
elevation and heading values to appropriate values.

Elevation can be adjusted to current value by clicking “ Current” button by the input field or
by writing a value by hand. Current button only affects the landing site elevation
Heading of the landing site can be manually introduced or measured from map through
use of “2Point Pick” button. Click in this button will hide all windows except the map display
and two consecutive left clicks on the map will indicate landing field orientation.
At the bottom of the dialog, above the get and set button a check-box allows to change
the direction the autopilot executes the landing hold orbit. Note that this only affects fixed
wing aircrafts.
At the bottom of the window the usual get and set buttons will put current autopilot values
into the dialog (Get button) or send the current values to the autopilot( Set button)
Safety Warning
Before exiting edit mode verify that the values on-board the autopilot
match the values shown on the dialog by clicking “ Get” button and
reviewing the values.
Check that all the necessary parameters have been edited: coordinates,
elevation and heading of the landing site.

2.12.3 Flight-Plan
To open the Flight Plan window go to Pre-Flight → Flight Plan. Please note this feature will
be disabled in captive rotary wing aircrafts.
In Flight-plan mode the UAV heads one by one to the defined waypoints. These waypoints
are numbered starting with number one. When the last point is reached, the UAV will start
the flight plan again from the first point.
Through the menu entry, access is gained to the flight-plan editor.
This flight-plan editor shows and modifies the contents of a
Autopilot's memory loaded flight-plan. It will not work at all if there
is no communications established with an operating autopilot.
Off-line flight-plan editor is in the works.
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When activating “Save Changes” option the active flight-plan is saved into the non-volatile
memory of the autopilot and will be available through power cycling.
Flight-plans can also be saved in a “.fp” file using the “ Save to a file” option available in the
flight-plan editor.

Figure 69: Map display during FLY-TO mode with a flight plan ready to activate

2.12.3.1 Flight plan Editor Window. Display Mode
The flight-plan editor window has three well
separated zones:
•

Header of the window: Gives general
information about the current flightplan.
◦ Total Distance: On-Ground distance
the UAV will have traveled after
completing one flight-plan loop
(From point one to the last enabled
point and back to one)

Figure 70: Flight-Plan Editor
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◦ Minimum Ground Clearance: Minimum ground clearance in the flight plan20
•

Body of the window: Two tabs, the first one contains current way-points location in
coordinates and altitude. The second one shows block operation options.

•

Footer of window:
◦ Add a new point at the end of flight-plan
◦ Save to a file current flight-plan

Every row in the body of the Flight-plan Points tab represents one way-point. Besides its
coordinates, three buttons are available for every row:
•

Get Button: This will query the autopilot for the current values for the way-point.
This is usually not required, as autopilot reports sequentially the current state of the
way-points automatically.

•

Delete Button: This button will delete the selected point and all the following waypoints from the flight-plan

•

Edit Button: This will put the row in edit mode, changing the way the left click
behaves in the map and allowing changes in the way-point data.

2.12.3.2 Flight-plan editor: Edit mode
When in edit mode, the looks and behavior of
the flight-plan editor will change:
Notice how all the rows except the one
corresponding point 3 in figure 71 disappear
from the window.

Figure 71: Flight-plan editor with point ID 3 in
edit mode

Also note that the coordinates and altitude
field in the row for point id 3 are now editable
fields.

Also, while in edit mode, all the windows in the
program but the flight-plan editor will hide to
allow clear view of the map. Left button click will pick coordinates from the map for Point
ID 3 position. This change in behavior is shown on the map with a cursor in cross-hair form
and a tool-tip reading “Left Click Picks ID Point X”
To make changes, edit using the keyboard the coordinates and altitude and click Set.
When using the mouse to select coordinates the Set button will be automatically engaged
after each click. Remember to adjust the altitude when operating with the mouse
'Get' button will put into the editable fields the current autopilot values for the way-point.
'Set' button will try to upload way-point data to the autopilot and 'Exit' will exit the edit
mode.
After every 'Set' or left click in edit mode, the icon displaying the point on the map should
have moved to the desired position. If not, just push 'Set' repeatedly until the point is in
position.
Closing the Flight-plan window also exits editing mode.

20 This clearance is based on available DEM model. As usual, it may be incomplete, inaccurate
or without the necessary precision, so this tool is a help and it does not substitue proper
flight planning.
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2.12.3.3 New Point Loading
To add a point to the flight-plan click on “New Point”. All windows but the map view will
hide temporarily and the cursor will turn into a cross-hair. A tool-tip will follow the cursor to
remind the change of behavior in the left mouse click. It reads “Right button appends new
ID Point X. Altitude will default to maintain ground clearance”
After a left click in the desired position, a new point, with incremental ID should be drawn
on map and reported in the flight-plan window.
Altitude of said point will be the elevation calculated for those coordinates plus the
minimum previous ground clearance. If that's not the desired altitude, it should be edited
using the “Edit” button
Pressing ESC key in the keyboard while in the new point mode will cancel the operation.

2.12.3.4 Block Operations
This tab allows the user to act on all the flight-plan points at a time. The options available
are:
•

Flight Plan Altitude Increment: set an altitude increment for every point on the
flight-plan. This altitude is added or subtracted (depending on the sign of the
increment) to each point.

•

Flight Plan Shift: with this option the user can move the whole flight plan the given
distance. The first spin box shifts the flight plan to the North if the sign is positive or
the South if it is negative. The second one moves the flight plan to the East if it is
positive or the West if it is negative. The distance the flight plan can be moved at
once is limited to a kilometer in each direction.

Figure 72: Flight Plan -> Block Operations tab

2.12.3.5 Completely new flight-plan procedure
For creating a completely new flight-plan follow the following steps:
1. If a previous flight-plan is present: click on “Delete” button for the point ID 1.
2. Click in “Add New Point”
3. Left click in the map for desired way-point position
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4. If altitude is not the desired:
1. click in Edit
2. Change altitude
3. Click in Set
4. Confirm altitude by clicking in Get
5. Click in Exit
5. Repeat 2 through 4 until desired flight-plan is ready.
Note that the flight-plan editor will respect the minimum ground clearance, so for a
constant AGL altitude flight-plan the operation will be considerably simplified:
1. If a previous flight-plan is present: click on “Delete” button for the point ID 1.
2. Click in “Add New Point”
3. Adjust altitude to provide desired clearance in point 1
4. Just add following points without worrying about altitude.
Note: Flight Plan points are edited one at a time. This way it is easier to upload and
download the information and the communications are not overloaded.
Note: The Flight Plan points must start on number one. The following flight points must
increase its number by one each time.
Note: If the flight plan created must be saved for posterior flights, the changes must be
saved on Settings → Save Changes as described on Section 2.15.17 Save Changes.

2.12.4 BackTrack
To open the BackTrack window go to Pre-Flight → BackTrack. Please note this feature will
be disabled in captive rotary wing aircrafts.
The backtrack feature is a secondary flight plan to run through to come near the base
bactrack point (Landing site or rally point). BackTrack points have a “B” before the point ID
and the first ID is 0.
Whether this plan will be used or not depends on the advanced comm failure settings for
the autopilot unit being used. Please check section 2.15.2.3 Communications: Advanced
Comm Failure for further insight on how to use this feature
The BackTrack points will only be valid if there is less than a certain distance between
them and their predecessor or between the runway and the first backtrack point (ID = 0).
This distance is the Coverage distance. U-See also checks the ground clearance of the
points and the path in between them.
A properly defined backtrack plan has its lowest id point near the landing site (ID 0) and
the following points are used to establish an acceptable path to fly back to the base point
(Landing site or rally point)
At every moment the aircraft evaluates its position relative to the backtrack and will show
which backtrack point is going to be used if communications where to fail at that same
moment through a yellow circle drawn around the selected backtrack point.
The aircraft will look for the nearest possible backtrack point and use it as base selected
point. However, the aircraft could decide to directly fly towards the base backtrack point or
the previous BackTrack point if it is already midway this transition (The aircraft will try to
minimize the flight-away and then comeback trajectories).
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Contrary to flight-plan, the point capture of the backtrack is 3D. The aircraft won’t proceed
to the next backtrack point unless its altitude is whithin reasonable limits. If the altitude
difference is too much the aircraft will orbit around the active point until the current
altitude and programmed altitude are reasonably matched.
If, however, there is not backtrack point within legal range the aircraft will fly straight
forward to the base point (landing site OR rally point)
Access to the BackTrack editor is gained through the menu entry.
This BackTrack editor shows and modifies the contents of a Autopilot's
memory loaded BackTrack. It will not work at all if there is no
communications established with an operating autopilot.

Figure 73: Map display during a flight with a BackTrack set and the Coverage Display of the points enabled

When activating “Save Changes” option the active BackTrack is saved into the non-volatile
memory of the autopilot and will be available through power cycling.
BackTracks can also be saved in a “.bt” file using the “ Save to a file” option available in the
BackTrack editor.
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2.12.4.1 BackTrack Editor Window. Display Mode
The BackTrack editor window is very similar to
the Flight-plan editor window. It also has three
separated zones:
•

Header of the window: Gives general
information
about
the
current
BackTrack.
◦ Minimum
Ground
Clearance:
Minimum ground clearance in the
BackTrack21

•

Body of the window: Contains current
way-points location in coordinates and
altitude.

•

Footer of window:
◦ New Point: Add a new point at the
end of BackTrack.

Figure 74: BackTrack Editor

◦ Save to File: Save to a file current
BackTrack

◦ Toggle Coverage Display: Show or hide the coverage area of each BackTrack
way-point in the map as a green circle around the point.
Every row in the body of the BackTrack Points tab represents one way-point. This rows
background is light-cyan in order to make a difference with the Flight-plan points. Besides
its coordinates, three buttons are available for every row and they are used the exact
same way is the Flight-plan Edit Window:
•

Get Button: This will query the autopilot for the current values for the way-point.
This is usually not required, as autopilot reports sequentially the current state of the
way-points automatically.

•

Delete Button: This button will delete the selected point and all the following waypoints from the flight-plan

•

Edit Button: This will put the row in edit mode, changing the way the left click
behaves in the map and allowing changes in the way-point data.

2.12.4.2 BackTrack editor: Edit mode
The edit mode works the same way as the
flight-plan editor window. When in edit mode,
the looks and behavior of the BackTrack editor
will change:
Notice how all the rows except the one
corresponding point 3 in figure 75 disappear
from the window.
Figure 75: BackTrack editor with point ID 0 in
edit mode

Also note that the coordinates and altitude
field in the row for point id 3 are now editable
fields.

21 This clearance is based on available DEM model. As usual, it may be incomplete, inaccurate
or without the necessary precision, so this tool is a help and it does not substitute proper
flight planning.
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Also, while in edit mode, all the windows in the program but the BackTrack editor will hide
to allow clear view of the map. Left button click will pick coordinates from the map for
Point ID 3 position. This change in behavior is shown on the map with a cursor in cross-hair
form and a tool-tip reading “Left Click Picks ID Point X”
To make changes, edit using the keyboard the coordinates and altitude and click Set.
When using the mouse to select coordinates the Set button will be automatically engaged
after each click. Remember to adjust the altitude when operating with the mouse.
'Get' button will put into the editable fields the current autopilot values for the way-point.
'Set' button will try to upload way-point data to the autopilot and 'Exit' will exit the edit
mode.
After every 'Set' or left click in edit mode, the icon displaying the point on the map should
have moved to the desired position. If not, just push 'Set' repeatedly until the point is in
position.
Closing the Flight-plan window also exits editing mode.

2.12.4.3 New Point Loading
To add a point to the BackTrack click on “New Point”. All windows but the map view will
hide temporarily and the cursor will turn into a cross-hair. A tool-tip will follow the cursor to
remind the change of behavior in the left mouse click. It reads “Left button appends new
ID Point X. Altitude will default to maintain ground clearance”.
After a left click in the desired position, a new point, with incremental ID should be drawn
on map and reported in the BackTrack window.
Altitude of said point will be the elevation calculated for those coordinates plus the
minimum previous ground clearance. If that's not the desired altitude, it should be edited
using the “Edit” button.
Pressing ESC key in the keyboard while in the new point mode will cancel the operation.

2.12.5 Bingo Time
Bingo22 time is a prefixed amount of time, that once surpassed will trigger a return home in
the autopilot.
To define this time, select Preflight → Bingo Time. In the dialog, enter the desired amount
of time and the unit this time is expressed in (See Figure 76: Bingo time window) from the
drop down menu and click on 'Set'.
When the bingo time is set, an automatic bingo count down appears on the Bingo alarm on
the Alarm window (See Alarms section) set as green. In case the bingo time arrives to
zero, the bingo alarm
will change to red with
the word “BINGO” on it.
The
operator
can
override
this
return
Figure 76: Bingo time window
home by commanding
any other mode, however, have in mind that until the Bingo time counter is reset, U-Pilot
won't attempt another automatic return home once it has been over-commanded.
A click in Disable Bingo will stop the count-down, disarm the BINGO alarm and deactivate
auto-return home by time.
This tool is not mandatory for flight but recommended.
22 Bingo is the code word used in OTAN standard radio brevity code to indicate fuel levels
on-board have reached levels that recommend a return to the base.
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2.12.6 Rally point
The rally point is defined as a 3D point (Lat/Lon/altitude) that is
designed to be used as a safe holding point to wait, specially
while in communications failure.
In Airelectronics’ system this point is forced to be in the vicinity
of the landing site to be considered valid 23. Also, the altitude
of the rally point must below 10000m ( 3080 ft ) to be
considered valid.
The point editor is very similar to the runway editor in
functionality, but to avoid confusion between them the
background is painted using dark gray. Also, at the foot of the
window there is a green/red label that shows if the configured
rally point is valid or invalid.
Figure 77: Rally point window

Note that changing the landing site without repositioning the
rally point can trigger an invalidation of the rally point.

2.12.7 Pattern Generator

Figure 78: Pattern Generator opened with a declared field for survey.

23How far or near is configured at adaptation time by airelectronics’ personnel. A typical
value is 5 km.
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This tool is intended for use with terrain observation flights that require covering some
part of the terrain in an exhaustive manner. By declaring (through left click) the external
outline of the desired surveyed terrain this tool will generate a set of files describing the
proper pattern flight-plan to cover the terrain.

2.12.7.1 Intended use
Unlike the usual tools included in U-See, this part of the program does not require a
connected autopilot. We recommend to use this tool before deploying to the field, leaving
the files prepared for upload once ready for operation.

2.12.7.2 Use of pattern generator
To access pattern generator, select Pre-Flight → Pattern Generator. The pattern generator
window will open.
The basics of the pattern generation is the marking of the desired observation field.
This is accomplished by means of left mouse button clicks. Every time a left click is made,
a vertex is added to the observation polygon. As many as needed vertices can be added to
the polygon, although it is necessary to add the vertices in order to avoid self intersecting
polygons. These vertices can be moved to a new position by dragging them with the left
mouse button.
Polygon will be drawn once you have more than three points marked and it will get
updated while points are added. Desired survey polygon will be drawn using intense
translucent green color. Projected navigation legs will be drawn as black lines.
If an error is made, the clear button will clear the points defined up to the moment and will
reset the area to start again.

2.12.7.3 Available parameters.
Once declared the desired survey field, a handful of parameters can be adjusted to finetune the generated flight-plan.
•

Safety Distance: UAV needs a significant space for making turns, this means that
the final and starting parts of every navigation leg would received bad coverage by
the cameras on-board as the UAV is still trying to maneuver to get into position.
This distance parameter controls the extra distance the UAV will cover to assure it is
well established on navigation leg when it reaches the area of interest.

•

Offset: This parameter controls the lateral separation of the navigation legs.

•

Orientation: It controls the geographic bearing that will be used to fly over the
designated survey area.

•

Altitude: How high the overfly will be made. There are two modes for generating the
flight-plan point altitudes:
◦ Above Seal Level
◦ Above the terrain.

The “Flight Plan Info” display shows how many flight-plan points will be needed for
covering the desired field and the total distance the final flight-plan will cover.
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AGL information is calculated using a Digital Elevation Model (DEM for
short) incorporated into U-See.
Default DEM used in U-See has global coverage but, in exchange, its
accuracy at some points may be lacking. Errors as high as 150 m. can
exist.
Because of this, we advise to review carefully the generated flight-plan
once it is loaded in the autopilot for proper ground clearance.
This warning still applies if high detail DEM is loaded instead of U-See default: DEMs
usually do NOT include obstacles (as buildings and antennas) and terrain may have
changed since the DEM preparation date because of human development.

2.12.7.4 Saving results
Once the parameters have been adjusted, it is necessary to save the results to disk for
later usage. Such thing is accomplished by clicking on “ Select file” button. A dialog will
open in which a base name and location should be given for the flight-plan files.
The name given in the dialog will be suffixed with a sequence number and the “.fp” file
extension.
For instance, if a particular area defined needs 67 flight-plan points and the filename given
is “example” the program will save in the selected directory the following files:
•

example-01.fp (Containing flight-plan points 1 to 32)

•

example-02.fp (Containing flight-plan points from 33 to 64)

•

example-03.fp (Containing flight-plan from 65 to 67)

These files should be loaded on the autopilot using the “ Flight plan from File” found in the
pre-flight menu. (See following section)

2.12.8 Flight plan From File

Figure 79: Flight-plan Load from file window

This dialog will allow the selection of a “.fp” flight-plan definition file and upload it to an
active connected U-Pilot autopilot.
Once the button start is clicked, the program will check the syntax of the file and will start
uploading the flight-plan points information one by one.
If any problem shall arise during the upload, an informational dialog will be presented
informing the nature of the failure and the proper corrective action to take.

2.12.9 Backtrack from file
Very similarly to the flight plans, the backtrack plan can be loaded from a file. The working
of this window is exactly equal to the Flight plan from File window (2.12.8 Flight plan From
File) with the exception that its files should have a .bt extension and a slightly different
inner structure (See Appendix D BackTrack File Format for full details on file format)
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2.13 Command Menu
2.13.1 Command window
To open the Command window click

icon or go to Command → Command.

The software automatically recognize if the vehicle is fixed wing, rotary wing or captive
rotary wing and will present the proper command window.
On the main map screen, all the information regarding the current mode will be shown in
green and all the information that the current mode is not using will be shown in blue. For
example if the UAV is in Take-Off mode, the flight plan path will be shown in blue but as
soon as the operator will click the Flight Plan button the flight plan path will become green.
This is the primary window during an actual flight mission.

2.13.1.1 Fixed wing command window
The fixed wing command window is divided in two groups
–

The command modes group where the command buttons are shown, grouped by
flight modes categories:
–

Flight modes: normal flight modes

–

Special Modes: modes used in special vehicles, special circumstances,
requiring special capabilities or used only in very specific moments.

–

Non-Flight modes: modes that may pose danger for the aircraft if
commanded while in-flight.

–

When available (optional Autopilot feature), an additional row of buttons will be
displayed, reading “NORMAL” and “ECO”. See 2.13.1.2 Normal and ECO flight laws.

–

The Altitude, Velocity and Orbiting radius setting menu. The operator can select the
Altitude, Velocity and Orbiting radius on each flight mode. To do so the operator
must enter the new values on the corresponding box and click Set button. Orbiting
is only available for fixed wing UAVs and it is not available for rotary wing UAVs
–

When available (optional AP feature) and additional item will show: Vertical
Performance. See 2.13.1.3 Vertical Performance limits.

Figure 80: Command window for a fixed wing aircraft
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Note: Each UAV has a flight envelope which restricts flight speed commands to minimum
and maximum values. Values out of this restriction are not accepted by the U-Pilot. Flight
envelopes may change for each flight mode and are pre-configured by Airelectronics, the
end user does not have to worry about it.

2.13.1.2 Normal and ECO flight laws
Optionally available for fixed wing vehicles only, it is possible to change the speed and
altitude holding strategy. This settings is independent of flight mode, but not all modes
allow command of Economic flight law. Whenever the user changes the mode, the flight
law will reset to normal.
Current flight law will be indicated by a blue background in the currently active flight law
button. Modes that do not accept change of flight law will have both buttons disabled.
Economic flight law will introduce a strategy in which speed is controlled by pitch angle
and altitude is controlled by throttle command. This will reduce altitude holding accuracy,
but, in exchange, throttle command will be executed much more slower.
Additionally, autopilot will not correct altitude errors in the positive, i.e. if the autopilot is
higher than commanded the throttle will be cut to reduce consumption, but not further
action will be taken.
Economic flight also enables gliding navigation and thermal soaring through the orbiting
mode combined with economic flight law.
However, as the altitude control is not as accurate, it should not be activated whenever
near the ground or when flying in airspace that requires strict vertical separation levels.

2.13.1.3 Vertical Performance limits
Optionally available autopilot feature. It may not apply to your software/autopilot pair.
Through this setting, vertical transition climb and descend can be limited. Current limit is
displayed in the selected vertical climb units or “Unlimited” is shown.
When operating unlimited or with a too high limit, the autopilot flight envelope limitations
still apply and transitions will be executed at maximum pre-configured safe values.
Available modes for vertical performance in fixed wing are:
•

Unlimited: All vertical altitude changes will be executed with maximum effort to
reach commanded altitude as fast as possible.

•

Manual: No vertical performance actuation will surpass the commanded limit. Some
modes, however, have the authority to revoke this limitation: specially emergency
procedures to recover a safe altitude when an automatic return home sequence is
initiated.

•

Auto: Autopilot will calculate proper rate to reach at destination with the
commanded altitude. This implies that modes that do not imply a point to point
travel (e.g. orbiting) will proceed as unlimited. In case the requested altitude
change is too aggressive, the autopilot will clip the climb/descend by envelope
protection and will behave as Unlimited.

Take into account that approach modes will ignore these limits to be able to comply with
pre-programmed landing path.

2.13.1.4 Available Fixed Wing Modes description
2.13.1.4.1

Manual mode

At this flight mode U-Pilot gives all the control to the external pilot.
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This mode must be selected before the mission starts in order to do the Pre-Flight settings.
Be aware of the throttle stick specially in electric motors.
2.13.1.4.2

Semi-Manual

In this mode the manual pilot input commands will be interpreted as requested attitude
angle, instead of requested surface deflection. Autopilot will only control attitude

angles while in this mode, so it is responsibility of the manual pilot to maintain safe
altitude, safe flight speed and proper navigation.
2.13.1.4.3

Fly To mode

At this flight mode the UAV heads a destination point selected by the Computer Operator,
the destination point can be changed on real time just left clicking on the map.
Have in mind that if you have the “ Flight plan editor” window opened, the left click will be
associated to flight plan waypoint set, and it won't change the Fly To point (indicated on
the map with a circle with “DP” in it).
When the destination point is reached the UAV automatically goes to orbiting mode using
the destination point as orbiting point.
In this mode is possible for the Computer Operator to set the commanded orbiting radius,
the commanded speed and the commanded altitude. To define new values of altitude,
speed or radius it is required to write the new value on the corresponding box and then
click Set button.
2.13.1.4.4

Orbiting mode

At this flight mode the UAV orbits a the current position, it will use the current point as
orbiting point.
In this mode is possible for the Computer Operator to set the commanded orbiting radius,
the commanded speed and the commanded altitude. To define new values of altitude,
speed or radius it is required to write the new value on the corresponding box and then
click Set button.
If the computer operator click with the left button on the map, the UAV will orbit around
the point he has clicked. If it turned out that this new point is too far away, the system will
change its mode into Fly to mode, and again, will switch into Orbiting mode when close
enough.
2.13.1.4.5

Landing mode

The UAV changes its mode to landing in three cases:
–

The Computer Operator clicks on Landing Button.

–

The Preflight Bingo Time is reached.

–

There is a Communication failure between the U-Ground and U-Pilot.

It is mandatory to properly set the Runway checking its altitude and Heading before
taking-off. In case of a communication failure the UAV will automatically go to this point.
The landing path is automatically recalculated with all the parameters set to the UAV
requirements, the user do not have to worry about it.
Landing path has 4 stages. The UAV will go through this sequence automatically:
–

Return. The UAV flys towards the hold center point, designated “L” on map. Related
to the runway this point is located backward to the right.
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–

Hold. The UAV starts an orbiting mode where adapts its velocity and altitude to
start the final landing part. The UAV will turn this path as many times as necessary
until it is ready to start the Final path. This turn is done by default clockwise, but
turn direction can be adjusted through the advanced runway menu (see 2.12.2
Runway )

–

Final. When the UAV trajectory reaches the tangent direction to the Runway the
UAV checks the speed and altitude and if they are correct it will start the final
landing part. It will start decreasing its altitude until it is over the threshold of the
runway

–

Flare. Once the Runway threshold is reached, the UAV will carefully rotate to pitch
up and it will cut down the throttle, in this controlled position it will touch the
ground.

2.13.1.4.6

Roulette mode

On Roulette mode the UAV roll is controlled by the External Pilot with a roulette on the top
right of the Futaba Joystick.
The U-Pilot still controls the altitude and speed. The Computer Operator can command a
new altitude or speed.
2.13.1.4.7

Flight Plan mode

On this mode the UAV heads one by one different defined points. These points are
numbered starting with number one, when the last point is reached the UAV will start the
flight plan again from the first point.
Each point is defined by its coordinates and by its altitude.
It is better to establish the flight plan before the mission start, but it is possible to edit it
during the flight.
To change these points follow the same procedure described on section 2.12.3 Flight-Plan
2.13.1.4.8

Take-Off mode

On Take-Off mode the UAV starts the take-off maneuver at maximum throttle and
increases the altitude.
The take-off heading is set by the operator on the Runway Heading.
Once the UAV reaches a safe altitude the Computer Operator can change its mode.
Default Autopilot version will not end Take-Off phase until
told so by the operator with a mode change.
Automatic end of Take-Off is an optional feature that has to
be enabled by Airelectronics's upon request. Contact us for
information.
Until a valid GPS fix has been established it is not recommended to start the flight.
2.13.1.4.9

Catapult Armed mode

This mode prepares the aircraft for a catapult-driven take-off. Aircraft will try to maintain
wing level and pre-configured pitch angle during launch. This mode will not command
throttle until a pre-configured amount of time has passed with movement being detected.
This allows bungee launching of electric UAVs without harm for propeller damage to the
person launching the plane.
2.13.1.4.10 Net landing mode

Net landing is a special mode, so it may not be available for your Software/autopilot
version.
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It commands the autopilot to land using net recovery mode in moving base mode. The
aircraft will cycle through the same stages that for conventional landing: Return, holding
and final, but the final target will the net location as indicated by the moving base
antenna. Vertical offset of the target has to be established through the “ Gains adjustment”
setting entry (See 2.15.3 Gains adjustment (Optional)).
In case the net threshold is crossed and the vehicle has not stopped, autopilot will execute
ABORT maneuver automatically.
This mode may not be available in your software version.
2.13.1.4.11 Abort

Execute pre-programmed net landing approach maneuver. Parameters of the maneuver
are adjusted using the “Gains adjustment” setting entry (See 2.15.3 Gains adjustment
(Optional)). It may not be available for your version.
2.13.1.4.12 S-FlyTo (Subordinate fly-to)

Equivalent to conventional fly-to, but destination point will be continuously automatically
updated to maintain relative geometry to the moving base. This mode may not be
available in your software version.
2.13.1.4.13 L-TAKEOFF (Learning Take-Off)

Only available for hand-launched aircrafts. Equivalent to normal take-off, but this mode will
set the landing site position, elevation and heading to the point and direction in which the
operator initially launches the aircraft. This mode may not be available in your software
version.
2.13.1.4.14 Come Above

Commands a return to the vertical of the landing site and an orbit upon arrival. If the
commanded altitude is lower than initial approach altitude, autopilot will climb at least
until this altitude. This mode may not be available in your software version.
2.13.1.4.15 Servos Adjustment mode

This mode is used to adjust the mechanical maximum, minimum and neutral position of
the servos. It is detailed on Servos. This mode must not be commanded in flight as the
servos are effectively disconnected from the autopilot.
2.13.1.4.16 Internal Loops mode

This mode is used to test autopilot reaction to change in attitude and proper surface
functioning. U-Pilot will deflect the surfaces trying to maintain pitch 0 and roll 0. This mode
does not run the engine (Unless told so by the manual override in the Futaba joystick) and
can be used for pre-flight aircraft check. This mode must not be commanded in flight as it
lacks navigation, speed and altitude control.
2.13.1.4.17 Brake on Runway mode

Only available in aircrafts with wheel brakes installed. This mode commands the engine to
its minimum, activates the wheel brakes and slows down the aircraft while keeping
centerline of the designated runway.
2.13.1.4.18 Camera Guided Mode

Only available with aircrafts which are equipped with an orientable camera.
In this mode the flight control is slave to the camera pointed coordinates. The UAV will fly
towards the camera designated target and fly an orbit around the pointed camera when
arrives at the commanded radius distance to keep observing the target. By changing
where the camera is pointed the navigation of the UAV is altered and it will navigate to
reach the camera pointed coordinates, thus, extreme cautious is advise when using this
mode to not loose situational awareness.
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Please, note that Camera Guided is a UAV flight mode that triggers an associated camera
control mode, but it does not work the other way around. It is not possible to change the
camera mode to trigger slave navigation behavior.
While the active flight mode is camera guided, it is not possible to change the camera
mode.

2.13.1.5 Rotary wing Command Window
To open the Command window click

icon or go to Command → Command.

The rotary wing command window is divided in two groups
–

The command modes group where the command buttons are shown, the user can
set the current flight mode. These modes are grouped in categories:
–

Flight modes: normal flight modes

–

Special Modes: modes used in special vehicles, special circumstances, requiring
special capabilities or used only in very specific moments.

–

Non-Flight modes: modes that may pose danger for the aircraft if commanded
while in-flight and are intended to run tests or diagnostics while on-ground.

–

When available (optional Autopilot feature), an additional row of buttons will be
displayed, reading “Heading: Auto” and “Heading: Man”. See 2.13.1.6 Manual and
auto heading.

–

The Altitude and Speed setting groups. Current and commanded values are
displayed here. Besides, an input box is displayed to set new commanded values. To
do so, write a new value and push Set. Written value should be displayed now in the
commanded display. Notice that is possible to set an orbit radio for rotary wing as
well. The orbit radio feature enables rotary wing aircrafts to maintain position in a
more efficient way. Setting this orbit radius at a value lower than 20 meters disables
this behavior and makes the vehicle hold on the commanded point vertically,
without performing any orbit.
–

When available (optional AP feature), an additional item will show: Vertical
Performance. See 2.13.1.7 Vertical Performance limits.

Figure 81: Command window when controlling a rotary aircraft
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Note: Each UAV has a flight envelope which restricts flight speed commands to be bound
between a minimum and maximum value. Values out of this restriction are not accepted
by the U-Pilot Autopilot. Flight envelopes may change for each flight mode and are preconfigured by Airelectronics, the end user does not have to worry about it.

2.13.1.6 Manual and auto heading
Optionally available for rotary wing vehicles, it is possible to change the heading holding
strategy. This settings is independent of flight mode.
Current heading law will be indicated by a blue background in the currently active button.
Automatic heading lets the autopilot take the decision whether the heading should be
changed for certain maneuvers given a number of parameters and variables. Manual
heading means that the autopilot will always try to perform the maneuver without
changing the vehicle’s heading. In both modes, the heading can be changed by the pilot
from the joystick.

2.13.1.7 Vertical Performance limits
Optionally available autopilot feature. It may not apply to your software/autopilot pair.
Through this setting, vertical transition climb and descend can be limited. Current limit is
displayed in the selected vertical climb units or “Unlimited” is shown.
When operating unlimited or with a too high limit, the autopilot flight envelope limitations
still apply and transitions will be executed at maximum pre-configured safe values.
Available modes for vertical performance are in rotary wing are:
•

Unlimited: All vertical altitude changes will be executed with maximum effort to
reach commanded altitude as fast as possible.

•

Manual: No vertical performance actuation will surpass the commanded limit. Some
modes, however, have the authority to revoke this limitation: specially emergency
procedures to recover a safe altitude when an automatic return home sequance is
initiated.

Take into account that approach modes will ignore these limits to be able to comply with
pre-programmed landing path.

2.13.1.8 Available modes for the Rotary Wing UAVs
2.13.1.8.1

Manual mode

In this flight mode the U-Pilot Autopilot gives control to the external pilot but still assists
the external pilot, specially with the heading of the UAV, acting as an advanced gyroscope,
making the system more controllable for a human operator.
This mode must be selected before the mission starts in order to do the Pre-Flight settings.
Be aware of the throttle stick specially in electric motors.
2.13.1.8.2

Take-Off mode

On Take-Off mode the UAV will start climbing and it will increase the altitude at a specified
preset vertical speed.
The take-off heading is set by the operator on the Runway Heading.
Once the UAV reaches a safe altitude it will automatically switch to Navigation mode.
Until a valid GPS fix has been established it is not recommended to start flying.
Just before commanding Take-Off mode the External Pilot must move the throttle stick of
the Futaba joystick up until the UAV is almost flying, then the Computer Operator will click
on Take-Off button. (Leave the throttle stick in that position until the Landing is over).
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When an incremental throttle Futaba joystick is used, the operation is automatic and the
External Pilot isn’t needed to perform this action.
Also, when On Ground Detector is enabled, the information from this subsystem will aid
the take-off operation, so that it is more accurate and clean.
2.13.1.8.3

Navigation mode

On this flight mode the UAV keeps its position and altitude at a destination point. The
destination point can be changed on real time just left clicking on the map. When the
destination point is reached the UAV keeps this position.
If orbiting radius is less than 20 meters, the UAV will hover on the point, otherwise it will
perform an orbit around the point with the given radius.
In this mode, it is possible for the Computer Operator to set the commanded speed and
the commanded altitude. To define new values of altitude or speed it is required to write
the new value on the corresponding box and then click Set button.
Notice that if the commanded speed is equal to 0, the UAV will not change its position.
2.13.1.8.4

Flight Plan mode

On this mode the UAV heads one by one different defined points. These points are
numbered starting with number one, when the last point is reached the UAV will start the
flight plan again from the first point.
Each point is defined by its coordinates and by its altitude.
It is better to establish the flight plan before the mission start, but it is possible to
determine it during the flight or even to edit, delete or add points.
To change these points follow the same procedure described on section 7.3.6 Flight Plan
2.13.1.8.5

Landing mode

The UAV changes its mode to landing in three cases:
–

The Computer Operator clicks on Landing Button.

–

The Preflight Bingo Time is reached.

–

There is a Communication failure between the U-Ground and the U-Pilot Autopilot.

It is mandatory to properly set the Runway checking its altitude and Heading before
taking-off. In case of a communication failure the UAV will automatically go to this point.
The landing path is automatically recalculated with all the parameters set to the UAV
requirements, the end user do not have to worry about it.
The UAV will return to the Runway Point at a safe altitude, once this point is reached, it will
command UAV commanded yaw equal to the Runway Heading and it will start descending
at a controlled rate.
Once the Ground has been reached and the UAV has landed, the External Pilot must kill the
engine and then move the B switch to down position, taking control in Manual mode and
then disconnecting power.
In case a Futaba joystick with incremental throttle is used, this operation is automatic and
the External Pilot won’t need to do anything. The UAV will automatically cut throttle when
it reaches the ground.
If the On Ground Detector subsystem is enable, the information provided will help the
throttle command during the landing mode to be more accurate and fast, as in the case of
the take-off.
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2.13.1.8.6

Camera Guided Mode

Only available with aircrafts which are equipped with an orientable camera.
In this mode the flight control is slave to the camera pointed coordinates. The UAV will fly
towards the camera designated target and keep a hover with the proper offset to see the
target at -30° elevation. Thus, this offset will change in function of the terrain clearance.
By changing where the camera is pointed the navigation of the UAV is altered and it will
navigate to reach the camera pointed coordinates, thus, extreme cautious is advise when
using this mode to not loose situational awareness and avoid collisions into ground and
elevated objects.
Please, note that Camera Guided is a UAV flight mode that triggers an associated camera
control mode, but it does not work the other way around. It is not possible to change the
camera mode to trigger slave navigation behavior.
While the active flight mode is camera guided, it is not possible to change the camera
mode.
2.13.1.8.7

Spool-up mode

This mode is intended to be used prior to the take-off mode, allowing the engines to
establish a stable working condition. It will increase the engine rotation up to a stable
value.
2.13.1.8.8

Warming-up mode

This mode must be commanded in the ground as a secure mode when the aircraft is
equipped with an internal combustion engine that might generate vibrations and that
takes some time to warm up to the working temperature.
2.13.1.8.9

Ground Standby mode

This mode must be commanded when the aircraft is in the ground as a secure, given that
it disables throttle command and gyro stabilization. It has been developed to be used with
the incremental joystick, but it is also useful with a normal joystick.
2.13.1.8.10 Servos Adjustment mode

This mode is used to adjust the mechanical maximum minimum and neutral position of the
servos. It is detailed in section 2.15.11 Servos section.
This mode shall never be commanded while in flight, as it disconnects servos from the
autopilot control.
2.13.1.8.11 Internal Loops mode

This mode is used to test autopilot reaction to change in attitude and proper surface
functioning. U-Pilot will deflect the surfaces trying to maintain pitch 0 and roll 0. This mode
does not run the engine (Unless told so by the manual override in the Futaba joystick) and
can be used for pre-flight aircraft check. This mode must not be commanded in flight as it
lacks navigation, speed and altitude control.

2.13.1.9 Captive Rotary wing Command Window
To open the Command window click

icon or go to Command → Command.

The rotary wing command window is divided in two groups
–

The command modes group where the command buttons are shown, the user can
set the current flight mode. These modes are grouped in categories:
–

Flight modes: normal flight modes.

–

Non-Flight modes: modes that may pose danger for the aircraft if commanded
while in-flight and are intended to run tests or diagnostics while on-ground.
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–

When available (optional Autopilot feature), an additional row of buttons will be
displayed, reading “Heading: Auto”, “Heading: Man” and “Heading: CAM”. See
2.13.1.10 Heading modes.

–

The Altitude and Speed setting groups. Current and commanded values are
displayed here. Besides, an input box is displayed to set new commanded values. To
do so, write a new value and push Set. Written value should be displayed now in the
commanded display. Notice that it is not possible to set an orbit radio for captive
rotary wing, given that it is not used by this type of aircraft.
–

When available (optional AP feature), an additional item will show: Vertical
Performance. See 2.13.1.11 Vertical Performance limits.

Figure 82: Command window when controlling a captive rotary aircraft

Note: Each UAV has a flight envelope which restricts flight speed commands to be bound
between a minimum and maximum value. Values out of this restriction are not accepted
by the U-Pilot Autopilot. Flight envelopes may change for each flight mode and are preconfigured by Airelectronics, the end user does not have to worry about it.

2.13.1.10 Heading modes
Optionally available for captive rotary wing vehicles, it is possible to change the heading
holding strategy. This settings is independent of flight mode.
Current heading law will be indicated by a blue background in the currently active button.
Automatic heading lets the autopilot take the decision whether the heading should be
changed for certain maneuvers given a number of parameters and variables. Manual
heading means that the autopilot will always try to perform the maneuver without
changing the vehicle’s heading. In both modes, the heading can be changed by the pilot
from the joystick. With CAM Heading, the UAV will follow the movement of the camera and
look where the camera is looking, trying to make the pan of the camera 0. It is intended to
be used with cameras in camera modes different than manual.

2.13.1.11 Vertical Performance limits
Optionally available autopilot feature. It may not apply to your software/autopilot pair.
Through this setting, vertical transition climb and descend can be limited. Current limit is
displayed in the selected vertical climb units or “Unlimited” is shown.
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When operating unlimited or with a too high limit, the autopilot flight envelope limitations
still apply and transitions will be executed at maximum pre-configured safe values.
Available modes for vertical performance are in captive rotary wing are:
•

Unlimited: All vertical altitude changes will be executed with maximum effort to
reach commanded altitude as fast as possible.

•

Manual: No vertical performance actuation will surpass the commanded limit. Some
modes, however, have the authority to revoke this limitation: specially emergency
procedures to recover a safe altitude when an automatic return home sequance is
initiated.

Take into account that approach modes will ignore these limits to be able to comply with
pre-programmed landing path.

2.13.1.12 Available modes for the Captive Rotary Wing UAVs
2.13.1.12.1 Manual mode

In this flight mode the U-Pilot Autopilot gives control to the external pilot but still assists
the external pilot, specially with the heading of the UAV, acting as an advanced gyroscope,
making the system more controllable for a human operator.
This mode must be selected before the mission starts in order to do the Pre-Flight settings.
Be aware of the throttle stick specially in electric motors.
2.13.1.12.2 Take-Off mode

On Take-Off mode the UAV will start climbing and it will increase the altitude at a specified
preset vertical speed.
When the take-off mode is commanded the aircraft will reposition its landing
site to match current position, altitude and orientation.
Once airborne, if you re-command the take-off the altitude of the landing site
will have to be adjusted.
Once the UAV reaches a safe altitude it will automatically switch to Hold Position.
Until a valid GPS fix has been established it is not recommended to start flying.
Just before commanding Take-Off mode the External Pilot must move the throttle stick of
the Futaba joystick up until the UAV is almost flying, then the Computer Operator will click
on Take-Off button. (Leave the throttle stick in that position until the Landing is over).
When an incremental throttle Futaba joystick is used, the operation is automatic and the
External Pilot isn’t needed to perform this action.
Also, when On Ground Detector is enabled, the information from this subsystem will aid
the take-off operation, making the throttle command more accurate and fast based on the
ground detection.
2.13.1.12.3 Hold position mode

On this flight mode the UAV keeps its position and altitude on top of landing site. In this
mode, it is possible for the Computer Operator to set the commanded altitude. To define
new values of altitude, it is required to write the new value on the corresponding box and
then click Set button.
Notice that the commanded speed is always equal to 0, given that the UAV will not change
its position.
2.13.1.12.4 Landing mode

The UAV changes its mode to landing in three cases:
–

The Computer Operator clicks on Landing Button.
Document Version 1.54

89

U-See User Manual - Command Menu
–

The Preflight Bingo Time is reached.

–

There is a Communication failure between the U-Ground and the U-Pilot Autopilot.

It is mandatory to properly set the Runway checking its altitude and Heading before
taking-off. In case of a communication failure the UAV will automatically go to this point.
The landing path is automatically recalculated with all the parameters set to the UAV
requirements, the end user do not have to worry about it.
Once the Ground has been reached and the UAV has landed, the External Pilot must kill the
engine and then move the B switch to down position, taking control in Manual mode and
then disconnecting power.
In case a Futaba joystick with incremental throttle is used, this operation is automatic and
the External Pilot won’t need to do anything. The UAV will automatically cut throttle when
it reaches the ground.
If the On Ground Detector subsystem is enable, the information provided will help the
throttle command during the landing mode to be more accurate and fast, as in the case of
the take-off.
2.13.1.12.5 Spool-up mode

This mode is intended to be used prior to the take-off mode, allowing the engines to
establish a stable working condition. It will increase the engine rotation up to a stable
value.
2.13.1.12.6 Ground Standby mode

This mode must be commanded when the aircraft is in the ground as a secure, given that
it disables throttle command and gyro stabilization. It has been developed to be used with
the incremental joystick, but it is also useful with a normal joystick.
2.13.1.12.7 Servos Adjustment mode

This mode is used to adjust the mechanical maximum minimum and neutral position of the
servos. It is detailed in section 2.15.11 Servos section.
This mode shall never be commanded while in flight, as it disconnects servos from the
autopilot control.
2.13.1.12.8 Internal Loops mode

This mode is used to test autopilot reaction to change in attitude and proper surface
functioning. U-Pilot will deflect the surfaces trying to maintain pitch 0 and roll 0. This mode
does not run the engine (Unless told so by the manual override in the Futaba joystick) and
can be used for pre-flight aircraft check. This mode must not be commanded in flight as it
lacks navigation, speed and altitude control.

2.13.1.13 Activating non-flight modes
When activating any non-flight mode, the software will warm and ask for confirmation prior
to performing the action given the danger an accidental click may pose. In some cases,
this is undesirable given that some actions must be performed fast by the operator and
the confirmation may delay the reaction time. In this cases, there is an option available in
U-See Settings dialog, please refer to Section 2.15.14 U-See settings.
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2.13.2 Camera command window
In this window you can command the available
on-board camera pointing capabilities of U-See.
The different modes available for the camera
pointing are:
•

Forward: Camera will point directly
forward. No change in orientation is
permitted.

•

Manual: Camera will point in the angles
specified
regardless
the
vehicle
orientation. The orientation of the
camera may be changed in this mode
through a dedicated joystick connected
to the computer or entering directly the
desired pan and tilt value in the input
boxes. This boxes only appear when this
mode is selected.

Stabilized: The camera will maintain
spatial orientation of the current selected
pan and tilt. If the vehicle rises its nose,
the camera will correct the movement to
continuing looking at the same spatial
direction. Although it will not follow a
particular
sub-vehicle
point.
The
Figure 83: Camera modes dialog
orientation of the camera may be
changed in this mode through a dedicated joystick connected to the computer.
•

•

Rates: Same as stabilized.
However, it is the payload
that takes responsibility to
maintain
a
spatial
orientation. This mode is
only available with advanced
gyro-stabilized payloads that
are capable of such feat on
their
own
(e.g.
Airelectronics' payload, DST
Figure 84: Camera rates trim
OTUS gimbals, etc.). The
orientation of the camera
may be changed in this mode through a dedicated joystick connected to the
computer.
Some cameras have a drift that can be corrected through specific trimming options
that appear when this camera mode is selected. The drift correction is reported in
°/min for each axis, clicking the “-” button adds negative correction for that axis
and clicking the “+” sums up positive correction. The “R” button allows to reset the
trim to 0 °/min.

•

Geo-Referenced: In this mode the camera of the vehicle will be pointed towards
the point designated through left click on the map. The camera will correct attitude
changes and position changes in the vehicle to always look to the coordinates
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selected. The hardware will use a Digital Elevation Model (DEM) to keep track of the
ground while climbing or descending. The orientation of the camera may be
changed in this mode through a dedicated joystick connected to the computer.
•

Neutral: Camera actuators will be instructed to adopt their neutral position. For
most cameras, this is considered the safe mode for critical flight stages, such as
landing.

•

Lateral: Special mode for one-axis roll mounted cameras. This mode keeps a fixed
angle with the horizon and enables stable observation of an on-ground point while
in orbiting with a considerably lighter and simpler camera setup.

•

Camera Guided: This mode cannot be activated through the camera command
dialog, however, while it is active, it is not possible to change the camera mode.
While in this mode, the UAV will navigate to get closer to the camera pointed
coordinates and keep the target in visual range. This mode affects not only the
camera behavior, but also the navigation behavior, so it has to be commanded from
the main command window (section 2.13.1: Command window).

The selected camera mode button will turn blue when the autopilot receives the
command.
Besides, you can command the zoom level of the camera through the zoom slider.
The options in this window change depending on the type of payload defined in the
2.15.9 Payload setting window giving for some systems the ability to turn on or off
different cameras or switch between them.
If shooter is enabled and the camera is compatible with this function, a group of buttons
will appear in the bottom of the window reporting the status of the shooter and the
number of photos taken. In addition, if Raspberry Pi is installed and configured it can be
commanded from this menu. In this part of the window the shooter can be turned on, this
will be reported by a yellow light in the bottom of the run button. The lights on the right of
the button show if the PWM is performing a camera shoot (green) or not (red). Under the
number of photos shot a label reports if the shutter is overridden (in red) or not (green,
normal operation). This label also reports if a NUC is being performed (in orange color).

Figure 85: Camera shutter with Raspberry Pi
installed

Figure 86: Airelectronics IR Camera Options

2.13.2.1 Airelectronics U-Camera IR options
When an IR version of U-Camera is connected to the system, an additional group of
options will appear. (“IR Specific”). This section allows the user to change the color palette
of the IR image and to perform the thermal calibration of the sensor.
The “Get” button updates the palette selection to match the data in U-Pilot while the “Set”
button commands U-Pilot to use the selected palette.
The “Make FFC” button commands the thermal calibration of the image. The calibration
process rotates the sensor upwards, performing the calibration facing a flat surface. When
the calibration is completed, U-Camera begins to stabilize normally.
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Note that once the calibration is performed, it is not stored into the non-volatile memory of
the camera. This means that the calibration information will be lost upon restart. To store
the data into the non-volatile memory the user must click the “Save FFC” button.
Writing the data to the non-volatile memory may take up to 10 seconds.
IMPORTANT: a power loss in the middle of the writing process may result in an
uncalibrated image or even damage the video module.

2.13.2.2 NextVision gimbals options
This gimbal has two video cameras,
daylight and thermal. Two radio
buttons are shown when this
payload is detected to allows the
selection of the video source. When
Figure 87: NextVision Camera Options
the thermal camera is selected,
additional options appear in the bottom of the dialog to select the IR color.
This type of payload is also capable of recording with an onboard microSD card. Special
video recording options are shown: a “Record” and “Perform Snapshot” buttons are shown.
When the “Record” button is pressed, a yellow indicator should turn on, indicating that the
autopilot is commanding the camera to record. There are two indicators in the right of this
button: red indicator means the camera is not recording and green means it is recording.
Possible feedback text is: “Stopped”, “Recording”, “Error” (unknown error) and “Mem Full”
(SD card memory is full).
When the “Perform Snapshot” button is pressed, snapshot is performed by the camera, but
there’s no other feedback available than the camera’s original video overlay (not the
overlay generated by U-See).

2.13.2.3 Epsilon 140Z payload options
The Epsilon 140Z allows using two different cameras: daylight and thermal. Two radio
buttons are shown when this payload is detected to allows the selection of the video
source.
This gimbal features a pointing laser
class 3B that can be turned on from
the “Laser” button. When the
“Laser” button is pressed for the
first time, a warning about the
Figure 88: Epsilon 140Z Camera Options
riskiness and possible injury to the
eyes of this system is shown. If the
dialog is confirmed, the autopilot will command the laser to be turned on, and the yellow
indicator will turn on. There are two indicators in the right of this button: red indicator
means the gimbal reports the laser is off and green means the gimbal reports the laser is
on.
Also, if the Hazardous Emissions is
blocked, a red cross will show on
top of the Laser button, and the
Laser will not be commanded. See
more about this feature is the
Section 2.13.8 Hazardous emissions
(optional).

Figure 89: Epsilon 140Z trim options
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The “Perform Gyro Calib” button allows to calibrate the inertial sensors of the camera,
correcting any possible drift of the gimbal. This is only possible when the camera is not
moving. In case the camera is in the middle of a mission, it is possible to correct this drift
with the camera's rates trim options, which are shown in rates mode. This rates trim
options are different from the rest of the payloads, given that the correction is performed
natively by the camera, and it doesn’t show feedback. Pressing the “<<” button performs
8 negative steps and the “<” button performs 1 negative step. The same applies to the
“>>” and “>” buttons, but with positive steps.

Figure 90: Epsilon 140Z Camera Options

option.

Additionally, false colors can be
applied to any of the cameras
present of this gimbal. The options
are shown in the bottom of the
camera dialog. Setting the false
color to “Default” will reset this

2.13.2.4 ASIO 155 payload options

The ASIO 155 allows using two different cameras: daylight and thermal. Two radio buttons are
shown when this payload is detected to allows the selection of the video source. When the thermal
camera is selected, additional options appear in the bottom of the dialog to select the IR color.

This gimbal features a pointing laser
that can be turned on from the
“Laser” button. When the “Laser”
button is pressed, the autopilot will
command the laser to be turned on,
Figure 91: ASIO 155 Camera Options
and the yellow indicator will turn on.
There are two indicators in the right
of this button: red indicator means the gimbal reports the laser is off and green means the
gimbal reports the laser is on. The “Perform Gyro Calib” button allows to calibrate the
inertial sensors of the camera, correcting any possible drift of the motors. This is only
possible when the camera is not moving.

2.13.3 Landing Control window (Optional)
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Figure 92: Landing Control window

Designed for fixed wing landing operation, this window won't be available while operating
a rotary wing aircraft or captive rotary wing aircraft.
The window is designed to reduce clutter interface while in landing phase by showing only
landing related commands and information.
This windows is composed of a profile view of the landing maneuver. It will show current
aircraft position and altitude, the current commanded altitude (Yellow horizontal line) and
hold level altitude, besides field landing elevation.
Below the profile display, an embedded version of the flight systems tab from the vehicle
subsystems dialog is available. This allows manual override of the flaps and airbrakes in
the aircraft. Also landing gear and wheel brakes can be commanded from here.
Mode command is also available, with only landing-relevant modes available with the
buttons located at the right bottom corner.
Next to the profile view drawing, a variometer will appear when the aircraft is on landing
phases HOLD, FINAL or FLARE, for a better control of the altitude.
Also, inside the profile view drawing, additional bars with the horizontal and vertical
deviation will appear showing the deviation from the landing path in meters. This bars use
special units, so only meters will be available. The bars will only show in FINAL or FLARE
phases of landing.
When in final approach mode, a progress bar will show how many meters are left for the
flare phase and an extra button to force flare mode will be displayed. If an AGL sensor
measure is available, an indicator of this measure appears on the right down corner of the
window. Also, as the AGL sensor measure can be used for calculating the meters left for
flare height (it depends on the system configuration), the flare height source is indicated
below the ‘Force flare’ button:
•

‘Altitude’ means the navigation altitude is used

•

‘AGL’ means a direct sensor measure is being used.

•

The progress bar associated to the meters left for the flare phase depends on this
height source.
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Only in UAVs with wheel brakes, when in final or flare mode, the button “Brake on Runway”
will appear. This button commands a change in the flight mode to Brake on Runway. The
button will be shown disabled while in final approach and will be enabled for use when the
aircraft enters Flare mode. This mode should be activated only after the plane has

successfully touched down.

Figure 93: Landing Control scaled

For aircrafts which landing path is too large compared to the hold altitude, the drawing
may be drew inaccurately to be monitored. In this case, right-click inside the landing
drawing may be performed to represent a scaled mode where the proportions of the
landing path length related to the landing hold altitude won’t be kept but, instead, the hold
altitude will be draw occupying the whole drawing height to provide greater detail. When
this mode is activated, an “S” is drew in the upper left corner of the drawing.

2.13.4 Take Off window (Optional)
As the previous dialog, Take Off window has been designed for fixed wing aircrafts that
supports rolling take-off. The window is not available for fixed wing aircrafts that do not
support this type of take-off, rotary wing aircrafts and captive rotary wing aircrafts.
The window is designed to reduce clutter interface while in take off phase by showing only
take off related commands and information.
It is composed of a graph showing IAS and rotation velocity in real-time, by default. The
main utility of this graph is giving the user the necessary information in order to determine
if the aircraft will reach the rotation velocity, keeping in mind the IAS evolution during the
rolling-on-runway maneuver.
Below the graph an embedded layout of flight systems can be found, as in the landing
window. Buttons related to specific take off modes are placed besides the graph. These
modes are Rolling On Runway, Rolling On Runway (Manual control), Brake On Runway and
Taxi. To prevent unintended commands, the dialog only enables the take-off associated
buttons when the aircraft has reported a mode compatible with a rolling-on-runway takeoff or taxi mode. The Taxi mode button is always available, but will ask for confirmation to
enter Taxi Mode if the mode is not one of the associated with rolling-on-runway take-off.

Taxi mode must not be commanded while in flight.
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Figure 94: Take Off window

When Rolling On Runway or Rolling on Runway (Manual control) are commanded, a
deviation bar appears below the graph in order to inform about the deviation of the aircraft
from the centerline of the intended take-off path

2.13.5 Vehicle Subsystems
Vehicle Subsystems window contains every subsystem installed in the UAV. Not all the
subsystems are available for every UAV, so it is probable that some of the systems
mentioned below do not appear in your software.
This window is subdivided in two tabs, “ Flight Sys” contains subsystems involved in aircraft
flight and landing control as flaps, airbrakes, landing gear and wheel brakes. “S econdary
Sys” contains subsystems not critical for flight as lights, gimbal retractable system and
video. Tabs are only available if aircraft presents subsystems in it.
2.13.5.1 Flight Sys
U-Pilot has its own algorithms to control the flaps and spoilers during the take-off and
landing. There is also a U-Pilot available configuration in witch flaps are controlled
manually by the operator, in that case the flaps must be controlled using the Vehicle
Subsystems window on Command → Vehicle Subsystems. On that windows there are tree
possible flap positions to be chosen by the operator at any time.
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From this window, the user can also handle airbrakes adjusting its position or leave them

Figure 95:Vehicle Subsystems window. Flight Sys tab

in automatic for the autopilot to control.
Selecting any other position than “ Auto Airbrake” will force the airbrakes to remain in that
position and autopilot won't change its position under any circumstance. Under normal
operating conditions, airbrakes should remain in automatic position.
This window also allows to control Landing gear system, which can be stow or deployed
from here. In addition landing gear wheel brakes can be operated.
2.13.5.2 Secondary Sys
This tab will allow to command secondary systems present in the aircraft. From here,
navigation and strobe lights can be turned on or off. Also this window manages gimbal
retractable system and on-board video.
2.13.5.3 Aux Toggles
This tab appears when the user sets some text in any of the aux toggles options available
in Settings → Config dialog, Aux Toggle Tab (see section 2.15.2.6 External Devices: Aux
Toggle).
When configured, they enable the turning off and on of the associated auxiliary uav
systems.

2.13.6 Engine management
Engine management window offers the possibility to inhibit the engine of the UAV. While
being active, this option ensures that the autopilot (which is constantly controlling the
engine) does not start the engine.

Figure 96: Engine management window
The inhibit feature is intended to be used while UAV is on ground, in the pre-flight phase,
while checking everything is correct. This option should be deactivated before flight
begins.
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Activating or deactivating the inhibit option is dangerous
while in flight phase, therefore this option must NOT be
used once UAV is flying.

If you wish to know if your autopilot supports this additional feature, please check your
autopilot version or contact us.

2.13.6.1 AMT electronic control unit
If you have an AMT ECU connected, this display will show up.

Figure 97: Engine management window AMT’s specific view
Additional documentation about this view is hosted in the project’s specific documents,
please contact Airelectronics to obtain them.

2.13.6.2 Other interfaces
There are other project-specific command windows which we cannot cover on this general
manual.

2.13.7 Transponder (Optional)
The transponder is a device that identifies the aircraft that is carrying it with a 4 digits
octal number by answering primary radar interrogation.
This window will only display in U-See if the aircraft is equipped with a transponder and the
proper configuration options have been stablished by airelectronics personnel.
This dialog allows the user to control the aircraft’s transponder. The transponder will
report the measured altitude, the code and the mode that it has set at the moment when
the user presses Get.

Figure 98: Transponder Window

By clicking in the edit button, the user can change the transponder mode and the
answered code. In this edit section, it is possible to set a different transponder code.
While in edit mode, the transponder can be put in these modes:
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Software dialog

Off

Meaning

The transponder won’t transmit information

Mode
Normal Transponder will only answer primary radar information
(Transponder Mode A)
Mode
Altitude Besides answering the radar ping, the transponder will append information
(Transponder Mode C)
about current pressure altitude

The transponder should be operated while in contact with the control dependency
responsible for the airspace the aircraft is operating in. Some legislations may assign a
generic code for UAVs operating in uncontrolled airspace. Please check with your local
aviation agency.
There are some internationally assigned transponder codes reserved for emergencies onboard aircrafts. Usually these codes do not apply to UAVs and should not be used at all.
The software will recognize and warn the user before uploading these codes to the aircraft:
Code

Reserved for

7500

Unlawful interference

7600

Communications failure

7700

General Emergency

While the 7600 code might seem like a good idea for a lost comms UAVs its applicability
for UAVs varies from legislation to legislation so the autopilot won’t change the
transponder code in a communication loss scenery. If you need this behavior, please
contact us for the proper changes in your autopilots.
In many countries improper use of reserved transponder codes (specially
7500) is deemed a very serious offense which can result in very serious
fines (thousands of dollars) or even jail time. Please, make sure you
really understand transponder operation before using it.

2.13.8 Hazardous emissions (optional)
If your aircraft is equipped with any equipment that may
emit signals that may pose any danger for the human
beings or animals (such as a gimbal with a class 3B
pointing laser), this menu is shown. The hazardous
emissions blocking system is used to block this
equipment from working whenever it is not completely
safe. There are three possible working modes:
•

Figure 99: Hazardous emissions
dialog

Auto: The autopilot will decide whether it is safe
or not to turn on this systems. Normally, the
emissions are blocked in take-off and lading
stages, whereas they are allowed in normal flight
modes.

• Block: The emissions are forcefully blocked and it
is not possible to turn on any system categorized as hazardous-emitting, until the
user changes the mode manually.
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•

Allow: The emissions are always allowed, and thus, any system categorized as
hazardous-emitting can be turned on until the user changes the mode manually.

2.13.9 Video processor (optional)
The video processor dialog allows the user to control some video related features that
requires a video processor board. This video processor might be independent or might be
included in the gimbal or camera. Some of this options will be also available in the video
capture dialog (See Section 2.11.6.4 Video Processor options (Optional)).

2.13.9.1 Epsilon 140Z
The Epsilon 140Z gimbal is equipped with a incorporated video
processor with capabilities to perform stabilization and tracking. In
this dialog there are options to control video stabilization, tracking
mode and tracking size.
•

Clicking on the “STAB” buttons toggle on/off the digital video
stabilization. When this feature is enabled, the stabilize on
track feature is also active, which means the tracking box
will always be on the center of the image.

•

Clicking on the tracking mode icons will change the tracking
mode the video processor is using. The first icon
corresponds to “static” mode, used to track static objects,
and the second button corresponds to “vehicle” mode, used
to track moving objects.

Figure 100: Epsilon 140Z
video processor dialog

•

The box width slider changes the tracking box width.

2.13.9.2 ASIO 155
The ASIO 155 gimbal is equiped with a PixBoard video processor
with capabilities to perform stabilization and tracking. In this dialog
there are options to control video stabilization and tracking size.
•

Clicking on the “STAB” buttons toggle on/off the digital video
stabilization.

•

The box width slider changes the tracking box width.

2.13.9.3 Sightline

Figure 101: ASIO 155
video processor dialog
The SLA 1500 from Sightline is an
standalone video processor which can be
used with a wide range of cameras, even though we support the
use of this video processor with U-Camera gimbal (daylight or
thermal version). It can perform tracking and stabilization. The
options available are:

Figure 102: Sightline
video processor dialog

•

Temperature: To monitor the board temperature.

•

Stabilization control: “STAB” button allows to toggle the
digital video stabilization, while “ROLL STAB” button allows
to toggle special digital video stabilization applied to the roll
axis. When this feature is enabled, the stabilize on track
feature is also active, which means the tracking box will
always be on the center of the image.
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•

Clicking on the tracking mode icons will change the tracking mode the video
processor is using. The first icon corresponds to “static” mode, used to track static
objects, and the second button corresponds to “vehicle” mode, used to track
moving objects.

•

The box width slider changes the tracking box width.

2.13.10 GPS source manager (optional)
In case there is an external GPS connected to the system in addition to the onboard GPS,
this tool is used to manage the priority of the navigation solution supplied by each GPS.

Figure 103: GPS source
manager window

There are two main sections in this window:
•

Source info: Information about the source used for obtaining the navigation solution
(main source) and the detected external GPS (external source).

•

Force source: There are four ways in order to select the main GPS source, one for
each button. The modes are:
◦ AUTO: The onboard GPS has priority. If the onboard GPS has no valid fix, the
external GPS is chosen if it’s available.
◦ AUTO EXT. (Optional): The external GPS has priority. If the external GPS has no
valid fix, the onboard GPS is chosen if it’s available.
◦ MAN.ONBRD: The onboard GPS is always selected as the main source, even it
has no valid fix.
◦ MAN.EXT: The external GPS is always selected as the main source, even it has no
valid fix.

2.14 Post-Flight Menu
This menu contain options to analyze the data collected from an actual flight. The
operations contained in this section do not require communication to an U-Pilot.
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2.14.1 Record Data → ..tx
txtt
This window is used to transform the binary-only telemetry files recorded on the Record
Data dialog to different (usually) text-based formats.
The window presents a button for
selecting a binary telemetry file and an
output format selector.

Figure 104: Recorded data->.txt Window

Once the Start button has been clicked,
the conversion will start converting the file
to the selected format. The text-version
file will be located in the same directory
than the selected binary file, so it is
necessary that the file is located in a
write-accessible location.

2.14.1.1 Current available formats:
2.14.1.1.1

Aircraft Telemetry TXT

This format exposes the main variables of the flight in a text file suitable for analysis with
Microsoft Excel, LibreOffice/OpenOffice Calc, Matlab and similar.
The filename will be that of the binary telemetry file appended with “.txt”
The information contained into this file is structured in 29 columns, separated by tabulator
character and end of line is marked using \r\n special characters, according to this table:
Data

Units

Pitch

[Degrees]

Roll

[Degrees]

Yaw

[Degrees]

Commanded Pitch

[Degrees]

Commanded Roll

[Degrees]

Commanded Yaw

[Degrees]

ADC Channel 1

[Volts]

ADC Channel 2

[Volts]

ADC Channel 3

[Volts]

ADC Channel 4

[Volts]

Altitude

[meters]

latitude

[Degrees]

longitude

[Degrees]

IAS

[km/h]

Ground Speed

[km/h]

Commanded IAS

[km/h]

Commanded Altitude

[m]

Speed North

[km/h]

Speed East

[km/h]

Speed Down

[km/h]

Uptime hours

[hour]

Uptime minutes

[min]
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Uptime seconds

[s]

UTC Time hour24

[hour]

UTC Time minute

[minute]

UTC Time seconds

[s]

UTC Date Year

[year]

UTC Date month

[months]

UTC Date day

[days]

Table 6: Data exported for analysis available to the end user

2.14.1.1.2

Camera shots position file TXT

This expansion format is intended for post-process of topography and agriculture studies
flights. It will export the main information regarding camera shoots coordinates, plane
attitude and time of the shoot.
The filename will be
“_Pointing_coordinates.txt”

that

of

the

binary

telemetry

file

appended

with

Every line in the file is the position of a camera shoot.
The information contained into this file is structured in 18 columns, separated by tabulator
character according to the table 7. End of line is marked by \r\n special characters.
Data

Units

Aircraft Pitch

[Degrees]

Aircraft Roll

[Degrees]

Aircraft Yaw

[Degrees]

Aircraft Latitude

[Degrees]

Aircraft Longitude

[Degrees]

Aircraft Altitude

[Meters]

Camera Pan

[Degrees]

Camera Tilt

[Degrees]

Camera
normalized [0-1]
pointing
vector
in
horizontal
frame.
North component.
Camera
normalized [0-1]
pointing
vector
in
horizontal
frame.
East component.
Camera
normalized [0-1]
pointing
vector
in
horizontal
frame.
Down component.
Camera
Pointing [Degrees]
target Latitude
Camera
Pointing [Degrees]
target Longitude
Camera
pointing [Meters]
target elevation.

24 UTC time reported in this field is the UTC as obtained from GPS. When there has not been a
GPS Fix it won’t be accurate.
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UTC_hour

[Hours]

UTC_minutes

[Minutes]

UTC_seconds

[Seconds]

Table 7: Data exported for analysis available to the end user

2.14.1.1.3

NMEA

Telemetry file will be converted to standard NMEA 0803 message lines. Due to limitations
in the NMEA protocol for UAV applications, only position information will be written through
$GPGLL and $GPGGA messages.
The filename will be that of the binary telemetry file appended with “_NMEA.txt”
For information about the structure of these message, check NMEA 0183 specification.

2.15 Settings Menu
Under settings menu, options regarding U-See preferences, customization and hardware
setup are available.

2.15.1 Configuration Loader / Extractor (Optional)
This is an optional feature, so this section may not apply to your U-See version
This feature allows the user to extract the
settings from the autopilot and save them to
a binary file in the computer running U-See.
This window also allows to load a
configuration file provided by Airelectronics
into the autopilot or verify the on-board data
to check that it has been properly loaded.
Extract, Load and Verify tabs present similar
structure to select a file and check between
several options.
After selecting a file to load or save, the user
is able to select which options will be loaded
or extracted.

2.15.1.1 Extract
The selected options will be retrieved from
the autopilot and saved to the chosen file.
Currently, all the options appear as checked,
not allowing the user to change them. This is
a normal behaviour, the user can only
extract the whole block of options from the
U-Pilot.

2.15.1.2 Load
After selecting a file, it will be scanned and
the user will be allowed to upload only the
options available in the file. Before loading
data, the program will check if the Config file
is compatible with the U-Pilot, aborting the
operation if there is something wrong.
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2.15.1.3 Verify
Similarly to the load option, only the check-box related to the information available in the
selected file will be enabled. This process will check that the configurations on-board are
identical to the ones in the file.
Note: when verifying the data, in the case of a validation mismatch, information about it
will be displayed in the message interface. However, the detail level of this information
may vary from one section to another.
Example: if there is any difference in the configuration section, hexadecimal values of the
mismatching configurations will be provided, while for the servos section, only the id of the
mismatching servo will be displayed.

2.15.2 Configuration (Optional)
Usually Airelectronics personnel manages the configuration of the autopilot for our clients
and every subsequent device supplied to customers is a copy of this reference
configuration. For simplicity’s sake in many UAVs the configuration cannot be changed at
all if not by Airelectronics’ personnel.
However, recognizing that for some type of operations and/or UAVs it would be necessary
through this menu option the autopilot’s configuration is accessed.
Depending on current support level of these options and intended operation of the system
some of the options and/or layouts described in this manual may not entirely apply to your
systems.
The configuration dialog is divided in categories and subtabs. Each one of them apply to
different settings. In this manual each category and tab is described independently.

Figure 106 Available
config categories in a
fully U-See version

Each subtab manages its own Get/Set buttons and is effectively independent from the
others in regard to obtaining/setting the configuration options

2.15.2.1 Config. Pages: P0-P4
These are the inner most basic settings of the autopilot and usually they are not exposed.

2.15.2.2 Config. Pages: Client Exposed P0
In the most basic version of P0 the only setting that can be activated/deactivated is
whether or not the autopilot should react to a communications loss or go on ignoring it.
Use of ignore comm failure is not recommended and even may be illegal in some
legislation. If your copy of U-See and the aircraft support it, usage of a longer fail time
instead of simply ignoring the comm failure is preferred.
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2.15.2.3 Communications: Advanced Comm Failure
Autopilot has a failure communications action programmed into its configuration. For
simple aircrafts this action defaults to fly back to the landing site and land.
However, aircrafts with more operational complexity might need a bit more configurability,
this is where advanced comm failure comes into play.
In planes where the advanced comm failure is enabled, this tab will be enabled. When it is,
the general layout of this dialog is divided in two halves.
Upper halve configures general comm failure behavior (It has its own get/set buttons) and
lower back configures a sequence of actions to run when the aircraft is in communications
failure. This communications sequence has a timer associated to it.
The upper half of the dialog allows setting the following options:

Figure 107 Advanced comm Failure window

•

Type of landing in comm Failure: Type of landing the aircraft will execute when
instructed to land in the comm failure sequence. Possible options at the time of
writing is “Use configured default”, “Runway” or “Parachute”.

•

Comm Failure time: How much time (in seconds) must elapse without receiving data
from the ground for the autopilot to consider the communications failed. Note that
this period of time must be of full communications blackout. Very bad
communications won’t be considered communications failure (Recommended value:
4 seconds).
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•

Comm Failure disarm time: How much time without a comms blackout must elapse
for the autopilot to stop the programmed communications sequence progress. 0 Is a
special value that means the sequence will be disabled as soon as a packet goes
through the radio link (Recommended value: 4 seconds).

•

Unlimit Climb/descend: Whether or not the autopilot should disable climb/descent
limiter in case of a communications failure for full vertical performance.

•

Reset Flight Law: If active, the autopilot will deactivate the ECO flight law (Or any
other alternative law present) and return to fly in NORMAL (see section
2.13.1.2 Normal and ECO flight laws).

Please, be advised that the autopilot can and will reject some configurations in case it is
deemed unsafe (e.g. program a landing with parachute in a plane without parachute fitted)
so a cycle of set → get is recommended to check your settings have been accepted.
The lower half controls the programmed sequence of actions to run while in
communications failure.
This sequence is associated to a timer that starts running as soon as the communications
failure is detected. Each step of the sequence has a time limit that is associated to that
phase. The time limit is inputted in minutes and 0 is a special value that indicates that
step should not advance to the following step because of any time limit.
Available actions for the sequence are:
•

Backtrack then Land

•

Backtrack then Rally

•

Land

•

Fly to Rally Point

•

Open chute inmediately

Notice that whenever a “BackTrack” mode is selected the next entry is automatically
selected. This is because the backtrack can have as final destination the landing site or the
rally point. When a Backtrack reaches its end executes the following step (landing or flying
to the rally point).
Attention points:
•

the backtrack phase can and will end before the time limit if the end of the
backtrack (B0) is reached

•

The FlyTo Rally point action will stay indefinitely orbiting the rally point if no time
limit is specified.

•

Open Chute immediately opens the parachute and will terminate the flight killing
the engine.

•

The sequence will be interrupted if the operator issues a change of mode
independently of the value set in the “Comm failure timer disarm time”.

•

Autopilot can reject a sequence if it includes a non-supported or ill configured entry
in the sequence ( e.g. parachute in a non-parachute equipped aircraft), so a get is
recommended after a set to check your settings have been applied.

•

If the configure rally point is invalid the autopilot will use the landing site as rally
point.

2.15.2.3.1

•

Special rules that apply when advanced comm failure is active regarding interrupting ongoing operations

The comm failure sequence won’t interrupt an ongoing landing operation.
Document Version 1.54

108

U-See User Manual - Settings Menu
•

If the communications failure occurs during Taxi Mode the aircraft will enter Taxi
Brake mode (idle engine and braking straight).

•

If the communications failure occurs during runway roll the autopilot will abort the
take-off and go into brake on runway mode.

•

If the communications failure occurs during initial climb after take-off the autopilot
will delay initial comm failure action until it reaches a safety altitude.

2.15.2.3.2

Example

Figure 108 Advanced comm Failure window

In case of communications failure execute the backtrack plan with a time limit of 18
minutes.
If the time limit is reached while in backtrack the aircraft will ignore rest of said backtrack
plan and fly straight to the rally point.
If the end of the backtrack is reached before the 18 minutes at the end of the backtrack
(B0) the aircraft will fly towards the rally point.
Once the rally point action is running the aircraft will fly towards the rally point (or stay
orbiting the rally point) for up to 5 minutes.
Then it will fly towards initial approach point for landing. If it has not entered the landing
pattern/manouver in 10 minutes (See previous subsection about rules that applies to
interrupting on-going operations) it will open the parachute.
This tool introduces a good amount of flexibility to the system but it
also opens the door to configure behaviors that for one user are safe
(controlled crash of aircraft, for example) while may be catastrophic
for others.
User is advised to study this documentation and test the system
behavior while on ground to become familiar with the feature before
using it

2.15.2.4 Communications: Satcom (Reserved distribution)
This section is intentionally left blank.

2.15.2.5 External Devices: Joy Buttons
This tab allows to configure up to 14 function buttons mounted on the manual joystick for
the external pilot to use. Note that feature support is enabled on request on the manual
joysticks we supply.
Note the button action is aircraft dependent.
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2.15.2.6 External Devices: Aux Toggle
Up to 8 arbitrary subsystem off/on toggles that are left for the user to use. Up to 8
characters can be used to describe subsystem connected to each toggle.
The off/on switches will be displayed in the “ vehicle subsystems” dialog (See Vehicle
Subsystems 2.13.5) using the configured labels.
If a switch is left with a blank label it won’t be shown at all.

Figure 109: Parameter adjusting

2.15.3 Gains adjustment (Optional)
This is an optional feature, so this section may not apply to your U-See version
Some versions of U-See expose a limited amount of parameters for end-user adjustment.
The adjustment of these parameters is done through this section of the software.

A wrongful change of this parameters can cause the autopilot to be unable to
control the vehicle and the utmost care and attention is necessary when making
changes.
By clicking on the left icons a group of parameters concerning a feature can be adjusted.
Relevant parameters for the feature selected are shown in the right pane of the dialog.
Each parameter shows its name, the value the parameter had the first time it was received
through a get, the current value and the relationship between those two values. Notice the
“first time value” is the value the parameter it had the first time it was received in the
current U-See session. Consider the following scenario:
•

A get is executed and a parameter has value 1.0

•

A set is performed that establish parameter as 2.0

•

The relationship will be shown as 200%

•

U-See is closed

•

A get is executed and now first received value is displayed as 2.0

First value does not represent neither a default nor necessary safe value.
The change of the parameter can be made by direct value adjustment or by relative
changes.
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•

Absolute value: Values that can be both positive and negative will be necessary to
be written directly.

•

Relative: Values that do not need to change sign will be adjusted as a percentage to
increase or decrease over current value.

Figure 110: Relative Mode change

Figure 111: Absolute mode

Below every parameter a short description of the parameter effect and its unit will be
shown.
To make the parameters change permanent Settings → Save Settings has to be used. If a
mistake is made, it is possible to power-cycle the autopilot to undo it.
Parameters accessed through this dialog can fundamentally change
the behaviour of the autopilot. They may provoke a leave of
controlled flight and proper training and knowledge is needed to
operate this feature.
If you have any doubt, please, contact Airelectronics for support
before risking your aircraft.

2.15.4 Configure GCS Hardware (Optional)
This is an optional feature, so this section may not apply to your U-See version.
Tracking enabled U-Grounds can be configured through this option. Check specific
U-Ground documentation for the usage of this feature.

2.15.5 Ammeter Calibration (Optional)

Figure 112: Ammeter Calibration

This window is available only in systems with a configured ammeter. From here, the user is
able to calibrate the U-Pilot ammeter. In Raw Battery the system reports the value read
from the ammeter, Calibrated Battery shows the value after applying scale and offset to
the raw value.
The formula used to calculate the calibrated value is:

Calibrated Value=Scale∗(Raw Value+Offset )
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2.15.6 Crypto Management (Optional)
Systems equipped with cryptographic security will show this window. Here, the user can
check the status of the cryptography in both the U-Ground and U-Pilot units; set the keys
for upstream and downstream, and enable and disable the cryptographic mode.

Figure 113: Crypto Management Dialog while the cryptography is working properly.

Before starting the operation and enabling the cryptographic mode, it is important to set a
new pair of random keys (that can be generated using the Random Keys section) by
clicking the Set Keys button. Once the keys are set in the U-Pilot, the cryptographic mode
can be enabled. When cryptographic mode is active in U-Ground and U-Pilot, the status of
both is reported as “On”. In the case an error occurred during the activation of
cryptographic mode, the error message is reported next to the status.
Please, note the importance of setting a new pair of keys after each system reboot to keep
the system working in a secure mode.
In the next table there is a list of the most common errors found while entering or exiting
cryptographic mode and how to solve them.
Description

No Comms
Disable

Error

after

U-Ground Status U-Pilot Status

Solution

clicking Off

Unknown

Click Enable crypto
again, the disable
packet might have
been lost.

No Comms Error after a U-Ground Off
restart

Unknown

Set keys again and
click Enable.

No Comms Error after clicking Enable On

Unknown

Click Disable crypto,
this
must recover
comms.

Tabla 8: Crypto Troubleshooting.

In the section named “Used Nonce Space”, total percentage of cryptographics nonces is
reported. This is equivalent to the total time available to use the cryptographic mode, so
when 100% is reached, the communications will be lost. Please, renew your cryptographics
keys before 100% is reached in any channel (channels are asymmetrical given that the
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amount of packets sent is different). This is only important for very long endurance
operations (time available is roughly +1 week), so normal users shouldn’t be worried
about this.

2.15.7 Manual Trims
The manual trim dialog allows the user to change the surfaces trim of the vehicle: this
allows to deflect surfaces a constant amount through all the flight envelope, thus
eliminating movement tendencies acquired through change of CoG, damage to
aerodynamic surfaces due to wear, etc.
For each command there are two buttons that modify the trim status and automatically
upload the new values to the vehicle, meanwhile the button “ Get” downloads the current
values of the trims. Keeping the button pressed will continue to trim in that direction,
accelerating the trim value with time.
There is a column showing current auto-trim values the autopilot is applying. This values
can be used as guidance to set the manual trim. However, different flight regimens require
different trim values so values different than zero should be expected when out of the
reference regimens. The Manual trim should be set for fixed wing aircrafts flying straight
and leveled at medium speed. For rotary wing aircrafts it should be set for a stationary
hover flight.
Unless operating with the automatic throttle capability in a rotary wing aircraft the Throttle
trim should be left as 0.

Figure 114: Manual trim window

2.15.8 Camera Joystick
This dialog allows configuration and operation of a HID compatible joystick for camera
control and operation.
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Figure 115: Joystick settings window

Joystick used for control can be selected and opened 25, besides configuration of the axis
and buttons used for functionality.
First tab shows the general configuration for the joystick including current joystick,
sensitivity sliders for normal and fast modes and the option to set the zoom in relative or
absolute mode. Relative mode sets a zoom depending on the time the designated axis has
been in up or down position. Absolute mode sets the direct position of the axis as zoom.
The second tab shows the current status of joystick, drawn in schematics. Status row at
the bottom of the dialog reports the raw status of each joystick axis and button. Tilt, pan,
roll and zoom axes show the current position of these assigned axes. Below those, there is
a row of buttons which report if one of them is assigned and pulsed in the joystick.
Available axes are the following:
•

Pan Axis: Axis in joystick that will move the camera in pan.

•

Tilt Axis: Axis in joystick that will move the camera in tilt.

•

Roll Axis: Axis in joystick that will move the camera in roll.

•

Zoom Axis: Axis in joystick that zooms in or out the camera.

For each axis, the configurable options are:
•

Dead zone: a slider that determines the discarded zone in the center of the axis.

•

Assign axis: a drop-down menu where the user can choose the axis number for that
function.

•

Invert axis: check-box that allows to invert the natural sense of the axis.

Besides the axes, configurable buttons are available:
25 Software will open at start-up last joystick used.
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•

Slow Button: A button that when kept pressed will reduce joystick sensitivity for fine
tuning of camera pointing.

•

Fast Button: A button that when kept pressed will increase joystick sensitivity for
fast movement of camera.

•

Man: Command camera manual mode.

•

Frwd: Command camera forward mode.

•

Stab: Command camera stabilized mode.

•

Geo: Command camera Geo-referenced mode.

•

Neut: Command camera neutral mode.

•

Lat: Command camera lateral mode.

•

Rate: Command camera rates mode.

Note that the joystick buttons cannot be assigned to more than one modes or modifiers.
Also note that if the camera installed in the aircraft does not support one of the modes
commanded no action will take effect when pulsing the joystick button assigned.
Modifiers and modes buttons only allow to configure the physical joystick button assigned
to each one.
Test should be made while on ground to assure this settings suite your application or
preferences regarding camera movement.

2.15.9 Payload setting window
This dialog is used to configure all the payload related options. Settings are grouped by
categories and subcategories or tabs. Categories and tabs could be hidden depending on
the type of payload configured.

2.15.9.1 General Config: Camera General Config
Camera installation type can
be adjusted with this dialog.
Depending on the camera that
is going to be used in the
aircraft, a different type must
be selected. Please, contact
Airelectronics
in
order
to
perform this configuration.
Serial driver section allows to
select what kind of RS-232
commands will be output
through the payload serial port.
Current supported protocols
are Sony VISCA protocol,
Controp
protocol,
TASE
Figure 116: Camera General Config
protocol, DST Gimbals, Antrica
Encoder, NextVision Single Mavlink protocol, Epsilon 140Z protocol, ASIO V3 protocol.
Other camera interface options can be added on request.
Pan-Tilt and Roll-Tilt servo option needs extra information: Angles obtained by servo
deflection has to be input for the system to know how much PWM variation needs to
command for camera control. Full deflection and neutral deflection has to be given for
proper operation of the camera.
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2.15.9.2 General Config: Angles Setup

Figure 117: Angles setup

The angles setup tab allows to declare a Maximum, minimum and neutral angles for each
camera axis. Pan and tilt commanded protocol controlled cameras needs this
configuration, as the autopilot will never exceed these declared limits.

2.15.9.3 Mount setup

Figure 118: Mount Setup

The mount setup tab allows to change the direction of each axis, by checking the “First
Axis Inverted” or “Second Axis Inverted”, the pan or tilt axis movements and feedback are
inverted, respectively. The offset configuration allows to fix little deviation that affect the
mount setup of the gimbal in the aircraft. For example, is the pan axis is not completely
aligned with the yaw axis of the aircraft, this can be fixed here. Please note that this that
not apply to geolocation mode.

2.15.9.4 Camera Shooter Config
This tab allows to manage the camera shooter configuration. In this menu it can be
disabled or set a time interval or one-time shoot. Also, the time comms are silenced for
each shoot is managed here. The time comms are disconnected before shoot and the time
after cannot be greater than a third of camera shooter interval. The addition of time before
shoot and time after shoot cannot be greater than half camera shooter interval.
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Also available, is the control of the camera's
NUC (Non Uniform Compensantion). Some
cameras require this command to be
executed
to
counter
image
quality
degradation with time (Notorious examples
are non-shutterless thermal cameras). When
this command is executed, the camera runs
a calibration loop that disables the camera
for image taking. The autopilot, when
configured to do so, will run this command
at the end of every flight plan leg to avoid
interfering with the image taking process as
much as possible. When the NUC command
is necessary, the period of time that the
Figure 119: Camera Shooter Configuration
camera is disabled for image taking must be
configured through this section of payload configuration dialog. Failure to do so will induce
problems recovering shoot positions after the flight, as the autopilot will ask for a picture
and the camera won't be able to provide it.Specific Config: Camera Specific Config
(optional)
The configuration inside this tab changes depending on the selected payload.
2.15.9.4.1

Epsilon 140Z specific config

This configurations affects the Epsilon 140Z type of payload, and allows to set an offset for
each axis, the video output mode of the camera and the analog video mode.

Figure 120: Epsilon 140Z specific config

2.15.9.4.2

ASIO 155 specific config

This configuration affects the ASIO 155 type of payload, and allows to set the network
video broadcast IP address and port.
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Figure 121: ASIO 155 specific config

2.15.10 Air Data System Settings
Adjustment to the Air Data Acquisition is made trough this window.

Figure 122: Air Data System settings window

With the 'Sync Barometric Altimeter & GPS' button in the 'Altimeter' section, the system
altitude is adjusted to reflect precisely the instantaneous GPS altitude at that moment.
The system corrects its barometric altitude using information from the navigation fix as an
input, however, if GPS initial navigation fix is of poor quality, a wrong barometric altitude
correction may be introduced into the system. This button forces the recalculation of such
barometric correction, thus correcting the problem.
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In the Main Pitot section, errors coming from pitot installation can be compensated. This
dialog allows to increase and decrease pitot indication linearly from -20% to 20%
compared to standard pitot sensor calibration. The colored dot at the left of the slider
represents the color of each pitot in the graph Ground Speed vs IAS in the Live Graphs
window.
In systems with external dynamic pressure sensors installed, “External 2 Pitot” and
“External 3 Pitot” will appear. This sections work the same manner as “Main Pitot”.
Each pitot adjustment widget displays a colored dot that matches the color used in the
Live Graph display (Section 2.11.1 Live Graphs).
To be made permanent, the changes in pitot installation need to be saved to the nonvolatile memory of the autopilot through the Save Changes entry in the settings menu.

The actions commanded through this settings window shall never be commanded
while an aircraft is in flight . Shall any doubt about the usage of this dialog arise, please
contact us before using it.

Proper operation of the Air Data System is of the utmost importance for a safe
operation of the system.

2.15.11 Servos
While the Airelectronics staff will adjust the servos on your UAV for you as part of the
adaptation, you may need to change a servo or move the autopilot among different units
of the same model of aircraft. With the servo adjustment mode, you will be able to adjust
the mechanical travels for the particular servos you use.

Figure 123: Servo adjustment window with
advanced configuration shown

Figure 124: Servo adjustment window with simple
configuration shown

This attained through the use of the servos window, accessed by means of settings →
servos menu entry.
This servo adjustment window has a top drop down control that selects which servo is
being configured. At every moment, the proper channels for the current connected aircraft
will be shown.
Below the drop-down menu to select servo, the window is divided in two zones. Left zone
allows configuration of servo end-point and neutral position (if that channel has a neutral)
and allows positioning the servo in that position during servo adjustment mode (through
buttons “Minimum”,”Neutral” and “Maximum”). Right section allows extra options and the
available settings depend on whether the channel is configured in simple or advanced
mode:
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•

In Simple mode: Simple mode exposes a checkbox to reverse the servo movement
(Inverted) and a checkbox to change the servo into “digital” mode (PWM pulse is
configured to 333Hz and 1500µs neutral pulse in an easy way). Besides the
checkbox, a “get” and “set” button are available. When clicked, get button queries
the autopilot for current in-memory values and shows them in the U-See interface.
Set button, on the other hand, takes U-See values and copy them to the autopilot
memory.

•

In Advanced mode: Advanced mode exposes the same “inverted” checkbox to
reverse servo movement direction, but also allows selection of PWM signal
frequency and pulse width. Get and Set button work the same way than the simple
counterpart.

The available frequencies for advanced mode are:
•

50 Hz (Safest, most usual servo frequency)

•

333 Hz (Usually, digital servos accept this frequency)

•

200 Hz

•

300 Hz

•

560 Hz (Very often, used for tail servo in helicopters).

Available pulse neutral times are:
•

1500 µs (Usual servo neutral)

•

760 µs (Used usually only with 560 Hz servos: this frequency leaves ~1786 µs
available for PWM width, hence the reduced pulse width )

Advanced servo configuration mode allows any combination of frequency and pulse width,
(further frequencies and pulse widths are available upon request).
Servos can be damaged by incorrect type of PWM signal. Before making
changes servo manufacturer documentation should be checked to make sure
proper settings are being applied.

The procedure to adjust the mechanical travels of the system servos would be:
1. Start the servo adjustment mode on the Command Mode window.
2. Open the Servos window on Settings → Servos.
3. Click Get button to receive the servo data from the Autopilot.
4. In case of using a digital servo (300 Hz command signal frequency) tick Digital
check box and click Set button.
5. Click 'Minimum' to move the servo to its predefined minimum position and change
the value on the box to move the servo to a new position.

6. In case the servo is not moving on the desired direction tick on Inverted check box
and click Set button.
7. Repeat the step 5, for neutral and maximum positions.
8. Press Set button to record the three values.

9. Open Save Changes on the Settings menu (Settings → Save Changes)
10. Press Yes to record the new values on the Autopilot.
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Note: The throttle servo only accepts maximum and minimum values.
Minimum, neutral and maximum values are reported in µs. Internally, the
autopilot uses a different representation of servo adjustment, so it is possible
that sometimes a different number than the input may be reported. E.g. input
1500µs and 1499µs is reported. This is normal and expected behavior.
Be aware that servo adjustment mode commands each servo independently,
so, for systems that must respect some mechanical restriction between servos
(e.g. a helicopter swashplate with a 4 servo configuration) it is very
recommended to release the quick link to avoid damaging the servos.
Advanced servo parameter configuration has been supported in the autopilot
since march 2014. Autopilots with firmware produced before this date won't
answer to the “Advanced mode” Get button. When in this case, restrain usage
to the simple version.

2.15.11.1 Adjusting a servo controlled Camera
If your system has a PWM servo controlled camera installed these steps should be followed
to adjust it properly:
1. Configure the correspondent servos for maximum, neutral and minimum
mechanical travel as indicated in section 2.15.11 Servos. To determine the proper
setting of the “Inverted” checkbox consider:
a. Pan servo should point the camera to the right when in maximum position and
to the left in minimum position
b. Tilt servo should point the camera down when in minimum position and up in
maximum position.
c. Roll servo should rotate the camera image frame clockwise when in maximum
position and counter-clockwise when in minimum position.
2. Set to neutral the pan, tilt and roll servos. (Camera should look straight ahead)
3. Command Min position in pan servo (Camera should look to the left of the vehicle)
4. Measure the angle between the line of sight of the camera and the forward
orientation.
5. Command Max position in pan servo (Camera should look the right)
6. Measure the angle between the line of sight of the camera and the forward
orientation.
7. Command neutral in Pan servo
8. Command minimum position in tilt servo (Camera should be looking down)
9. Measure the angle between the line of sight of the camera and the forward
orientation.
10. Command maximum position in tilt servo (Camera should be looking up)
11. Command neutral in tilt servo.
12. Command minimum position in roll servo. (Camera should balance to the left, or,
when looking at the image the camera produces, rotate counter-clockwise)
13. Measure the angle between the camera frame and the horizontal
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14. Command Max position in roll servo (Camera should balance to the right, or, when
looking at the image the camera produces, rotate clockwise)
15. Measure the angle between the camera frame and the horizontal
16. Introduce the measurements information in the “ Payload setting window” dialog. The
pan-tilt-roll angles follow the usual body angles convention.
a. Tilt angle is positive upwards
b. Pan angle is positive to the right
c. Roll angle is positive when the camera image rotates clockwise
17. Save all the changes by selecting settings → Save Changes

2.15.12 Pitch Throttle Curves
To set pitch and throttle curves go to Settings → Pitch Throttle Curves. On that window
is possible to get the recorded values on the Autopilot or to set new values. It is
recommended to use the values defined by the engine manufacturer.
This window is primarily intended for Rotary wing UAV and won't be available when not
communicating with a rotary wing configured autopilot.

Figure 125: Pitch and Throttle curve adjustment
window

2.15.13 Magnetometer Calibration
The performance of the magnetometer will greatly depend on its installation location. A
magnetometer relies on the earth’s magnetic field to provide heading. Any distortions of
earth magnetic field by other sources such as a UAV massive iron components should be
compensated for in order to determine an accurate heading. Sources of magnetic fields in
any UAV include permanent magnets mostly in its motors, electric currents flowing in its
wiring—either dc or ac, and Ferro-magnetic metals such as steel or iron. The influence of
these sources of interference on a magnetometer accuracy can be greatly reduced by
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placing the compass far away from them. Also, remember most GPS antennas come
equipped with magnets to attach to metallic structures. If this is the case, either keep the
GPS antenna far from the magnetometer or strip the antenna from its magnets.

Figure 126: Magnetometer Calibration Window

Magnetometer is very important in rotary wing UAV, do not fly a rotary wing UAV if the
magnetometer alarm is triggered (red color alarm displayed).
Magnetometer is not necessary in fixed wing UAVs.
The field effects can be compensated by way of calibrating the magnetometer for a
defined location in terms of magnetic interference. In order to calibrate the magnetometer
the U-See operator must follow those steeps:
1.- Turn on all the electronic parts of the UAV
2.- Wait until temperature stabilizes and GPS navigation fix is valid.(GPS alarm green color)
3.- Place the UAV on a flat surface.
4.Open
the
Magnetometer
Calibration
(Settings → Magnetometer calibration)

window

on

U-See

software.

5.- Click Start button and manually turn the UAV more than 360 degrees. Make this turn
with the UAV leveled. Do not turn too fast, finish more than one turn at the same time than
the progress bar reaches 100%
6.- Click Set button.
7.- Check than the magnetometer alarm stays green orientating the UAV north, east, west
and south. If it's not go to steep 5.
8.- Go to Setting → Save Changes and click Yes button to save the new calibration into
the non volatile memory of the U-Pilot.

2.15.14 U-See settings
All the options that affect the behavior of the U-See program and that are not strictly
associated with an UAV are grouped under this menu entry.
Available settings are classified in seven main categories. One by one description will be
given hereafter.
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2.15.14.1 Alarms & Warnings

Figure 127: Alarms & Warnings

Alarms & Warning section allow to change and fine-tune the behavior of the U-See Alarm
system.
This section is divided in three main sections:
•

Battery related on-ground alarms: It is possible to define values at which U-See will
launch an alarm, independently of autopilot on-board own alarms limits. This
section allows to define a battery voltage alarm per every available channel. If at
any point the voltage of the channel drops below the configured voltage, the
corresponding ADC channel alarm will trigger. It is possible to define also a
threshold percentage of battery below which ENG alarm will be triggered. For this
alarm to work as designed, it is important to input the correct battery available
capacity in Engine Data (See 2.11.11.1.1 Electric engine Data)

•

General Alarm configuration: this section controls how alarms behave
◦ Alarms button blinks until user press it: The alarm will blink until the user
acknowledge the alarms fail state by clicking on it. This prevents intermittent
problems go unadvertised and we strongly recommend to activate this option
◦ Alarm sound when it is generated : Whenever an alarms goes to a worse state
( Normal → Warning → Caution ) a distintive alarm sound will be emitted over the
computer speakers. It is recommended to activate this setting to prevent
missing alarms.
◦ Sound when U-Pilot’s mode changes: When a different master mode is received in
U-See a chime sound will be emitted over the computer speakers.

•

Software Warnings Configuration: this section is used for general software warnings.
The option “Don’t show warnings for non flight modes in Command dialog” is
explained in Section 2.13.1.13 Activating non-flight modes. This option is not saved
after software restarts and have to be activate explicitly for security purposes.

•

GPWS warning levels: the last section of the window allows configuration of the
GPWS warning system levels. Rotary and fixed wing may have different warning
levels. Altitudes introduced in this section are AGL (Above Ground Level) indications
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and the dialog will force the critical value to be lower than the warning level and
those two lower than the low altitude level. For more information, see 2.8.3 GPWS
Information display

2.15.14.2 Data Presentation
Customization of data presentation in State window is also allowed through this dialog, a
drop-drown menu allows the selection of data presentation mode shown in the surfaces
window (see Section 2.11.9 State).
Also in this section, is the selection of preferred units for every magnitude. See 2.5 Units
and locale for the accurate definition of available units.
Users of the imperial measurement system should check that the definition of the units
match their expected values before operating the system. Specially if you use miles for
distance measurement, as there is no “standard mile” and its definition changes from
country to country.

2.15.14.3 Maps & DEM configuration

Figure 128 Maps & DEM Configuration

This section allows to fine tune symbology presented on the map. A check is available to
turn off/on:
•

Show calculated camera pointing target

•

Show calculated camera sight area on the map (Section 2.8.6.1 Camera pointing
area)

•

Show an indicator in the right bottom corner of the map (Section 2.8.6.2 Camera
tilt and pan widget)

•

Enable Current Traffic Info: Overlay on map related to the current near air traffic. It
activates the Traffic Information main category of this dialog.

•

UAV Trail: A historic of aircraft position. Climbs at 5 m/s or higher will be painted
completely red, descends of 5 m/s or more will be completely blue.
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•

Show Relative-GPS Info (Optional feature): This may not apply to your U-See
version. This control shows/hides all Relative GPS symbology display on map. This
includes moving base position as reported by relative GPS subsystem, its overlay
and the base trail.

•

Overlay on Map: Shows/hides on map basic information overlay.

•

GPWS Overlay: Shows/hides GPWS colored pattern on map. This doesn't affect the
TERRAIN alarm or the GPWS bar diagram on the altitude sliding bar.

•

Line of Sight Direction: Shows/hides yellow line linking the aircraft position and the
Home Position. If Home Position is not reported, the line links aircraft position and
landing site.

•

UTM coordinates in map contextual menu: shows the UTM coordinates in the point
the user right-clicked.

Map theme used for map display can be changed between the installed options in the
system. Custom maps can be added using the MapManager utility distributed along U-See.
2.15.14.3.1 Map Cache configurations

To change map cache related settings, it is possible to open a dialog containing different
settings clicking in “Map Cache configuration”.
The map cache allows the software to store part of the maps in memory so that it doesn’t
need to download them again every time that part of the map is represented.
In this dialog there are two caches sizes. One is the volatile cache, stored in RAM memory
and that wipes every time the user closes the software. The other is the persistent cache,
stored in the hard drive, and that is preserved after every restart of the software.

Figure 129 Maps Cache configuration dialog

Both cache sizes can be changed from this dialog, selecting a size in MB. It is possible to
set no limit by typing a 0 size, although it is not recommended. To restore the default
settings, just click on “Restore Defaults”.
Any of the caches can be wiped by clicking the corresponding “Erase” button. Note that, in
the case of persistent cache, this will also erase any part of the map downloaded by the
user navigation or by the Download Map Region tool (see details in Section 2.10.1
Downloading map regions).
It is not possible to change this settings or erase persistent cache while there is a map
region download in progress in the Download Map Region dialog.
2.15.14.3.2 DEM configuration

Digital Elevation Model (DEM) Configuration is accessed through the “ Dem configuration”
button located on the right bottom corner of the window.
Through this dialog the source for terrain elevation in the software can be established. It
will affect all software terrain related displays.
To add a source, click on the button “New Layer”.
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The valid sources for elevation data are:
•

IGN-ASC files: Spanish specific version of widely available ASC format, as published
by national geographic institute.

•

GeoTiff Source: Geo-referenced Tiff files.

•

DTED Source: Standard elevation format.

Besides sources of elevations, it is also important to define the priority of these sources.
Each source has an attached order which is managed by moving the sources up and down
in the sources stack.
When a terrain elevation is needed, software will request said elevation from the first
source in the list (Query sequence can be confirmed through the ID column in the stack
display). If the elevation was obtained, it will stop there; if not, it will request the next
source available in the list. In case no custom source is available, the elevation will be
obtained from the default DEM model.
Be advised that if a very big DEM model is loaded (> 100 Mib) there could be a delay of a
pair of seconds between the loading of the file and its output is propagated to the rest of
the software.
This default DEM model is a nearly global land coverage model (between 60°S and 60°N)
with a grid spacing of around 1km.
Each source has to be assigned a name, a source associated filename or folder, its type
and for every source, elevation reference has to be manually established. Usually
elevation data is given from the reference geoid associated with the coordinate system,
however, sometimes files are encoded using elevation from the reference ellipsoid. User is
required to input this information. Available Options for the “File Altitude Data Reference”
•

Reference Geoid: File contains elevation data as measured from the reference geoid
(roughly equivalent to above mean sea level)

•

Reference Ellipsoid: The file contains elevation data measured from the reference
ellipsoid (sometimes this is referenced as
GPS altitude).

It is possible to load multiple DEM files from a
folder. To do so, when Create New Layer option
has been selected, check the option “Use a whole
folder” and select the folder that contains the
DEM files. It is possible to filter the files by file
extension inputting text in the text line between
this option and the “Select folder” button. For
example, if you type “dt1” only files with “.dt1”
extension will be loaded.
When a whole folder is loaded, it will appear as a
single entry in DEM list, but it is possible to open
this entry and see all the loaded files inside the
folder, together with its status.
In Appendix E: GMTED2010 example. a use-case
of a Digital Elevation Model is shown.
Figure 130: DEM Folder loading example

2.15.14.4 Recording

In this section, the file record naming and paths can be changed.
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2.15.14.4.1 Automatic Data Record

U-See can be configured to automatically start recording telemetry data files once it is
started. This eliminates the need for the operator to remember to record the telemetry
before every flight as it is done automatically for him.
In this section a folder for automatic recording can be selected (Default will be C:\Users\
<USER>\Documents) and a base-name for the recording files.
When enabled, the program will start automatically record any data that enters the
telemetry system to disk. The filename generated will be:
<BaseName>_DD_MM_YYYY-HH_MM_SS
Where:
•

DD is day of the month

•

MM is month numbered

•

YYYY is year

•

HH is hour at start of recording

•

MM is minute at start of recording

•

SS is seconds at start of recording.

2.15.14.4.2 Multimedia Record

The files created from the Video Capture dialog will be saved with the path and names
configured in this section. The default path is “$USER\Videos”. The name for the video files
will be generated with the selected base name and the date, following the same format as
automatic data record files. Additionally, the string “_capture” will be appended after the
base name for the capture picture files.

2.15.14.5 Language
The software detects your system language and start in that current language. It is
possible to select the preferred language in that section though. It is necessary to restart
the software for the change to be effective.
Current available languages for U-See software are English, Spanish and Chinese. To
request additional languages, please contact Airelectronics.

2.15.14.6 Traffic Information
U-See is capable of receiving real time traffic information from the internet, a connected
ADSB receptor on the ground or in the aircraft and representing this information on the
map. Options related to the traffic servers and overlay drawing can be found in this main
category.
This category will be disabled if the traffic information is not enabled in the map settings
(See section Maps & DEM configuration 2.15.14.3 in the same dialog)
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Figure 131: Traffic information category

The traffic information is managed though the use of ‘plugins’. These are small
independent programs that extend U-See funcionality and can be mantained and extended
without updating the full U-See software.
In this dialog, the following options can be found:
•

Plugin Activation: A list of the loaded and available plugins for obtaining the air
traffic info during the session. A plugin can be activated/deactivated by clicking on
the checkbox by the plugin’s name. Name of the plugin and its version are shown
too.
◦ In case more than one plugin is selectedU-See software will combine the results.
If the information is repeated (An aircraft can be present in more than one
system) U-See software shows the most recent information.
These plugins have been programmed and prepared by Airelectronics, contact us if
you need a specific driver or a new one.

•

Traffic drawing options: To avoid clutter drawing limits can be configured:
◦ Max. Radius drawing from aircraft: Other aircrafts below this distance can be
drawn on the map. Farther aircrafts won’t show.
◦ Max. Altitude Offset from Aircraft( higher ): Limits how higher an aircraft can be
to be drawn on the map
◦ Max altitude offset from Aircraft (lower): Limits how far below an aircraft can be
to be drawn on the map

•

Enable non-critical aircraft overlays: This option controls if only the critical aircrafts

(Red and Yellow levels) show an attached label with information of the flight or
every aircraft detected displays extra information. To avoid clutter it is
recommended to show only critical flights overlay (Option disabled)
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•

Anti-collision warning levels: Similar to GPWS warning levels, three warning levels
can be configured for the vertical distance between the U-Pilot and any other
aircraft. These levels are low (associated to green color), warning (associated to
orange color) and critical (associated to red color). The limits of these levels can be
set in this section. Any aircraft nearer than 1 kilometer from the U-Pilot in 2D will be
considered critical regardless of the altitude offset.

Figure 132: Example of air traffic overlay on
map

As is shown in the image, each aircraft has its own information overlay, indicating altitude,
heading, speed, ICAO number and warning level (overlay color). The aircraft icon indicates
the current position of the aircraft and its heading.
The traffic information is included inthe telemetry recorded by U-See in order to let the
user study the air traffic state in the moment of the operation.
The Traffic interface is designed to increase user situational awareness. Be
advised that while the utmost care has been taken to insure a proper
representation of altitude offsets errors (instrument, calculation, etc) may
exist. Altitude Offset must never be trusted blindly and this tools does not
substitute proper coordination with Air Traffic Control and adequate flight
preparation

2.15.14.7 Voice synthesizer
A voice synthesizer can be used for aural feedback. The voice synthesizer gives the
following information:
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•

The autopilot alarms . If there are multiple alarms activating at the same time, the
assistant warns about them one by one, prioritizing the warnings over cautions (red
alarms over orange) in a chronological order.

•

In a landing maneuver, the activation of each landing phase:hold, final, flare and
retard.

•

In a final phase during a landing maneuver, how many meters or feet left to the
flare phase.

This configuration subsection contains the following options:
•

Activate/deactivate the assistant.

•

Change the language associated to the assistant’s voice, its volume, pitch (voice’s
tone) and rate (how many words per second).

•

As these options affects directly to how the voice sounds, there is a button in order
to listen a test phrase pronounced by the assistant.

This tool uses the installed voice packets in the operative system. At the date of writing,
these are the available options:
•

English – only: Assistant always speaks English.

•

Spanish – English: Assistant mainly speaks Spanish. If the Spanish voice packet is
not found installed in the O.S. or there is a word not found in Spanish, the assistant
uses English.

•

Chinese – English: Assistant mainly speaks Chinese. If the Chinese voice packet is
not found installed in the O.S. or there is a word not found in Chinese, the assistant
uses English.

Each option can be hidden if the associated language is not found when U-See starts.
Please be sure that the voice packets are installed correctly in the O.S.
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2.15.15 Fly/No-Fly Zones Management
This feature is configured and stored in U-See, not in the Autopilot. This means
the presence and configuration of zones must be checked if you are using the
system in a different computer.

Fly and Exclusion Zones are loaded in U-See using KML files. In this window the user can
manage some of the aspects related with these features.
When adding new zones they are attached to the default KML file.
A detailed list of the options available can be
read below:
Operations clicking on map: the buttons New
Exclusion Zone and New Fly Zone prepare the
map for the creation of an Exclusion Zone and
Fly Zone respectively. In this mode, every leftclick action in the map sets a new zone point
until the Finish Zone button is clicked. The
Delete Zone button sets the map in deletion
mode, in this mode, if the user left-clicks inside
a zone, it is deleted.
•

Figure 133: Fly/Exclusion Zones Management
window.

Operations using coordinates: Second
half of the dialog is intended to edit
existing zones and create new zones
using coordinates.

◦ By clicking the ‘Add new zone’ button
a new zone with just one point will be
created, then by edition of new points
a full zone can be created. Remember to select the type of zone being created
with the “Type” drop-drown menu

◦ A new point in the active zone can be created clicking on the ‘Add Point’ button.
The new created point will be always appended to the list of points at the end of
the list
◦ Besides creating new zones, already existing zones can be also edited. To select
an existing zone select first the associated KML (see section 2.10.2 Document
Loader for more information) file that defines the zone in the drop down menu
labeled ‘List zones in:’ and the available zones in that KML file will be listed in
‘Current Zone’ drop down menu.
◦ Notice zones can be converted from one type to another through the “ Type”
drop down menu.
◦ When the ‘Center’ button is pressed while having a zone selected the map will
recenter and set the proper zoom to see the whole zone.
◦ ‘Remove’ button will delete the zone and remove it from the associated KML file
◦

Each point in a zone can be edited or removed using the buttons available for
each point by its coordinates. Points IDs are numbered in increasing order from
one.
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Figure 134: Editing a zone's point

2.15.16 Auto align sensors
It may occur, after a significant time in operation since
manufacturing, that U-Pilot MEMs sensors may have
experienced zero drift. This dialog accounts for such
possibility and allows to reset the zero reference for your
autopilot.
Different types of alignments are available:
Figure 135: Sensors Auto
Alignment window

All sensors: calibrates all MEMs sensors. Requires
the UAV to be still and with the less vibration the
better. It also requires the UAV to be positioned with 0° roll and 0° pitch for proper
alignment.
•

•

Gyroscopes: all gyroscopes are calibrated. Requires the UAV to be still and with the
less vibration the better.

•

Z-axis gyroscope: only Z-axis gyroscope is calibrated. Requires the UAV to be still
and with the less vibration the better.

Before starting the alignment operation a warning dialog is presented to remind user the
expected UAV state (Figure 136: Sensor Auto Alignment warning window )

Figure 136: Sensor Auto Alignment warning window

Once the sensors are aligned it must be recorded to the EPCS on
Settings → Save Changes as described on 2.15.17 Save Changes or by pressing Save on
the dialog.

2.15.17 Save Changes
All settings changed are not saved to the Autopilot until “ Save Changes” is used. Once the
operator accepts the warning message, all settings are recorded to the Autopilot and the
old settings are lost.

IMPORTANT: THE SETTINGS NOT RECORDED TO THE AUTOPILOT WILL BE LOST
WHEN THE AUTOPILOT IS SWITCHED OFF.
The recorded information is:
•

The current Flight Plan and BackTrack
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•

The current Servo Configuration, maximum, minimum and neutral positions

•

The current runway and Rally Point

•

The current Pitch and Throttle curves

•

Magnetometer calibration

•

Payload configuration

•

Advanced Communication Failure configuration

•

Auxiliary buttons

•

Satcom configuration

•

Joystick buttons

•

Weight settings (MTOW,OEW,Payload Weight)
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Appendix A

Matlab script for data analysis

This script will load data file and present some interesting figures.
%% -------------- Start of file -----------clear all
data=load('Y:\Path_to_Data\datafile.txt');
Pitch = data (:,1);
Roll = data (:,2);
Yaw
= data (:,3);
CommandedPitch = data(:,4) ;
CommandedRoll = data (:,5);
CommandedYaw = data (:,6);
Battery1
Battery2
Battery3
Battery4

=
=
=
=

data
data
data
data

(:,7);
(:,8);
(:,9);
(:,10);

Altitude = data (:,11);
Latitude = data (:,12);
Longitude = data (:,13);
IAS = data (:,14);
GroundSpeed = data (:,15);
CommandedIAS = data (:,16);
CommandedAltitude = data (:,17);
VNorth = data (:,18);
VEast = data (:, 19);
VDown = data (:,20);
UpTime_hour = data (:,21);
UpTime_minute = data (:,22);
UpTime_second = data (:,23);
UTC_hour = data (:,21);
UTC_minute = data (:,22);
UTC_second = data (:,23);
UTC_year = data (:,21);
UpTime_month = data (:,22);
UpTime_day = data (:,23);
close all
figure
hold on;
grid on;
plot (Pitch,'r');
plot (Roll,'g');
title ('Pitch & Roll');
legend ('Pitch [degrees]','Roll [degrees]');
figure
hold on;
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grid on;
plot (Pitch,'r');
plot (CommandedPitch,'b');
title ('Pitch command loop');
legend ('Pitch','Commanded Pitch');
figure
hold on;
grid on;
plot (Roll,'r');
plot (CommandedRoll,'b');
title ('Roll command loop');
legend ('Roll','Commanded Roll');
figure
hold on;
grid on;
axis equal;
plot (Longitude,Latitude);
title ('Position 2D');
figure
hold on;
grid on;
title ('Speed');
plot (IAS);
plot (GroundSpeed,'r');
legend ('IAS [km/h]','GroundSpeed [km/h]');
figure
hold on;
grid on;
title ('Speed in Horizontal axis');
plot (VNorth,'r');
plot (VEast,'g');
legend ('Speed North [km/h]','Speed East [km/h]');
figure
hold on
title ('Vertical speed');
grid on;
plot (VDown./3.6);
legend('Speed Down [m/s]');
figure
hold on;
grid on;
title ('Altitude');
plot (Altitude,'r');
plot (CommandedAltitude,'b');
legend ('altitude [m]','Commanded Altitude [m]');
figure
hold on;
grid on;
title ('Speed Control Loop');
plot (IAS,'r');
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plot (CommandedIAS,'b');
legend ('IAS[km/h]','Commanded IAS[km/h]');
figure
hold on;
grid on;
title ('ADC readings');
plot (Battery1,'r');
plot (Battery2,'g');
plot (Battery3,'b');
plot (Battery4,'k');
legend ('ADC in 1','ADC in 2','ADC in 3','Main system voltage');
%% -------------- End of file ------------
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Appendix B Matlab script for pointing camera
coordinates
This script will load data file and present some interesting figures.
%% -------------- Start of file -----------clear all
data=load('Y:\Path_to_Data\datafile.txt');

airplane_pitch = data(:,1);
airplane_roll = data(:,2);
airplane_yaw = data(:,3);
airplane_latitude = data(:,4);
airplane_longitude = data(:,5);
airplane_altitude = data(:,6);
camera_pan = data(:,7);
camera_tilt = data(:,8);
camera_horizontal_North = data(:,9);
camera_horizontal_East = data(:,10);
camera_horizontal_Down = data(:,11);
pointed_latitude = data(:,12);
pointed_longitude = data(:,13);
pointed_altitude = data(:,14);
UTC_hour = data(:,15);
UTC_minute = data(:,16);
UTC_second = data(:,17);
figure
plot(airplane_latitude,airplane_longitude)
hold on
plot(pointed_latitude,pointed_longitude,'r')
plot(airplane_latitude,airplane_longitude,'o')
plot(pointed_latitude,pointed_longitude,'ro')
axis equal; grid on; legend('Airplane','Camera');
figure
plot(airplane_pitch)
hold on
plot(airplane_roll,'g')
plot(airplane_pitch,'o')
plot(airplane_roll,'go')
grid on;legend('Pitch','Roll')
figure
plot(airplane_yaw,'r')
hold on
plot(airplane_yaw,'ro')
grid on;legend('Yaw')
figure
plot(camera_horizontal_North)
hold on
plot(camera_horizontal_East,'g')
plot(camera_horizontal_Down,'r')
plot(camera_horizontal_North,'o')
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plot(camera_horizontal_East,'go')
plot(camera_horizontal_Down,'ro')
grid on;legend('Camera North','Camera East','Camera Down')
figure
plot(pointed_altitude)
hold on
plot(pointed_altitude,'o')
grid on;legend('Pointed Altitude')
%% -------------- End of file ------------
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Appendix C

Flight plan File Format

U-See is capable of loading flight plan information from a file. There are, however, two
different formats of flight plans. Modern autopilots (Firmwares produced after january 1st
2015) should be able to load both formats, while old autopilots won't load V2 files
correctly.

V1
V1 files are text files, encoded as ASCII, with the dot (.) as decimal separator and as
carriage return both Unix (\n) and Windows Style(\r\n) will be understood.
Keep in mind that notepad under windows won't display correctly files encoded under
Unix carriege returns. In these cases, use Wordpad to open these files under windows.
Files pertaining V1 format will have exactly 33 lines and the maximum number of usable
flight plan points will be 32. This matches flight plan capacity limitation in legacy
software.
The first line must read:
#FP FILE V1

After this first line, each line will describe a flight plan point coordinate, separated by
commas ( , ) . The order for the coordinates is:
latitude[deg],longitude[dege],altitude[m]

Latitude and longitude must be expressed in sexagesimal degrees referred to WGS84
horizontal datum. Positive values are north and east for latitude and longitude respectively.
However, consider that altitudes in these files must be expressed in meters above the
WGS84 reference ellipsoid (commonly named 'GPS altitude') and must be below 10000
meters.
The points that are not to be used must read as:
0,0,20000

Once a point is marked unused all subsequent points must be marked as unused and they
won't be navigated to. This is, all used points must be put sequentially starting at first row,
with each usable flight plan point in a row until all the desired points are written, and then,
up to completing 32 points, (0,0,20000) should be used
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#FP FILE V1
37.6251585217047975,-122.363418958030223,267.80694580078125
37.611685384455896,-122.363423115433449,267.80096435546875
37.6116353483901591,-122.363202248013508,267.80133056640625
37.625333454526718,-122.363197980480038,267.807403564453125
37.6255083744618801,-122.362913880729423,267.8079833984375
37.6116602890740168,-122.362918247908979,267.8018798828125
37.6116102457594792,-122.362665826221772,267.80230712890625
37.6257083028855916,-122.362692892989529,267.8084716796875
37.6258832216097403,-122.362408790616527,267.80908203125
37.611610201370965,-122.362444943455046,267.802734375
37.6115601570479683,-122.362192522255768,267.80316162109375
37.6260081594604046,-122.362187824792684,267.80950927734375
37.6260830973094968,-122.361935313810307,267.80999755859375
37.6115601052761264,-122.361940084977888,267.80364990234375
37.6115600529663965,-122.361687647700037,267.804107666015625
37.6261330314990232,-122.361651249773089,267.810546875
37.6262329713933994,-122.361430290317116,267.81097412109375
37.6116099865639129,-122.361403638983816,267.804656982421875
37.6116599262000051,-122.361151184587968,267.805145263671875
37.62628291108458,-122.361177786276059,267.81146240234375
37.6262828571505068,-122.36092529900472,267.8118896484375
37.6117348618425069,-122.360898721293609,267.805633544921875
37.6118597900357514,-122.360646240202144,267.80615234375
37.6262828026784391,-122.360672811733437,267.812347412109375
37.6261827545800571,-122.360388798493631,267.812835693359375
37.612084710780934,-122.360425278228632,267.860870361328125
37.6122846275978731,-122.36017276874334,267.984100341796875
37.626132712859075,-122.360167890047251,267.813201904296875
37.6260576671425611,-122.359915429968282,267.813629150390625
0,0,20000
0,0,20000
0,0,20000

Example 1: Flight plan file V1 example

V2
V2 files are text files, encoded as ASCII, with the dot (.) as decimal separator and as
carriage return both Unix (\n) and Windows Style(\r\n) will be understood.
Keep in mind that notepad under windows won't display correctly files encoded under
Unix carriege returns. In these cases, use Wordpad to open these files under windows.
Files pertaining V2 format will have an arbitrary number of lines. However, when less
than 200 points are used, the last point shall be 0,0,20000. Also, it is important to note
that points above 200 won't be uploaded to the autopilot.
The first line must read:
#FP FILE V2

After this first line, each line will describe a flight plan point coordinates, separated by
commas ( , ) . The order for the coordinates is:
latitude[deg],longitude[dege],altitude[m]

Latitude and longitude must be expressed in sexagesimal degrees referred to WGS84
horizontal datum. Positive values are north and east for latitude and longitude respectively.
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However, consider that altitudes in these files must be expressed in meters above the
WGS84 reference ellipsoid (commonly named 'GPS altitude') and must be below 10000
meters.
The points that are not to be used must read as:
0,0,20000

Once a point is marked unused all subsequent points won't be navigated to and will be
considered unused. This is, all used points must be put sequentially starting at first row,
with each usable flight plan point in a row until all the desired points are written, and then,
to end the file (0,0,20000) should be used.
#FP FILE V2
37.6332393753529146,-122.398791697086239,268.5220947265625
37.6250768409847325,-122.398801661470472,268.38580322265625
37.6250518885132976,-122.398570537967331,268.1923828125
37.6332560259911943,-122.398560550830524,268.693084716796875
37.6332560349269301,-122.39832940347128,268.813720703125
37.6250269355910234,-122.398339414619358,267.99566650390625
37.6250019822178956,-122.398108291426638,267.791748046875
37.6332560430358853,-122.398108762810182,268.9300537109375
0,0,20000

Example 2: V2 Flight plan file
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Appendix D

BackTrack File Format

U-See is capable of loading BackTrack information from a file. Contrary to Flighplan files,
these files only have V2 format as BackTrack was included as a feature later.

V2
V2 files are text files, encoded as ASCII, with the dot (.) as decimal separator and as
carriage return both Unix (\n) and Windows Style(\r\n) will be understood.
Keep in mind that notepad under windows won't display correctly files encoded under
Unix carriege returns. In these cases, use Wordpad to open these files under windows.
Files pertaining V2 format will have an arbitrary number of lines. However, when less
than 200 points are used, the last point shall be 0,0,20000. Also, it is important to note
that points above 200 won't be uploaded to the autopilot.
The first line must read:
#BT FILE V2

After this first line, each line will describe a BackTrack point coordinates, separated by
commas ( , ) . The order for the coordinates is:
latitude[deg],longitude[dege],altitude[m]

Latitude and longitude must be expressed in sexagesimal degrees referred to WGS84
horizontal datum. Positive values are north and east for latitude and longitude respectively.
However, consider that altitudes in these files must be expressed in meters above the
WGS84 reference ellipsoid (commonly named 'GPS altitude') and must be below 10000
meters.
The points that are not to be used must read as:
0,0,20000

Once a point is marked unused all subsequent points won't be navigated to and will be
considered unused. This is, all used points must be put sequentially starting at first row,
with each usable BackTrack point in a row until all the desired points are written, and then,
to end the file (0,0,20000) should be used.
#BT FILE V2
42.6460505999999953,-5.72935950000000016,2286
42.6308415999999966,-5.8337279999999998,2286
42.6115555999999955,-5.94531289999999935,2286
42.5970250999999962,-6.05828549999999932,2286
42.5439833000000007,-6.14712959999999953,1186.6199951171875
42.4873763000000011,-6.23115810000000003,1249.3909912109375
42.4324912999999952,-6.30323889999999931,1353.7960205078125
0,0,20000

Example 3: V2 BackTrack file
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Appendix E

GMTED2010 example.

There are 4 products of GMTED2010 that could be used with U-See. Each of this products
is delivered with three different resolutions.
● Mean
◦ Represents the average of the values.
● Median
◦ The median is the value for which the half of the values are below this value,
and the other half are over it. It might be more representative than the mean
with skewed data.
● Minimum
◦ This product values are the minimum values of the sampled areas. It should not
be used because it is not safe for operation.
● Maximum
◦ This product values are the maximum values of the sampled areas. For
maximum security, this is the file that should be used.
More info in http://pubs.usgs.gov/of/2011/1073/pdf/of2011-1073.pdf.
In order to use GMTED2010 products with U-See, follow these steps:
In your web browser
1. Go to GMTED Viewer (http://topotools.cr.usgs.gov/gmted_viewer/viewer.htm).
2. Click your area of interest in the world map.
3. Select the desired file on the left side and download it to your local hard disk.
In U-See:
1. Go to "Settings → U-See Settings"
2. Click in "Maps & DEM" and then in "DEM Configuration"
3. Click on "New Layer"
4. Enter a name for the layer in the white field.
5. Select type "Geotiff"
6. Select the downloaded file.
7. Select "Reference Geoid" as the file altitude data reference.
8. Click on "Create"
9. If everything is ok, a new layer should appear in the list on the left with a green tick.
Otherwise, a red cross would appear.
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Appendix F

U- Camera

General System Introduction
U-Camera is the Gimbal solution provided by Airelectronics, designed for small and
medium sized UAVs. U-Camera can be mounted on fixed wing vehicles or rotary wing
platforms such as multicopters or helicopters.
The system uses encoders, magnetometers and GPS information to calculate the pointing
with high precision. Four different operation modes are available. Mounted camera
provides a 10X optical zoom and a horizontal resolution of 530 TV Lines.
Based on the same FPGA technology as U-Pilot flight control system, U-Camera is capable
of precise pointing even when mounted on vehicles with high dynamics. As its twin system
U-Pilot, U-Camera is built using a two parallel microprocessor approach:
•

One microprocessor takes care of the state estimation, pointing and control of the
gimbal, using hardware acceleration to calculate high speed algorithms.

•

Another processor handles secondary tasks as managing the camera modules or
the communication with the UAV platform.

Due to the fact that those two processors are working in parallel and there is dedicated
electronics taking care of all the serial ports, sensors, inputs and outputs, the system is
capable of recalculating the gimbal position and control faster than any other system,
providing an excellent video stabilization and pointing.

U-Camera Elements
A U-Camera system is composed by the following elements:
•

U-Camera Board: is the electronic board that computes the gimbal position and
points and stabilizes it.

•

U-Camera Gimbal: the proper gimbal, contains the video module, motors and
sensors.

◦ The mount setup tab allows to change the direction of each axis, by checking the “First
Axis Inverted” or “Second Axis Inverted”, the pan or tilt axis movements and feedback
are inverted, respectively. The offset configuration allows to fix little deviation that
affect the mount setup of the gimbal in the aircraft. For example, is the pan axis is not
completely aligned with the yaw axis of the aircraft, this can be fixed here. Please note
that this that not apply to geolocation mode.
•

U-Camera Harness: connects U-Camera Board and U-Camera Gimbal and provides
the required connections such as power supply, command interface or video output.

• Concept of system operation
When correctly placed, U-Camera Gimbal, Harness and Board act as a single element, UCamera. The interface with other elements (FCS, Video transmitter) is done via U-Camera
Harness.
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Video Transmitter
U-Camera Gimbal connector provide a power supply at 12V (1A max) for a video
transmitter supply. Using this power supply the transmitter can be connected directly to
the gimbal without external regulators, while maintaining the transmitter isolated from the
rest of the system.

U-Camera Operation
Powering U-Camera
Before powering U-Camera, all the harness and wires must be connected. U-Camera
system is not ready for hot-plugging, and power-up without all the harness connected may
damage the electronics.
U-Camera accepts input voltages from 9 to 28V. IMPORTANT: if the power supply is above
17V, active refrigeration of U-Camera Board is highly recommended to avoid permanent
damage.
Upon power-up, the camera will point momentarily to Pan 0º and Tilt 0º and then will start
to stabilize in Rates Mode.

Pointing modes
U-Camera accepts different modes in order to satisfy various pointing operations:
•

Angles Mode: Angles Mode will point the gimbal to the angles provided by Set
Gimbal Angles Packet.

•

Rates Mode: Rates Mode will completely stabilize the camera. The Gimbal will
keep the camera pointing to a fixed direction in the space. The stabilization point
can be modified using the Set Gimbal Rates Packet.

•

STOW: The mode will protect the camera lens pointing it to the angle tilt = +90°
and pan = 0°.

•

Pilot: The pilot mode will point the gimbal to tilt = 0° and pan = 0° to provide the
front view from the vehicle. This mode has a soft stabilization.

GPS Configuration
U-Camera can work with and without GPS input. It is recommended to work with GPS input
to provide the maximum pointing accuracy.
The GPS source can be selected between the following options available:
•

Internal GPS: U-Camera will use the on-board GPS receiver to get the position and
velocities. In this case, the GPS antenna must be placed correctly on the vehicle and
connected to U-Camera Board.

•

External Feed: U-Camera will use the position and velocities send from the
controller as described in the communication protocol.
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Vehicle Angles
In order to provide the best pointing accuracy, U-Camera accepts the Euler Angles of the
vehicle (Yaw, Pitch, Roll) as input.
If this packet is received, U-Camera will use the provided angles as vehicle angles. If the
packet is not being received U-Camera will calculate the vehicle angles from the GPS
source.
Depending on the type of vehicle and Flight Control System used, externally provided
vehicle angles will provide better performance.
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Appendix G

Voice installation

• Windows 10
1. Press the Windows Key and search for “Settings”, then click con the settings App (Figure
137).

Figure 137: Search for Settings Apps.

2. On the Windows Settings App, click on “Time & Language” (Figure 138).

Figure 138: Time & Language

3. On the Time & Language menu, click con the Language menu on the left panel. Then
check if in Preferred languages apper the following languages installed (Figure 139):
1. English (United States).
2. Español (España).
3. Chinese (China).
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4. Its important that in each language appears the “Text To Speech” icon (Figure 140). If a
new language must be installed proceed with step 5. Otherwise if the “Text To Speech”
Icon does not appear in the desired language proceed with step 5.

Figure 140:
Speech Icon

Figure 139: Language Options

5. Install a new language: To install a new language click on “Add a preferred language”
(Figure 139), a new menu will pop-up, search for the language desired to be installed.
(Figure 142). After this, select the language and click on next. Once next is clicked, a
new menu will appear, in which the “Install language pack” must be checked (Figure
141). Click Install on the bottom left to finish this step.

Figure
142:
Language
Figure
143:
Optionsto
forInstall
each language
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6. Install new voices: Now the language pack is installed, but the “Text to Speech”
functionality might not be active. To activate it click on options on the desired language
(Figure 143). Now the language options menu should be open, click on “Add additionl
speech voices” (Figure 145).
A new menu will will appear, in which the language desired must be searched. Once the
desired language is found select it and click on the add button (Figure144).

Figure 145: Add aditional speech voices

Figure144: Voices packages
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7. Install new voices (Alternative): It is possible to install voices directly from the speech
menu. Once here in the “Manage Voices” menu check if all the desired voices are
installed. If it is not the case, click on “Add voices” and proceed as indicated at step 5
(Figure 146).

Figure 146: Manage Voices

• Windows 7
1. Download the Microsoft Speech Platform – Runtime. Go to the official web page26
and click on download, a window will pop up where you have to select either the
x86_SpeechPlatformRuntime\SpeechPlatformRuntime.msi
or
the
x64_SpeechPlatformRuntime\SpeechPlatformRuntime.msi
depending
on
your
operating system. Once the installer is downloaded execute it and install it .
2. Install new languages. Go to the Microsoft Speech Platform – Runtime Languages
webpage27 and click on download, a new menu will pop up, select the languages
you want to install in your system. For each language two files are required, the
MSSpeech_SR file and the MSSpeech_TTS file.
Select the following files:
English Voice

MSSPeech_SR_en-US_TELE.msi

MSSPeech_TTS_en-US_Helen.msi

Spanish Voice

MSSPeech_SR_es-ES_TELE.msi

MSSPeech_TTS_es-ES_Helena.msi

Chinese Voice

MSSPeech_SR_zh-CN_TELE.msi

MSSPeech_TTS_zh-CN_HuiHui.msi

Now click on next, the files will be downloaded.
3. Execute the SR file and the TTS file for each language downloaded in the previous
step.
26 http://www.microsoft.com/en-us/download/details.aspx?id=27225
27 http://www.microsoft.com/en-us/download/details.aspx?id=27224
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4. Open Regedit (click on windows button, search for regedit.exe and execute the
application). Download the following tokens (right click on the folder and click
export):
5. Now you have to edit the files exported on the previous step. In order to do that,
open them with Notepad, press “cntrl + H” and search for “\Speech Server\v11.0\”
then replace it with “\Speech\”. Then save the file. This step must be done with both
of the files (Figure 147).
6. Merge the new Registry files into your registry, for this you have to double click on
both of the files and click “yes” to continue. This must be done for both of the files.

Figure 147: Find and replace

• Linux
When operating under linux the software will use a system wide voice synthesis frontend
called Speech dispatcher.
It is a Linux service designed to give the applications running a unified access to the many
available synthesizer software available under Linux.
Due to the heterogeneous nature of Linux install we cannot provide exact configuration
instructions for all Distributions. Please check the documentation of your linux distribution
on Speech Dispatcher and the varying available synth systems.
Our recommendation is to use as synth engine pico or espeak-ng

• Debian Stable
Under debian stable you’ll need to install at least the packages:
•

speech-dispatcher

•

qtspeech5-speechd-plugin
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For the recommended pico engine its speech dispatcher plugin should also be
installed:
•

speech-dispatcher-pico

If other engines are to be used, their respective speech-dispatcher plugins must be
installed ( e.g. speech-dispatcher-festival)
Under /etc/speech-dispatcher a file called speechd.conf describes the system-wide speech
dispatcher configuration. (It is possible to create a per-user configuration file; check
speech-dispatcher documentation). To use the recommended text to speech engine the file
should be edited so that the following is present:
AddModule "pico-generic"
DefaultModule pico-generic

"sd_generic"

"pico-generic.conf"

Check debian documentation on speech distpacher for further configuration
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Appendix H

Change log

This annex describes changes introduced to this document.
Date

Changes

2020/10/02

•
Document version up to 1.54
•
Added instructions to setup system wide voice synthesis on windows and a
small not on linux

2020/05/05

•
•
•
•
•
•
•
•
•
•
•

2019/10/07

•
Document version up to 1.52
•
Added description of the extra information added to the manual trim dialog.
•
Added description of extra columns added in the Aircraft Telemetry TXT export
file format
•
Modified Matlab script for data analysis

2019/15/04

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Document version up to 1.51
Added new multimedia record settings
Updated recording container formats
Update new video record interface
Added Warming-up mode to rotary wing modes
Added new feature to load DEM folders
Added landing control deviation bars and variometer
Added option to change video source in video capture dialog
Added video processor options to video capture dialog
Added video processor dialog
Added option to broadcast video
Added heading indication to map and to state dialog
Added desired RPMs to Moscat ECU
Added USB license
Added new Moscat eFI ECU type
Minor fixes

2019/11/02

•
•
•
•
•
•
•
•
•
•
•
•

Document version up to 1.50
Added BackTrack to possible operations with mouse left button on map.
Added new network stream decoders.
Added new captive rotary heading option.
Added new modes description to captive rotary and rotary wing aircrafts.
Added resolution selection in video capture dialog.
Added new options when manual and rates mode are selected.
Added new camera specific options.
Added new hazardous emitting systems dialog.
Added new payload configuration options.
Added firewall warning to Safe-T status dialog.
Minor text and screenshots fixes.

Document version up to 1.53
Added new KML files, Fly/No-Fly Zones and POIs management.
Added traffic info information, icons and settings.
Added payload and config reworked windows.
Added AGL indicator in landing window.
Added AGL source indicators in State window and info related.
Added info about sound when mode changes.
Added new Take off window.
Added specific section about shortcuts.
Added new options for Epsilon.
Added GPS source manager.

Previous entries of this changelog table has been trimmed to avoid too long changelog section
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